LYRRUS INCORPORATED
PROGRAM LIMITED USE LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING
THE ENCLOSED SOFTWARE. INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN
THE SOFTWARE UN-INSTALLED, AND YOUR MONEY WILL BE REFUNDED.

LICENSE
Lyrrus Incorporated has developed and provides the computer software program contained on this CD-ROM (the
'Program') and licenses its use. You assume responsibility for the selection of the Program to achieve your intended results,
and for the installation, use and results obtained from the Program.
a. Permissible Uses
(i) Lyrrus Incorporated hereby grants you a personal, non-transferable and non-exclusive right and license to use the
Program under the terms stated in this Agreement. Title and ownership of the Program and the related documentation
remain in Lyrrus Incorporated.
(ii) You may use the Program only on a single CPU.
(iii) You may not transfer or assign the Program or this license to any other person without the prior written consent of
Lyrrus Incorporated.
(iv) You acknowledge that you are receiving only a LIMITED LICENSE to use the Program and related documentation
and that Lyrrus Incorporated retains title to the Program and documentation. You further acknowledge that Lyrrus
Incorporated has a valuable proprietary interest in the Program and documentation.
b. Restrictions
(i) You may not use, copy, reproduce, modify, alter, or transfer the program or any copy or merged portion, in whole or
in part, except as expressly provided in this license. (You may make a single copy of the Program for archival backup
purposes in support of your use of the Program on the single machine.)
(ii) You acknowledge that the program contains trade secrets of Lyrrus Incorporated. In order to protect such trade
secrets, you may not decompile, reverse engineer, disassemble or otherwise reduce the Program to a human perceivable
form. You may not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network, or create derivative
works based on all or any part of the program or documentation.
(iii) You and your employees and agents are required to protect the confidentiality of the Program. You may not
electronically transfer the Program or accompanying documentation from one computer to another over a network. You
may not distribute or otherwise make the Program or documentation available to any third party, by time sharing or
otherwise, without the prior written consent of Lyrrus Incorporated.
(iv) IF YOU USE, COPY, REPRODUCE, MODIFY, ALTER, OR TRANSFER POSSESSION OF THE PROGRAM
OR ANY COPY OR MERGED PORTION, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN
THIS LICENSE, YOUR LICENSE WILL THEREBY TERMINATE AUTOMATICALLY.

TERM
The license is effective until terminated. You may terminate the license at any time by destroying the Program and related
documentation, together with all copies thereof. This license will also terminate immediately if you fail to comply with
any term or condition contained herein. Upon such termination, you agree to return to Lyrrus Incorporated, at your own
expense, the Program
and related documentation, together with all copies and merged portions of the Program or related documentation in any
form.

EXPORT
You acknowledge that the laws and regulations of the United States may restrict the export and reexport of the Program.
You agree that you will not export or reexport the Program or related documentation in any form without prior written
consent of Lyrrus Incorporated and appropriate United States and foreign government approval.
# Table of Contents

Chapter One: Basic Sequencer Operation

- The Transport Window ................................................................. 1
  - The Counters ............................................................................. 3
  - Other Transport Controls .......................................................... 4
  - Special Record Modes ............................................................... 5
  - Selecting Insert Points for Special Record Modes ....................... 6
  - Thru ......................................................................................... 7
- The Track Sheet ............................................................................ 8
  - Selecting Tracks to Play ............................................................ 9
  - Selecting Tracks to Record ........................................................ 9
  - Multi-Track Record ................................................................. 10
  - Using Multi-track Record with Guitar Controllers ...................... 10
  - Soloing tracks .......................................................................... 11
  - Looping .................................................................................... 11
  - Naming tracks .......................................................................... 12
  - Setting the Playback Channel .................................................. 12
  - Multi-Channel Tracks ............................................................... 13
  - A Note on the Ports ................................................................... 14
  - Using the Pop-up Sliders ........................................................... 15
  - Setting the Initial Program Number .......................................... 16
  - Using the Device Dialog ........................................................... 17
  - Tips/Hints ................................................................................ 20
  - The Volume Column .................................................................. 20
  - Using the Master Volume Fader ................................................ 22
  - Moving tracks ........................................................................... 23
  - Duplicating tracks .................................................................... 24
  - Transpose Lock ......................................................................... 24
  - Playing a sequence ..................................................................... 24
  - Recording a track ....................................................................... 25
- The Tempo Window ....................................................................... 27
  - Resetting the original stored tempo .......................................... 28
Chapter Two: Editing in the Track Editor Window

The Measure Ruler ..................................................................................................... 30
Show/Hide "Measure Display" ................................................................................. 31
Using Markers ............................................................................................................ 31
   Placing a marker .................................................................................................. 32
   Naming markers .................................................................................................. 32
   Moving to a marker ............................................................................................. 32
The Markers window .......................................................................................... 33
Editing in the Track Editor window ........................................................................... 33
   Selecting measures to edit ................................................................................... 34
   Selecting a block of measures .............................................................................. 34
   Selecting an entire track ...................................................................................... 35
   Selecting measures across all tracks .................................................................... 35
Playing a Sequence from the Track Editor ............................................................. 36
   Setting the playback point ................................................................................... 37
Shortcut to the Step Editor ........................................................................................ 37

Chapter Three: Using the Step Editor Window

The Notes .................................................................................................................. 40
Markers ...................................................................................................................... 41
Program Changes ....................................................................................................... 41
Icons and Information ............................................................................................. 42
Scrolling and zooming ............................................................................................. 43
Viewing different tracks .......................................................................................... 44
Playing a sequence ................................................................................................... 44
Editing Data ............................................................................................................... 45
   Regional editing .................................................................................................. 45
   The Time Indicator ............................................................................................. 46
   Selecting a region to edit ..................................................................................... 46
Inserting new notes ................................................................................................... 49
   Show/Hide Velocity ............................................................................................ 51
Inserting the notes with a mouse: ........................................................................... 52
   Step-time note entry from a MIDI instrument .................................................. 52
   Rests and Corrections ......................................................................................... 53
   Step-timing chords ............................................................................................ 53
   Changing durations ............................................................................................ 54
   Overdubbing and changing tracks ................................................................... 54
   Editing individual notes ..................................................................................... 54
   Moving in Place: Shift-Clicking ........................................................................ 55
   Copying a Note: Option-Clicking ...................................................................... 55
   Stretching or Shrinking a Note .......................................................................... 56
Chapter Four: The MIDI Data and Event List Windows

The Data Windows ................................................................. 61
  Common Features .............................................................. 62
  Display Modes ................................................................. 62
  "Ghost" Notes ................................................................. 63
  Icons and Information ..................................................... 63
  Markers, Measures, Scroll Bars, and Zoom ......................... 64
  Selecting MIDI data for Editing ........................................ 65
  Entering MIDI data .......................................................... 66
  Changing and Erasing Data ............................................... 67
  Data density and the Zoom Factor ..................................... 67

The Pitch Bend Window ...................................................... 68
The Channel Pressure Window ............................................ 69
The Key Pressure Window .................................................. 69
The Modulation Window .................................................... 70
The Controllers Window .................................................... 70
The Velocity Window ........................................................ 71
The Tempo Map Window ................................................... 71
The Event List Editor .......................................................... 72
  Changing events ............................................................. 73
  Scrolling the List ............................................................. 73
  Selecting a region ........................................................... 74
  Inserting events .............................................................. 74
  Removing Events ........................................................... 74
  Filtering events ............................................................... 75
  Changing and naming tracks ............................................. 75

The Big Counter Window .................................................... 75

Chapter Five: Using the File Menu

About Master Tracks Pro Files ............................................. 78
Starting a new file .............................................................. 78
Opening an Existing File .................................................... 79
Closing files ................................................................. 80
Saving files ................................................................. 80
  Using the Save As Command ........................................... 81
  Using the Revert to Saved Command ............................... 81
  Using MIDI Files .......................................................... 82
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Bend Range</td>
<td>110</td>
</tr>
<tr>
<td>Conductor</td>
<td>111</td>
</tr>
<tr>
<td>Changing the Meter</td>
<td>112</td>
</tr>
<tr>
<td>Changing the Beat</td>
<td>112</td>
</tr>
<tr>
<td>Setting Tempos</td>
<td>113</td>
</tr>
<tr>
<td>Looking at the Results</td>
<td>114</td>
</tr>
<tr>
<td>Listening to the Results</td>
<td>115</td>
</tr>
<tr>
<td>Locked Markers</td>
<td>115</td>
</tr>
<tr>
<td>Strip Data</td>
<td>115</td>
</tr>
<tr>
<td>Setting Up the Operation</td>
<td>116</td>
</tr>
<tr>
<td>Using Strip Data</td>
<td>117</td>
</tr>
<tr>
<td>Thin Continuous Data</td>
<td>118</td>
</tr>
<tr>
<td>Thin Notes</td>
<td>120</td>
</tr>
<tr>
<td>Transpose</td>
<td>120</td>
</tr>
<tr>
<td>Transpose Map</td>
<td>121</td>
</tr>
<tr>
<td>Humanize</td>
<td>122</td>
</tr>
<tr>
<td>Quantize</td>
<td>123</td>
</tr>
<tr>
<td>Everything or Just the Attacks</td>
<td>123</td>
</tr>
<tr>
<td>Setting the Quantization Value</td>
<td>123</td>
</tr>
<tr>
<td>Ahead of and Behind the Beat</td>
<td>124</td>
</tr>
<tr>
<td>Intensity</td>
<td>125</td>
</tr>
<tr>
<td>Swing</td>
<td>126</td>
</tr>
<tr>
<td>Sliding Notes</td>
<td>127</td>
</tr>
<tr>
<td>Sliding Data</td>
<td>127</td>
</tr>
<tr>
<td>Fit Time</td>
<td>128</td>
</tr>
<tr>
<td>Locked Markers</td>
<td>129</td>
</tr>
<tr>
<td>Scale Time</td>
<td>129</td>
</tr>
<tr>
<td>The Change Filter</td>
<td>131</td>
</tr>
<tr>
<td>Pitches</td>
<td>132</td>
</tr>
<tr>
<td>Durations</td>
<td>132</td>
</tr>
<tr>
<td>Velocities</td>
<td>133</td>
</tr>
<tr>
<td>Channel</td>
<td>133</td>
</tr>
<tr>
<td>Measures</td>
<td>133</td>
</tr>
<tr>
<td>Beats and Sub-Beats</td>
<td>134</td>
</tr>
<tr>
<td>Combining filters</td>
<td>135</td>
</tr>
<tr>
<td>Executing and Recalling the Change Filter</td>
<td>136</td>
</tr>
</tbody>
</table>

**Chapter Eight: Using the Windows Menu**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Main Windows</td>
<td>138</td>
</tr>
<tr>
<td>Track Editor</td>
<td>138</td>
</tr>
<tr>
<td>Event List Editor</td>
<td>138</td>
</tr>
<tr>
<td>Step Editor</td>
<td>138</td>
</tr>
</tbody>
</table>
### Chapter Nine: Using the Songs and Layout Menus

- **The Songs Menu** ................................................................. 141
- **Using Multiple Songs** ...................................................... 141
- **The Playlist** ........................................................................ 142
- **Saving and Loading the Playlist** ........................................ 144

### Chapter Ten: Using the Goodies Menu

- **Memory** .............................................................................. 149
- **The Tempo Window** .......................................................... 150
- **Transport** ........................................................................... 150
- **Markers** ............................................................................. 151
- **Notepad** ............................................................................ 153
- **Master Fader** ..................................................................... 154
- **Sysex** ................................................................................ 154
  - **Receiving System Exclusive Data** ................................. 154
  - **Sending System Exclusive Data** ...................................... 155
  - **Loading and Sending Multiple Messages** ........................ 156
- **Keyboard Setup** ................................................................. 156
- **MIDI Setup** ....................................................................... 158
  - **Assigning Playback Ports** ............................................. 159
  - **Assigning the Record Port** ............................................ 159
  - **Assigning the Synchronization Port** .............................. 160
Transmitting Sync Commands ................................................................. 160
Synchronization Selection ................................................................. 161
Start Time ......................................................................................... 162
SMPTE Dropout Parameter ............................................................... 162
Click Setup ...................................................................................... 163
Chase Controllers ........................................................................... 164
Record Filter ................................................................................... 166

Chapter Eleven: Advanced Topics
Using Loops .................................................................................. 167
Re-barring ....................................................................................... 168
Working with the Tempo Map ......................................................... 168
  Placing and Erasing Tempo Changes ............................................. 170
  Using the Conductor Command .................................................... 170
Working with External Synchronization ......................................... 171
  MIDI (“Ext”) sync ........................................................................ 172
  MIDI Time Code (“MTC”) sync .................................................... 173
Locked markers ............................................................................. 176
Printing the screen ....................................................................... 177
I’ve Got A Question ........................................................................ 177

Appendix A: MIDI Drivers, Interfaces and Sync Setup
MIDI Drivers .................................................................................. 181
Apple MIDI Manager ...................................................................... 182
Powerbooks and MTPro ................................................................. 183
Connecting to serial ports ............................................................... 184
MIDI Time Piece support ............................................................... 184
OMS Support ................................................................................ 186
Sync Setup .................................................................................... 187
MIDI Machine Control .................................................................. 188

Appendix B: Common MIDI Setups
MIDI Thru ..................................................................................... 189
Common MIDI setups ................................................................... 190

Appendix C: Version 6.0.1 Changes and new features
File Menu changes ....................................................................... 193
Expanded MIDI file support ......................................................... 193
Change Menu new feature ............................................................ 194
Device List Bank Select ................................................................. 194
Appendix D: Using the built-in QuickTime Synthesizer

Installing QuickTime 2.0 ................................................................. 195
Using the Built-in Synth ................................................................. 196
Choosing Instruments ................................................................. 197
General MIDI ............................................................................... 197

Appendix E: Using the On-Screen Keyboard

Playing the Keyboard ................................................................. 199
Entering Chords ........................................................................ 199
Changing the Octave ................................................................. 200
Setting the Velocity ................................................................. 200
Displaying the Playback ............................................................ 200

Appendix F: Assignable Faders

The Assignable Faders ............................................................... 201

Appendix G: Keyboard Shortcuts

Transport Commands ............................................................... 203
Track Editor Commands ............................................................ 203
Window Commands ................................................................. 203
File Menu Commands ............................................................... 204
Edit Menu Commands .............................................................. 204
Change Menu Commands .......................................................... 204
Layout Commands ................................................................. 204
Goodies Commands ................................................................. 205
Step Editor and MIDI Data Window Commands .................. 205
Other Shortcuts ................................................................. 206

Appendix H: Standard MIDI Controller Assignments

Index
Master Tracks Pro is designed to work much like a multitrack tape deck. Although a sequence is stored in the Macintosh’s memory instead of on tape, you still need controls that let you play, record, fast forward, rewind, and stop the sequence. You also need a counter to tell you where you are in the sequence. The Transport window is where Master Tracks Pro provides these features.

The center portion of the Transport Window has six screen “buttons” — Play, Record, Fast Forward, Rewind, Pause, and Stop. They function just like their counterparts on an actual tape deck. To “press” one of these buttons, you just click on it with the mouse.

You can also execute the Play, Record, and Stop functions from the Macintosh keyboard: the space bar alternates between Play and Stop, and the Enter key activates Record. In addition, see the section on the Keyboard Setup command in Chapter 10 for instructions on how to define MIDI keys for the transport control.
Here's how each of these transport functions works:

**Play** — plays the sequence beginning at the point currently indicated by the Measure Counter. Pressing the Space bar on the Mac keyboard also starts playback. Before starting playback, make sure the track or tracks you want to hear are play-enabled in the Track Editor window (see page 9).

**Record** — starts recording on a track that’s been record-enabled in the Track Editor window (see page 9), beginning at the location in the sequence indicated by the Measure Counter. Recording can also be started by pressing the Macintosh Enter key.

A track must be record-enabled before you start recording, or the command will not function, and you will get an error message. Each time you record on a track, the new data is *recorded over* any data previously recorded, and the previous data is *erased*. However, if you start recording at any point in the sequence other than the beginning, data previous to the point where you start will be preserved. Likewise, any existing data in the remainder of the track past the point at which you stop recording will remain untouched.

Any Record operation can be cancelled with the Edit menu’s “Undo” command (see Chapter 6 for details), however, if you don’t like a track you’ve recorded and want to go over it, you don’t need to Undo it, since the program will automatically erase the old track when you record the new track.

The program also provides Special Record Modes—Overdub, Looped Overdub, Punch-in and -out—which we’ll get to in a moment.

**Rewind** — Clicking on this button once moves the measure counter back one measure. Clicking and holding moves the counter back continuously in one-measure increments. Double-clicking sets it back to the beginning of the sequence. The left-arrow key on the Macintosh keyboard has the same function: pressing it once moves the counter back one measure, and pressing and holding moves it back continuously. In addition, if you have an extended keyboard, you can press the “Home” key to get back to the beginning of the sequence.

**Fast Forward** — Clicking on this button once moves the measure counter
ahead one measure. Clicking and holding moves the counter forward continuously in one-measure increments. (The Macintosh right-arrow key does the same thing.) Double-clicking sets it at the end of the sequence. If you have an extended keyboard, you can press the “End” key to instantly get to the end of the sequence. You can also click on Fast Forward while a sequence is playing and hear the playback sped up (the right-arrow key won’t do this, however).

**Stop** — Clicking on the Stop button stops playback and recording. If the Auto function is on, the sequence automatically rewinds to wherever you last started playback. Whenever you click on Stop (or press the space bar), the program sends out a MIDI “All Notes Off” command on all MIDI channels to make sure that no notes are left “hanging” because of MIDI data errors.

**Pause** — Clicking on this button pauses both play and record. When you click again, the sequence resumes playing or recording from where you stopped.

### The Counters

On the left side of the Transport window are two counters that let you locate your current position in the sequence. The *Measure Counter* at the top left displays the position in the sequence in measures, beats, and individual “clocks” — a clock being defined as 1/240th of a quarter-note. You can move to any location in a sequence by clicking on the measure, beat or clock field in the Measure Counter, typing in the number from the Mac keyboard, and then clicking on Play or Record. Pressing the period key (or the Tab key after the first field is selected) when the measure field is highlighted repeatedly “tabs” among the three fields — measure, beat, and clock.

Pressing the period "." key when *not* in the measure field will bring up a "go to..." dialog that allows you to type in a location and press Return to go to that spot.

The *Current Time Indicator* shows the actual time location (in hours, minutes, seconds, and frames) of your current position in the sequence. If you have changed the tempo in a sequence, this counter will reflect those tempo changes. Normally, the counter will show elapsed time from the beginning of the
sequence — however, you can specify a non-zero Start Time for the sequence if you are working in conjunction with an external timecode source. The Start Time is set in the Sync Setup dialog (Goodies menu). If you have set a Start Time, then the Current Time is calculated using the Start Time as the beginning of the sequence. (The frames field in the Current Time Indicator will also be affected by the setting of the SMPTE Format in the Sync Setup dialog box.)

Other Transport Controls

The other controls in the Transport window can, except as noted, be operated while the sequencer is running in Record or Play.

Auto - If Auto is highlighted, and you stop playback, the sequence will automatically "rewind" to the point where playback (or recording) started last. If Auto is off, and you click in any window at any location in the sequence, the transport will locate to that point. With Auto on, the transport stays where it is unless you click in one of the Counter fields or use the Rewind or Fast-Forward buttons.

Click - When this control is on, you will hear a click tone on each beat of each measure for the entire length of the piece during Record or Play. The click tone can come from the Mac’s internal speaker (or its audio output jack), or it can come from a MIDI instrument —a popular use is with the “Rim” sound of a drum machine. Double-clicking on this control (or choosing “Click Setup” from the Goodies menu) opens a dialog box for setting up how you want the click to sound.

Count In - When this control is on, you get a click tone for one measure before starting to play or record. The number of beats it counts is equal to the meter of the first measure in the sequence, as determined in the Tempo Map. The setting (internal speaker or MIDI) for the Count tone is the same as the Click tone, but the two are independent; that is, one can be turned on without the other.

Sync - This box determines whether the sequencer will synchronize to incoming MIDI timing signals. Clicking on it toggles among three modes:
• “INT Sync” means the sequencer will play all by itself, with no external timing signals needed (or wanted).

• “EXT Sync” means that the sequencer requires a MIDI Start command, MIDI clocks, and possibly a MIDI Song Position Pointer (as provided by FSK-to-MIDI devices or SMPTE-to-MIDI convertors like the Fostex 4050 or Roland SBX-80) for it to start playing or recording.

• “MTC Sync” means that the sequencer will wait for a MIDI Time Code number that corresponds to some point in the sequence before it will start playing or recording.

You cannot change the Sync setting while the sequencer is running. More information about synchronization can be found in Chapters 10 and 11.

When stopping playback with the Option key down in MTC sync, the sync mode is switched to internal.

When starting playback with the Option key down in internal sync, the sync mode is switched to MTC.

**Special Record Modes**

*Master Tracks Pro* has 4 Special Record modes: Punch In, Overdub, Looped Record, and Looped Overdub. These modes can be turned on and off with a button in the Transport window. (The button defaults to Punch In mode.) Double-clicking on the Special Record Mode button in the Transport Window (or choosing Special Record Mode from the Goodies menu) opens a dialog. This dialog lets you choose a record mode. You can also set the start and end points for the section in which you want Record to be active (This option is unavailable in Overdub mode.). When you have made your choices, click OK.

![Record Mode dialog](image)

1.5 The Record Mode dialog
The four special record modes are:

**Punch In:** - Highlighting this box will activate a selected region for recording. After you have clicked on Record or pressed the Enter key, the track(s) selected for recording will start to record only when the measure counter passes the punch-in point. The track(s) will stop recording (and go back to Play) when the counter passes the punch-out point. If you start recording between the two punch points, recording starts immediately.

*Note: You can punch in on any track while the sequence is playing. Record enable a track and start playback. Then press the Enter key when you want to start recording. Press the space bar to stop.*

**Overdub:** - Overdub mode lets you record onto an existing track without erasing the existing data. This is similar to a Mix of two previously recorded tracks, but done by playing in real time.

**Looped Record:** - Looped Record repeats the looped section and replaces the last pass with the current pass each time it loops. The previous track is erased each time around.

**Looped Overdub (Drum Machine Style Recording):** - This Record mode repeats the looped section, retaining and playing the last pass while recording the current pass each time the section loops (similar to the way in which most drum machines record).

**Selecting Insert Points for Special Record Modes.**

For any Punch, Looped Record and Looped Overdub, the in and out points can be selected in any window. Click at one point, drag left or right to the other, and release (this is similar to the procedure for selecting a region to edit, which will be discussed in the next chapter). Double-click on the Punch box and a dialog will open to confirm your settings. Click OK and you can proceed with the punch in.

You can also get to this window without setting up a region. Double-click on the Record Mode box and the window will open with values from the last time you made a regional selection. You can use these values, or enter new measure,
beat, and clock values for the punch points you want, from the Mac keyboard, and then click on OK.

The Special Record Modes cannot be activated unless at least one track has been record-enabled in the Track Editor window. When activated, the dot that normally appears as the record-enable indicator in the Track Editor assumes the form of a “button”.

De-activate a Special Record mode (and go back to normal record mode) simply by clicking on the Icon to de-select it. As with a normal Record operation, if you don’t like the way a Punch or Overdub turns out, you can cancel it with the Undo command in the Edit menu.

The Special Record Modes are unavailable for Fader Recording (see the Mixer section later in this Chapter).

*Note: Before you can record, you must select the track you wish to record by clicking in the appropriate box of the “R” column of the Track Sheet.*

**Thru**

This control is used when you’re recording from a master MIDI controller which doesn’t produce sound itself, or when you want to use one synthesizer to control another while recording.

Clicking on Thru toggles it on and off. When it is on, the MIDI data you send to the Macintosh will be echoed out one of the MIDI Out ports on your computer’s MIDI interface.

Double-clicking on the Thru box brings up a dialog box for setting the Thru port and channel. If the letter in the box is “A”, then the data will be sent out through the interface connected to whichever port is designated as Port A (usually the Modem port, although this can be changed in the MIDI Setup dialog box). If the letter is “B”, the data will go out Port B. (A more detailed explanation of how to use the ports appears later in this chapter.) The number in the box indicates which MIDI channel the data will be echoed on. If, instead of a channel number, a “–” appears there (for example, “A–”), all data will pass thru on whatever channel (or channels) it is coming in on.
The port and channel settings in the Thru box automatically change when a track is record-enabled in the Track Window — the port and channel assignments of the track being recorded are assumed by the Thru box.

In Multi-Track Record mode (which can be selected from the Layout menu), the Thru box will remain at its current setting regardless of what is going on in the Track Window, and must be double-clicked for any changes to be made.

In Multi-Channel Mode (see page 13), Thru will follow all chosen channels at the same time.

The Track Sheet

The Track Editor is the display window for some of the most basic information about your sequence. The left half of the Track Editor is called the Track Sheet and lists the 64 tracks available in Master Tracks Pro and allows you to select which tracks will record or play. You can also select a port and MIDI channel for the data in each track, choose a name and an initial MIDI program change for the track, set an initial volume for the track, solo one or more tracks, and loop tracks independently. The right half (or Song Editor) shows which tracks have MIDI data recorded on them, and in which measures. We’ll deal with this half of the window in the next chapter.

If the Track Editor is not already on your screen, or if it is hidden by other windows, you can activate it by choosing it from the Windows menu, or by pressing ≈ - 1 on the Macintosh keyboard.

The basic operation of this half of the window is simple. To change any item in the window, just click in its box. For settings that are either on or off, an icon in the box indicates the setting is on, while an empty field means that the setting is off.

For the “Chnl” (Channel) parameter, clicking on it opens a Change Channel Dialog which lets you enter the port and channel number for the chosen track. Master Tracks Pro will automatically sense the presence of a multi-port interface such as the MOTU MIDI Time Piece for 128 channel operation - see the Appendix for more information.
For the “Prg” (Program Change) and “Vol” (MIDI Volume) parameters, there are two modes - collapsed (numeric) and expanded (graphic). When collapsed, clicking on the box makes a “pop-up slider” appear. We’ll deal with pop-up sliders a little later. When expanded, you can access the Program Change Device List and the Recordable Volume Sliders.

Selecting Tracks to Play

You can select any combination of tracks in your sequence to play back. Tracks that are not selected, even if they contain MIDI data, will not play. Click in the Play box of each of the tracks that you want to play. The triangular play icon appears solid in each track’s Play box to show that the track is play-enabled, and it will sound when you start the sequence. Newly recorded or Pasted tracks default as play-enabled.

To turn play off for that track, click in the box again. The play icon will become hollow, and the track will not be played when you start the sequence. Tracks can be muted and turned back on during playback and recording. Tracks that contain no MIDI data, not surprisingly, cannot be set to play.

Selecting Tracks to Record

Normally, only one track can be selected for recording at a time. To enable a track for recording, click in the Record box for that track. A red circle appears
in the Record box to indicate that the track is record-enabled. When you start
the recording, all incoming MIDI data will be recorded on that track.
(If a Special Record mode has been enabled, the solid circle will be
replaced with a “button” icon.) As mentioned earlier, the port and
channel number in the Thru box will automatically change to match
the port and channel of the track selected for recording. If you don’t
select a channel, MIDI data will be echoed on the same channel(s) it
is coming in on.

To turn off the recording function of a track, click on the Record column for
that track again. The record icon disappears. Of course, you can also disable a
track’s record function by enabling a different track. After you complete an
initial recording on a track, that track is automatically play-enabled.

**Multi-Track Record**

*Master Tracks Pro* has a special mode for recording multiple tracks at once (e.g.,
from a guitar controller with each string set to a different channel, or from two
or more keyboards connected to a merger). It is called, logically enough, Multi-
Track Record mode, and it is turned on from the Layout menu. In this mode,
you can select as many tracks to record as you wish. The incoming data will
automatically be sorted out so that the data on each port and channel is re-
corded on a track that is assigned to that port and channel (in the “Chnl”
column).

To record-*disable* all tracks in the Multi-Track Record mode, hold down the
Option key while clicking on any active Record icon.

**Using Multi-track Record with Guitar Controllers**

You might set, for example, a guitar controller to transmit on channels 6
through 11, through the interface on port A. You would turn on Multi-Track
Record, and set track 1 on *Master Tracks Pro* to record on channel A6, track 2
to record on channel A7, and so on, through track 6 recording on channel A11.
Now each string is being recorded on its own track.

If data is coming in on a channel which is not assigned to a track, it will not be
recorded.
For safety’s sake, and for convenience later when editing the tracks, we recommend using an additional track to record the *entire* performance. Set the Channel on that track to “−”, which means that all MIDI data coming into the designated port will be recorded on that track, regardless of channel. Turn Thru on, and set its channel to “−”, and you will be able to hear the entire guitar’s output.

**Soloing tracks**

The Solo command gives you an easy way to play a single track or a few tracks without having to individually deactivate the Play box on all the other tracks. Then, when you want to hear more tracks again, you only have to turn off Solo on the selected tracks.

To select a track for soloing, just click on the track’s Solo box. You’ll see a solid black diamond pop up in the box. To turn solo off, just click on the box again. Any number of tracks can be soloed at a time.

To turn off all Soloed tracks, hold down the Option key while clicking on any active Solo icon.

**Looping**

Each track in a *Master Tracks Pro* sequence can be looped independently. When the sequence gets to the end of a track, it plays the track over again from the beginning, no matter what other tracks are doing. Since different tracks can be of different lengths, this can be a very effective tool.

A track can only end on a measure boundary — a track cannot be, for example, 31 measures plus 2-1/2 beats. (However, you can make measures just about any length you want — see the discussions in Chapters 7 [“Conductor”] and 11). Therefore, a track always plays to the end of a measure before looping back, even if no notes are playing in most of the measure, or even if the measure is completely empty, but still showing (as a hollow rectangle) in the Track Editor window’s right half. Trimming empty measures from the end of a track to put a loop point right at the end of the notes is discussed in Chapters 6 and 11.

To set a track to loop, simply click in the Loop box for the track, at the far right of the Track Editor window. The Loop icon will appear in the box. To shut the loop function off, click on the loop box again, and the icon disappears.
Note: If you start playback at a point after a track has ended, you obviously will not hear that track. This is true even if the track is set to loop — you must start playback at a point within the track you want to loop if you want to hear it.

Naming tracks

Each track can have a name, which you can use to describe the music in the track, or to remind yourself which instrument and/or sound you’ve chosen to play the track. These track names are saved permanently with the sequence file when you store it on a disk. Even a track that has no MIDI data can have a name, so you can leave memos on them for yourself (although the Notepad function is better designed for this — see Chapter 10).

Click on the Name box in the track you wish to name. A dialog box pops up and asks you to type in the name of the track. You can use any combination of characters you wish. When you’re finished, click on OK or press Return. If you want to return to the Track Editor window without making any changes, click Cancel.

For faster setup, you can quickly set any number of name fields. Hitting Option-Enter or Option-OK after entering track names now automatically brings up the name dialog for the next track.

To set the width of the Name pane, drag the mouse over the double line between the Name and Chnl headings. When the pointer changes to a double arrow, click the mouse and drag right or left to adjust the size.

Setting the Playback Channel

The Channel box on each track contains the current MIDI channel setting for playback of the track. To use this feature, you need a little background on the way the program handles MIDI channel information.

Master Tracks Pro supports multiple-channel tracks. In normal record mode you can record any combination of channels within a single track. Each recorded
note has a channel assigned to it, based on the transmitting channel of the
device used to record the data (i.e., the master controller or keyboard). When
you mix or merge tracks, the channel identity of every note is retained, so that
within a single track you can have notes of many different channels. (So that
guitar controller we recorded earlier on one track would still maintain each
string’s identity.)

If you enter a number between 1 and 16 in the Channel box, then when you
play the track, all data on the track will come out on that MIDI channel.
However, if a dash (“–”) appears in the Chnl column, the track is unassigned,
and will play back exactly as it is stored in memory, with each note emerging on
the same MIDI channel it was received on.

To change the channel, click on the channel
field in the Track Sheet and type in a number
for the channel when the dialog appears. If you
type a quick “1” followed by a number 1
through 6 you can also type in two digit
channels 10 through 16. Of course, you can
also click on the channel and port you desire.
The two rows represent the two basic port
choices (A & B). The “-” at the start of each column stands for “no
channelization”. With that choice selected any data on the track goes out on the
channel(s) it has been assigned to (remember - every message is assigned a
MIDI channel). Click on OK or press Return to enter it and return to the
Track Editor. Of course, you can click on Cancel to leave the setting as it was.
Remember that in normal Record mode, the “Thru” setting in the Transport
window follows the channel and port of any track that is record-enabled.

In Multi-Track Record mode, as discussed above, the Port and Channel
assignments apply to incoming as well as outgoing data. Only MIDI data
received on the assigned MIDI channel and port (as set in the Channel col-
umn) will be recorded on a track. If you wish all MIDI data coming in a port
to be recorded, put a “–” in the Channel column.

MultiChannel Tracks

To use Multi Channel Mode, click on the Multi-Channel switch in the
Channel dialog. Then select the channels (and ports) you wish to use (up to 8). With MultiChannel Tracks, a single part can play on up to 8 channels at the same time. This allows you to easily have multiple sounds play the same part. In other words, you can have one note message on one track sent out on two or more channels. Before, you could only do this if you used a track for each channel (by copying and pasting a track to other tracks and assigning each to a different channel). Now your lead keyboard line may actually consist of your Proteus’ Stereo Piano patch on channel 1, combined with a Roland Piano patch on channel 2 and a Casio Sampler string patch on channel 3. You could accomplish the same thing with three different copies of the same track assigned to different channels. If you started editing that part, though, you would either have to recopy the edited part to the other tracks or make each edit three times. Multi-channel tracks is one way to experiment with layering sounds.

Tips/Hints:
• For fast entry, hitting Option-Enter or Option-OK in the MIDI channel dialog will automatically bring up the channel dialog for the next track.
• Use letter keys to choose ports, Tab to cycle through ports, and number keys choose channels.
• The “Thru” control will follow Multichannel tracks

A Note on the Ports

Master Tracks Pro supports both the Modem and Printer ports of the Mac, provided you have a compatible interface that can address both ports (such as the MIDI Time Piece from MOTU), or two separate interfaces. This effectively gives you 32 discrete channels for MIDI playback. The Port designation in the Track Editor window lets you choose which software Port a track will be assigned to: A or B. Translating these settings into hardware (i.e., which physical port corresponds to which software Port) is the job of the MIDI Setup dialog box, selected from the Goodies menu.

When you first boot up the program, both Ports A and B are assigned to the Modem port. You can change this so that either or both of the software Ports is assigned to the Printer port. See Chapter 10 for more details.
*Master Tracks Pro* can also support a Multi-port interface such as the MIDI Time Piece from Mark of the Unicorn for 16 or 32 port operation. See the appendix for more information.

**Using the Pop-up Sliders**

Before we get to dealing with the Program and Volume parameters, let’s look at the pop-up sliders which are used to set them, and indeed are used all over *Master Tracks Pro*. In some windows the sliders appear just with numbers at the top, while in others, there is a line of text describing what the slider is selecting.

When a pop-up slider appears, you have several options of how to set it. When you click on the field that opens the slider and, without releasing the mouse button, drag over to the “knob”, you can then make the knob go up and down with the mouse. The slider’s numeric value is shown above the slider itself, and when you release the mouse button, the current value is entered in the parameter field the slider came from. If you decide *not* to change the value of the parameter, you can drag the mouse anywhere outside the slider box, and the displayed value will become the value you came in with. Release the mouse button, and everything is as it was.

When you click on the original field and immediately release the mouse button *without* dragging it over to the slider, the slider opens in “entry” mode: the value box at the top of the slider is highlighted, and you can type a new value in from the Macintosh keyboard.

You can also increment the value of the slider by clicking the mouse above the knob. If you click and hold, the value will continue to increment. You can decrement the value the same way by clicking below the knob.

When you’ve entered or incremented to the value you want, click on OK or press Return to enter the value, or click on Cancel to leave the value where it was before you started.

If you open the slider box in “slider” mode, you can get into “entry” mode by moving the slider up past the top of its range. The value box will highlight, and
you can type in a new value. If you open the slider in entry mode, you can get it into slider mode by clicking on the knob itself (or actually, anywhere within the slider’s range). Adjust the knob, and when you let go of the mouse, the new value is entered.

Setting the Initial Program Number

A “program” is the MIDI term for an individual “setup” or “patch” on a MIDI device, which is stored in the memory of the device. On a synthesizer or sampler, a program is customarily equivalent to a particular sound (e.g., trumpet, bells, dog bark), while on a drum machine a program may be a particular song, and on a MIDI effects device it may be a particular pre-programmed effect (e.g., long reverb, flange, distortion). Each program has a number, and when a MIDI program change message is sent to the device, the device responds by switching to the program whose number is in the message.

Master Tracks Pro allows you to record program changes at any point in a track, and also to enter as many program changes as you like via the Step Editor window (which will be discussed in Chapter 3). The Track Editor window lets you set up an initial program change for a track that will be sent on the track’s assigned channel whenever you start the sequence, before any notes play.

There are two ways to enter the initial program change. You can click on the “Pgm” field for the track in question, and set the number with the pop-up slider that appears. Following standard MIDI practice, a program change can be numbered from 1 to 128. You can also expand the "Prg" column and click to open a "Device" list for choosing a preset.

If the Program column for a track is showing “–” (which is the default), no program change is sent when the sequence begins — your instrument will remain set to whatever program it’s already on, until it receives a program change from within the sequence (if there are any). Also, if the track’s Channel assignment is “–”, no program change is sent (because the software has no way of knowing which channel it should be sent on).

If you start the sequence from some point other than the very beginning, you can arrange to have the program indicated in the Program field sent before the sequence starts to play by turning on the “program chasing” function in the
Chase Controllers dialog box, which is opened from the Goodies menu. When that function is on, then, wherever you start in the sequence, the initial program change on each track will be sent, unless there are subsequent program changes within the sequence prior to your starting point, in which case only the latest program change for each track will be sent. See the discussion on Chase Controllers in Chapter 10.

Note that when you enter a program change in the Track Editor, it is immediately sent out over MIDI on the track’s assigned channel. This will happen even when a sequence is playing, so it’s an effective way to test different patches with a track without resetting the synthesizer or effects unit.

**Note:** If you have two tracks assigned to the same MIDI channel and port, make sure that you send out an initial program change on only one of them. If you try to send out two program changes on the same channel at the same time, the results might be unpredictable.

### Using the Device Dialog

You can view each track’s instrument programs as names in addition to numbers with Master Tracks Pro. Several lists of popular device program names (factory presets) are supplied with Master Tracks Pro. You can also create custom lists of program names to add custom or new instruments to the list. The Device dialog can be used when setting an initial program change and can be used when entering a preset change in the Step Editor.
To use the Device dialog:
Click on the heading of the Program column (“Prg”) and the column expands to show the program name.

Clicking in a Program Name field calls up the Device dialog. In the Device dialog you can see the current device, the presets available, the track number/name (if any) and two “copy” checkboxes.

To select a different program:
Click on a name or move to it using the arrow keys. When the name is selected, the corresponding MIDI program change is transmitted in real time.

To select a different device:
Click and hold on the triangle at the right of the Device box. The Device Menu will appear, allowing you to either choose from the supplied list of devices, or add a new device to the list.

To add a new device:
Select “Add New Device” from the Device Menu. The “Enter Text” dialog will appear. Enter the name of the new device and click on “OK” or strike the return key to return to the Device dialog. To enter the various program names for the new device, simply select the desired location with the pointer or arrow keys and enter the name. (See next item)

To change a program name:
Select a name from the list. The selected name will appear in the “Name” box at the top of the dialog. Click on, and then drag across the “Name” box to select the entire program name, and then enter the new program name. An alternative method is to click in the “Name” box, activating the text cursor.

Choose any program name in the list and it will appear, selected, in the “Name” box. If you then wish to change other program names for the same device, simply choose the name to be changed from the list of program names and it will appear, automatically selected, in the “Name” box.

To delete a device:
Select “Delete” from the Device Menu to delete the current device. Master Tracks Pro will ask you if you are sure you want to delete that device. If you do, click on yes or strike the return key.
To rename a device:
You can rename the current device by selecting “Rename” from the Device Menu. The “Enter Text” dialog will appear allowing you to change the name of the current device.

Note: You can delete or rename any device on the list with the exception of the following devices: Generic, Gen 8x8, and Roland MT-32.

To Clone a device:
If you have two or more of the same MIDI device, you will probably want to be able to differentiate between those devices on the Track Sheet. The Clone feature allows you to create multiple copies of the same device. Select the device you wish to duplicate and then select “Clone” from the Device Menu. The “Enter Text” dialog will appear. Enter the name of the clone device (for example: If you are cloning the Korg M1, you may want to name the clone “Korg M1 #2”). Click on “OK” or strike the return key to return to the Device dialog. The clone is now the currently selected device and you can change the appropriate program names.

To save or load a Device File:
You can save your custom device setups to disk. This enables you to easily transfer them to other computers running Master Tracks Pro. Or you may wish to load only those devices that are being utilized in the current sequence. It also enables you to load your device setups into future updates of Pro.

To return to the Track Sheet:
After auditioning sounds and settling on your choice, you can either click OK, hit Return, or double-click your program choice to return to the Track Sheet. Your choice (both device and program name) will now appear in the Program Name column of the Track Sheet.

“Copy Device to All Tracks” Checkbox
When you select “Copy Device”, the program names of all tracks will change to the program names of that device. (The program numbers will be retained.) In other words, the same program number will be transmitted via MIDI, but the corresponding program name for the globally chosen device appears in the Program Name field.
"Copy Program name to Tracks Name" Checkbox
Clicking this checkbox will automatically put the current program name into the "Name" field on the Track Sheet.

Tips/Hints

- Choosing “Save Preferences” from the File menu will cause the current device to be chosen by default when you open new files.
- ≈ - space bar can start and stop sequence playback from device dialog.
- For initial program changes only: To make multiple track entries faster, click on the track number to bring up the track fader, then select a new track. This automatically sets (OKs) the previous track.

The Volume Column

MIDI Volume is a useful part of the MIDI specification that allows a device’s overall volume to be controlled externally. (It should not be confused with MIDI velocity, which is a measure of how hard a key is struck.) MIDI Volume commands are continuous — that is, they can be used to control a note after the note has been struck — so they can be used to control a mix. A mix always has to have a starting level for each sound, and that’s where Master Tracks Pro’s initial volume (“Vol”) parameter comes in.

Like the Program column, the Volume column has two modes. The collapsed (numeric) mode lets you view volume as a number. The expanded (graphic)
mode lets you view and record volume changes in a track with an automated mixer. You can toggle between the graphic and numerical displays by clicking on the Volume/Vol heading.

*Note: MIDI Volume is defined in the MIDI spec as Controller #7. Some synthesizers do not recognize MIDI volume commands — consult your synth’s manual to make sure.*

**Using the Numeric Volume Indicators**

If a number between 0 and 127 is entered in this box (using a pop-up slider), then a MIDI Volume command with that number is sent out on the channel associated with the track when the sequence is started. This gives an initial volume setting to the receiving synthesizer.

As with initial program changes, MIDI Volume commands will be “chased” if the sequence is started at a point other than the beginning, provided that “controller chasing” in the Chase Controllers dialog box is turned on. Also, any entries made to this box while a sequence is running will have an immediate effect on the corresponding track. This is a good way to test levels for a mix — use this function to find the level for a certain section, and then use the Controllers window to enter it permanently in the sequence at the proper place.

If you don’t want any initial volume command to be sent, set the level to “-.” This is the default setting. As with the Prg parameter, if the track has no channel assignment, no initial MIDI Volume command will be sent, regardless of the setting of the Vol parameter.

**Using the Recordable Volume Faders**

To use the faders, click on the heading box of the Volume column (“Vol”), the column expands to become a set of volume faders that can be used in real time to set or record MIDI volume levels for each of the tracks.

**To record the faders:**

Shift-click in the record field(s) of the Track Sheet (the icon will appear as a miniature fader).

Press the Record Button (or the Enter key) to begin recording.
Move the Fader(s) with the mouse to adjust volume.

The changes will automatically be merged into the track(s).

**Using the Master Volume Fader**

There is also a variable mode Master Fader window, selected from the “Goodies” Menu. With the Master Fader, you can fade all tracks at the same time or use this control as a “group” fader to set the sub-mix of several tracks at once (such as a multi-track drum part).

Click on the text field at the bottom of the fader to toggle the three modes:

**Live**: This mode sends out Volume (controller #7) to all tracks in real time only—volume information is sent out but not recorded.

**Absolute**: This is also a real time mode, but it sends the absolute fader position as the new “Master Volume” SysEx message. (Please note that there are very few instruments that will respond to this new control.)

**Record**: This setting allows for recording volume changes on tracks.

**To use the Master Fader in Record Mode:**
Enable Fader Recording (shift-click in the R column) for the tracks you want to control.

Click the Record button (or press the Enter key) to begin recording.

Move the Master Fader(s) with the mouse to adjust volume. The changes will automatically be merged into the tracks.

*Note: While this method will retain the relative levels between tracks (until you reach top or bottom) this will override any changes currently in the track!*

To scale the initial volume level on all tracks simultaneously, press and hold the option key and move the Master Fader up or down.
Tips/Hints for Volume:
• Fader recording is only possible in “standard” record mode (no looping or punching).
• When multi-track recording is on, all tracks are either in fader record mode or MIDI record mode.
• If multiple tracks are assigned to the same channel, moving a fader on any of those tracks will affect the volume of all tracks on that channel.
• The faders will appear “grayed out” on tracks that have not been assigned to any MIDI channel. If a track has not previously been set to a particular volume level, the fader will be “grayed out” until you click on it and drag it to an appropriate position.
• Faders snap to default position whenever the counter is returned to top, even with Chase off.
• - F opens the Master Fader window and brings it to the front.
• Master Fader mode is saved with prefs.

Moving tracks

In the Track Editor window, you can re-order the tracks freely. You may want to do this so that all your drum and percussion tracks, which you recorded at different times, are grouped together, or so that the tracks line up in order of channel number, or for any number of other reasons.

<table>
<thead>
<tr>
<th>Tk</th>
<th>Pr</th>
<th>Rs</th>
<th>L</th>
<th>Name</th>
<th>Chn</th>
<th>Prg</th>
<th>Vol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>bass</td>
<td>A1</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>harp</td>
<td>A2</td>
<td>32</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>melody metheney</td>
<td>A3</td>
<td>0</td>
<td>-</td>
</tr>
</tbody>
</table>

1.19 Moving a Track

You move a track by clicking in the track’s number at the far left side of the window, holding the mouse button, and dragging the track up or down to its new position. If there is already a track in the new position, it will be pushed aside to make room for the track you are moving. Master Tracks Pro always fills in track slots the best it can; if, for example, you move Track 1 to the Track 9 slot, Tracks 2 through 9 will get pushed up one position. If you move Track 11 to the Track 3 slot, Tracks 4 through 10 will get pushed down.
When you move a track in the left-hand side of the window, all of its data in both sides of the window will move with it.

Duplicating tracks

If you want to set up a second track with the same parameters as an existing track (name, channel, program, record/play status, etc.), hold down the Option key before you press on the number of the track you want to duplicate. Now drag to a new position, and the settings for that track will be a copy of the first one (the first one will remain in place).

However, if there is any data on the track in the position (as shown in the right-hand part of the window), it will be unchanged. Therefore the duplicated track’s parameters will be imposed on the old track’s data. This can be an effective tool for quick re-orchestration of complex files. (If the track has no data, the new track initially will not be play-enabled. It will, however, become play-enabled as soon as you put any data in it.)

Note that if the track that you are duplicating is record-enabled (a “•” appears in the “R” box), then any copy you make of it by Option-dragging will be record-enabled. If this happens, the original track will become record disabled unless Multi-Track Record mode is on.

Transposing

Tracks can be “locked” from transposing in this window by shift-clicking on the track number in the Track Sheet. The track will display a “lock” icon. This will prevent a drum track, for example, from being transposed when you do a “Select All” in the Track Editor. A lock icon will be displayed in the Transpose dialog if a locked track is selected for transpose.

Playing a sequence

To play a sequence, be sure the tracks you want to play are play-enabled and check that the MIDI channel for each track agrees with the MIDI device that you intend to play it on. If you wish, use the transport controls to move the Measure Counter to the point in the sequence where you want to begin play-
back (double-click on the rewind button to get it back to the beginning). You can start playback in one of three ways:

1. Click on the Play button in the Transport window.

2. Press the space bar on the Mac keyboard.

3. Assign a key on your MIDI keyboard to start playback. Selecting a key for this purpose is done with the Keyboard Setup command in the Goodies menu. See Chapter 10 for details.

Once you start the play function with one of these controls, the Play button becomes highlighted and the sequence will normally begin to play immediately. However, there are two conditions under which it will not play:

If the Count In button is highlighted, you will get a one-measure count in before the sequence starts, either from the Mac speaker or over MIDI, depending on how you have this feature set up. (If you don’t hear anything at all during the count in, it may be that you have assigned the count to a MIDI channel that has no receiving device assigned to it.)

If the Sync button (lower-right corner of the Transport window) is set to “MTC Sync” or “EXT Sync”, the program will wait for an external MIDI timing signal of one kind or another before starting. Click on it once or twice until it says “INT Sync”. (If you have already tried to start the sequence, you will have to click on Stop or press the space bar again before you can change this parameter.)

During playback, you can change the tempo of the music using the scroll bar on the Tempo window. (See more about this below.) You can also switch between windows while the sequence is playing, examine data, and even edit in any part of any track without interrupting playback.

Recording a track

To record a track, record-enable it by clicking in the Track Editor Record box as described earlier.
Master Tracks Pro can record on all 16 MIDI channels simultaneously on a single track. If you record a track containing data on multiple channels, as you might with a guitar controller, you can afterwards use the Strip Data command on the Change menu to move the data for each channel onto its own track. (See Chapter 7.) If you have a situation in which you are sending multiple-channel data to the program but only want to record the data from one channel, you can use Multi-Track Record, and just record-enable the track with the desired channel assigned to it, or you can turn on the Record Filter from the Goodies menu to filter out all channels except the designated one — see Chapter 10 for details on this.

Master Tracks Pro can record all types of MIDI data, but if you want to keep certain types of data from being recorded (such as aftertouch), you can use the Record Filter to eliminate that as well. If you want to separate various types of data after the recording is already complete, the Strip Data command on the Change menu can be used.

Start recording with one of these three options:

1. Click on the Record button on the Transport window

2. Press the Enter key on the Macintosh keyboard.

3. Assign a key on your MIDI keyboard to start recording, using the Keyboard Setup command (see Chapter 10).

Again, if you want to start recording immediately, the Count button must not be highlighted and the Sync button must read “INT”.

When you’ve finished recording, click the Stop button in the Transport window, press the space bar, or play the key on your MIDI keyboard that you’ve assigned to the Stop function (which can be the same as the key you assigned to Play).

When you have finished the first pass recording a new track, the program automatically activates the track for playback, and the play icon appears in the track’s Play box.
In *Master Tracks Pro* if you record over an existing track, you will erase it. If you want to overdub a second line on the same MIDI channel, assign another track to that channel (option-drag the track in the Track Editor if you like) and record your second pass on the new track. You can merge them later if you want to. It’s a good idea to get in the habit of deactivating a track’s record mode right after you’ve recorded it so you don’t record over it accidentally next time — although you can always Undo an accidental Record pass. Click on the track’s Record box in the Track Editor window, so that the circle disappears from the box.

### The Tempo Window

The Tempo window is a small but very important *Master Tracks Pro* window, since it displays sequence tempo and meter information. (If the Tempo window is not on the screen, or if it is hidden behind other windows, you can make it visible by choosing it from the Windows menu.)

At the bottom of the Tempo window, from left to right, appear the time signature, the value of a beat as interpreted by the program’s metronome (i.e., whether it sounds on each quarter-note, each eighth-note, or each dotted-eighth in a 6/8 bar, etc.), and the tempo. These settings reflect the values at the current position of the measure counter. If the meter and tempo stay the same throughout a piece, then these values will not change regardless of the measure counter position, but if there are tempo or meter changes, they will be reflected in this window as the sequence plays or as you move the measure counter.

These values are all recorded in a special *Master Tracks Pro* track called the Tempo Map. The Tempo Map allows each measure to have its own time signature and beat note, and it allows tempo to be changed as often as you could possibly want — up to 240 times per quarter-note (i.e., on each clock). To change anything in the Tempo Map, you can open the Change Conductor dialog box, either by clicking on the time signature in the Tempo window, or by choosing Conductor from the Change menu. For some Tempo Map adjustments, you can use the Tempo Map window (Windows menu). See Chapters 4, 7, and 11 for more information.
However, as mentioned earlier, you can use the tempo scroll bar in the Tempo window to make temporary changes in the tempo, even while a sequence is playing or recording. This tempo change is not recorded as part of the sequence, and is called an “offset tempo”. You can see the current offset tempo setting in the top of the Tempo window, while the “permanent” tempo setting for the sequence is shown at the bottom. (If there is a tempo change in the Tempo Map that occurs while you have made a tempo offset, that new tempo will be offset as well, by the same factor.)

As is normal for a Macintosh program, there are three ways to change the offset tempo using the scroll bar:

1. Click and hold on the scroll box in the scroll bar and drag it.

2. Click anywhere in the gray part of the scroll bar and the scroll box will move rapidly toward that location and cause a corresponding rapid change in the offset tempo setting.

3. Click or click and hold one of the arrow controls at either end of the scroll bar. This changes the offset tempo value in 1-beat-per-minute increments.

The offset tempo scroll bar only functions when the program is in Internal sync mode. If you are syncing to an external source, the scroll bar has no effect.

**Resetting the original stored tempo**

You can easily return to the stored tempo (tempo with no offset) after you have altered the tempo with the Tempo Offset (in the Tempo window) by clicking in the "q = " field.

For the sake of this example, let’s say that the tempo map of your sequence is set to a constant $q = 120$ and you have set the Offset Tempo to 140. Click in the $q = 120$ field and the Tempo Offset will immediately snap back to 120, the same value as the actual stored tempo.
The right half of the Track Editor window shows how the tracks in a sequence are constructed measure-by-measure. In this window, tracks can be edited one measure at a time, or in groups of measures and/or groups of tracks. You can move sections of music within a sequence or build new sequences from segments of other sequences. You can also modify the data in a variety of ways using the commands in the Edit and Change menus.

Editing events individually or in smaller regions is handled in the Step Editor, MIDI Data, and Event List windows, which are covered in the next two chapters.

On the left edge of the right half of the Track Editor window are the track numbers. Along the top are the measure numbers. Recorded tracks appear on the screen as a horizontal row of rectangular boxes, each box representing a measure. Solid black boxes contain MIDI data (which may or may not include notes); hollow boxes are measures that have no MIDI data.

The grey vertical bar at the end of the data area represents the end of the Tempo Map for the sequence. Even if the tracks you’re looking at are completely empty of MIDI data, and no measure boxes are on the screen, the grey bar will still appear at the measure where the Tempo Map ends. As explained in
the previous chapter’s section on looping, different tracks can be of different lengths, The Tempo Map is always as long, or longer, than the longest data track. If you record a track of any length in a brand-new sequence, a Tempo Map of the same length is automatically created. It is possible to have a Tempo Map that contains measures with no data, but it is impossible to have a measure in a data track that has no corresponding Tempo Map. Details on changing the length of a Tempo Map are in Chapter 6.

You can scroll through the track data in the Track Editor window using the scroll bars as you do with other Macintosh programs. Scroll vertically to look at other tracks, and scroll horizontally to look at earlier or later measures. You can also scroll while selecting blocks of measures — we’ll get to this in a moment.

The Measure Ruler

The row of numbers at the top of the right side of the Track Editor window is known as the “measure ruler”. It marks off measures in the sequence so that you can keep track of which part of the sequence you’re looking at. The number of a measure appears immediately to the left of the measure itself.

Clicking on a measure in the measure ruler selects that measure across all 64 tracks, plus the Tempo Map.

The number “1” always appears at the beginning of the measure ruler, and then every fourth measure is numbered (4, 8, 12, 16, etc.), with short vertical marks appearing for other measures. That’s the way the program defaults — if you want to change the numbering scheme, press one of the number keys 3 through 0 on the Mac keyboard. The number you press will become the multiple of the bars that are numbered: pressing 3 numbers measures 3, 6, 9, etc.; pressing 5 numbers measures 5, 10, 15, etc., and so on. Pressing 0 numbers every 10th measure. The “+” key will increment your selection by 1 and the “-” key will
decrement it. The measure-numbering scheme is not saved with the sequence; instead it is saved in the Preferences file (see Chapter 5).

**Show/Hide "Measure Display"**

The Measure display is an indicator that shows you exactly where the arrow pointer is in the Track Editor. Use this to accurately select insert points for precise cutting and pasting in the Track Editor.

*Note: This indicator is only visible when the marker ruler is showing.*

**Using Markers**

*Master Tracks Pro* provides markers that let you identify a particular location in your sequence so that you can return to it any time you wish. Markers placed in the Track Editor window are always at the beginning of a measure. From other windows it is possible to place markers within measures, but when you view those markers in the Track Editor window, they will appear at the start of the measure they’re in.

*Master Tracks Pro* markers look and act very much like Tab stops in a word processing program. Markers are displayed at the top of the Track Editor, Step Editor, and MIDI Data windows, just below the window’s title bar, in the *marker ruler*.

The marker ruler can be hidden in all windows — choose “Hide Markers” from the Layout menu. To get the markers to reappear, choose “Show Markers”. Markers are still active even when they are hidden.
Placing a marker

When the marker ruler is visible, you'll see a small box at its left end containing a hollow upside-down triangle. This box is called the “marker well”. To place a marker into the marker ruler, click and hold over the well. Another upside-down triangle, the marker you’ll be placing, will appear just below the well. Now, while still holding down the mouse button, drag the new marker to the measure where you want to place it. Once you’ve positioned the marker, release the mouse button.

The marker will remain where you’ve placed it, and will become solid black. In addition, a vertical dotted line will appear below the marker, extending through the track data indicators to help you see exactly where the marked measure is in your sequence. You can move the marker any time by clicking and holding on it, and dragging to its new location. You can delete a marker by dragging it off the left edge of the window.

Naming markers

Master Tracks Pro lets you name the markers on the screen. Once you’ve named a marker, the name appears to its immediate right on the marker ruler in any window.

When you first place a marker, a dialog box appears that asks you to give the marker a name. Type in the name from the Mac keyboard, then click on OK or press Return to enter it and return to the Track Editor. You don’t have to name the marker, just click OK or press Return.

Moving to a marker

To move the Measure Counter and the front window (Track Editor, Step Editor, or MIDI Data window) to the next marker in the ruler, press the Tab key on the Macintosh keyboard. The view will change so that the next marker is at the extreme left of the window. You can now record or play from this point. If you want to reach another marker, then simply press the Tab key repeatedly until you reach the marker you wish. (If the Auto function is turned on, the Measure Counter will not change — only the data in the window.)
When you are on (or past) the last marker, pressing Tab will have no effect.

To move back to a previous marker, press Shift+Tab. Again, the data lines up so that the marker is at the left edge of the window. If you are on (or before) the first marker in a sequence, pressing Shift-Tab will send you to the beginning of the sequence.

The Markers window

The Markers window, which is accessible from the Goodies menu, contains a complete list of all markers in a sequence, and lets you add, delete, re-position, and re-name markers, as well as “lock” them. Locking a marker can be useful when you are working with film or video and need to line up specific visual events with musical events. See Chapters 10 and 11 for details.

Markers can also be imported into a sequence through a MIDI File. A Master Tracks Pro marker is equivalent to a “text event” as described in the MIDI File specification. When a MIDI File containing text events (see MIDI File Options /File Menu - Chapter 8) is loaded into Master Tracks Pro, they will show up as markers, and can be treated as if they were created within Master Tracks Pro.

Editing in the Track Editor window

In the Track Editor window you can easily change MIDI data in large regions using all the commands on both the Edit and Change menus (see Chapters 6 and 7 for more about the actual editing functions). Again, the smallest unit available for editing changes in the Track Editor window is an entire measure, and all edits are done on multiples of whole measures. Also, the edits you make in the Track Editor window affect all types of MIDI data at once (in the individual MIDI data windows, they just affect the data being shown in that window). Commands like Cut on the Edit menu, or Channel on the Change
menu, affect MIDI data such as controller data, sustain pedal, and program changes, as well as note information.

Selecting measures to edit

To make changes to one or more measures of your sequence using Edit or Change menu commands, the region of measures must first be selected. Selected measures appear on the screen highlighted in inverse video. To select one measure on a single track, click on one side of the rectangle corresponding to that measure and drag slightly to the opposite side, until you see the rectangle highlighted, then release. To select adjacent measures and/or measures on adjacent tracks, hold the mouse button down and keep dragging.

Selecting a block of measures

There are two ways to select a large block of measures across multiple tracks. First, you can position the mouse pointer at one corner of the block, click, and drag towards the diagonally opposite corner until the inverse highlight covers all the measures you want to select. If all the measures you want to select aren’t visible on the screen, you can scroll the screen simply by dragging to any edge of the window. The window will scroll and the selection highlight will move with it. This technique — known as “hot scrolling” — can also be used to scroll the Track Editor window, even if you don’t want to select that particular block of measures. In that case, when you’re through scrolling, simply click again, and the selected block will be de-selected.

Second, a block can be defined by clicking at one corner of the block, holding down the Shift key on the Mac keyboard, and then clicking on the diagonally opposite corner.
If you want to select a range that is larger than what you can see in the window, click on one corner and use the scroll bars to move to the second point. Next, hold down the Shift key and click on the second point — the entire area between the Clicks will be selected.

If you want to select measures in two tracks that are not adjacent to each other, you can move the tracks so they are adjacent, as described in the previous chapter. For example, if you want to perform an operation on Tracks 5 and 11, grab the track number at the far left side of the window for number 11, and drag it up so it’s directly underneath 5. Now the tracks will be numbered 5 and 6, and you can work on them together.

**Selecting an entire track**

To select an entire track for editing, click on the track number in the left hand column next to measure 1 (not the far left “Tk” column). To select several adjacent entire tracks, click and hold over the first track number in the group, and drag the mouse up or down in the track number field.

**2.8 Selecting an entire track**

**Selecting measures across all tracks**

To select one measure in all tracks, click on the column for that measure (just to the right of the number or vertical mark) in the measure ruler at the top of the window. To select adjacent measures in all tracks, click and hold on the column for the first measure in the group and drag to the column for the last measure you want to include.
To de-select a selected area, simply click anywhere in the right half of the Track Editor window.

*Note: If you plan to Cut, Copy, or Clear a region that includes notes that are tied from or to other measures, you should read the section on tied notes in Chapter 6 for details.*

**Selecting and Editing While a Sequence is Playing**

You can select regions to edit and perform edits as a sequence is playing. If the edit is performed on a section of the sequence that has already been played, then you obviously won’t hear the results of the edit until the next time you play the sequence. Sometimes if you perform an edit on a track while notes on that track are sustaining, the notes will be interrupted. Rest assured this is just temporary, and the notes will play to their full length the next time you play the sequence.

**Playing a Sequence from the Track Editor**

Click on the Play button or press the space bar to start playback. You can set the Track Editor (or whichever window is in front) to scroll through the sequence data during playback by choosing Follow Playback from the Layout menu. When Follow Playback is on, and the Track Window is the active window, a vertical highlight bar moves along the track data as the sequence plays, to indicate the measure currently playing.
Setting the playback point

With the “Auto” function off, you can set the starting point of a sequence within the Track Editor window by pointing at the measure you want (scroll if you need to) and clicking. The Measure Counter will reset itself to this measure and the next time you click Play or Record, the sequence will start from this point.

*Note: You can control the playback point in the same way when you are using the Step Editor window or any of the MIDI data windows.*

Shortcut to the Step Editor

From the Track Editor, you can move directly to the Step Editor window to work on any specific measure in any track you wish. Simply double-click on that track and measure in the Track Editor window, and the Step Editor window will open at the point at which you’ve clicked.

Note that this function will not work if there are no measures at all in a sequence — if you want to start working on a sequence by entering data from the Step Editor, you will have to open the window from the Windows menu or press ≈+3.
The Step Editor window lets you view and edit note data, one track at a time. It provides a variety of precision tools that let you input and edit notes individually or in groups. It also lets you perform certain editing operations on non-note data, even though it doesn’t display it.

To open the Step Editor window:

- Choose it from the Windows menu, or
- Type ≈ –3 on the Mac keyboard, or
- Double-click on a specific track and measure in the Track Editor.
In the first two cases, the window will open at the current cursor position in whatever window was opened last, and on whatever track was last viewed in this or any other data window, (if this is the first window opened, it will open at measure 1 of Track 1). In the last case, the window will open on the track and measure where you have clicked.

The Step Editor window contains a graphic display of one track’s worth of note events. This area is divided by a grid of solid lines and a finer grid of dotted lines that makes it easy to accurately determine the position of notes in the window. The dashed lines indicate the note division between "E" and "F". The solid lines indicate measure boundaries and octave divisions. The window usually has a measure boundary at its left edge. The dotted lines show a pitch division at every “white key”. You can turn off the dotted lines and just show octave divisions (giving you a somewhat “cleaner” screen) with the Hide Grid command in the Layout menu. You can bring the dotted lines back with the Show Grid command.

The Notes

The note data itself is displayed as a sideways “piano roll”. Each note is represented as a small horizontal rectangle, or block. The vertical position of the block reflects the note’s pitch, and it can be referenced to the picture of the piano keyboard at the left edge of the window. In addition, when you move the cursor to a particular note, the pitch indicator box at the top of the window will show its position as a note and an octave number (e.g., “G3”). *Master Tracks Pro* can handle all MIDI pitches, which range from C–2 to G8 (middle C is C3). Accidentals are always displayed as sharps.

The horizontal position of the block shows the note’s position in time. It is referenced to the enlarged measure ruler that lies along the top edge of the data area of the window. In this ruler, each “box” is a measure, and each short vertical line within the box is a beat marker. (Remember, the beat may not always be a quarter-note, depending on the beat setting in the Conductor window.) If you move the cursor to a note, the time indicator box at the top of the window will show the position in measures, beats and clocks of the cursor (although not necessarily of the note).
The horizontal length of the block represents the note’s duration. You can estimate the duration of the note by comparing it against the markings in the measure ruler. There are more accurate ways of determining note durations, which we’ll get to in a moment.

Markers

Like the Track Editor, the Step Editor window has a marker ruler. If any markers are set, they’ll be displayed here just as in the Track Editor window. The marker ruler can be toggled on and off by selecting Show/Hide Markers from the Layout menu. Hiding the marker ruler expands the data area slightly so you can see a greater range of notes. Markers are still active even if they are hidden.

Placing, moving, naming, and removing markers is done just the same as in the Track Editor, using the marker well in the upper left corner of the window. The only difference is that in the Step Editor, you can place markers anywhere within a measure, to within an accuracy of one clock if necessary (see the section on zooming on the next page). You can move the window forwards or backwards to a marker by pressing Tab or Shift-Tab, respectively. If the Auto function is turned off, the measure counter will follow. If the marker is inside a measure, the left edge of the window will move to the beginning of the measure that contains the marker.

Program Changes

A "Program Change" well lets you select and change presets in a track. Like the marker well, you can simply grab the icon and drag a program change to any location. Initial program changes are marked with a
hollow icon to show they cannot be dragged. Double click on a triangle to change the program or to call up the Device List dialog.

Also, you can record program changes directly, by selecting them from your MIDI instrument when in Keyboard Step entry mode.

**Icons and Information**

At the top of the Step Editor window there are two rows of icons and parameter settings, collectively called the Toolbar. On the top row of the Toolbar, you’ll see several note icons, representing the rhythmic values of the notes you can insert with the pencil or step-enter from a MIDI keyboard; a tuplet box; and controls for note articulation and velocity.

On the second Toolbar row are several note editing icons, the pitch and time indicators already mentioned, the Current Track box, the MIDI channel control box, and the name of the current track.

All of the items on the first Toolbar row, as well as the channel control box, apply only to the input of new notes. The remaining options are used in a variety of entry and editing functions.
Scrolling and zooming

As in the Track Editor window (and like any standard Macintosh program), you can scroll through the data in the Step Editor window using scroll bars.

*Master Tracks Pro’s* two Zoom commands let you decide how much of the track data you can see at one time in the Step Editor window. Like a zoom lens, the Zoom commands let you move your perspective in or out for different levels of “magnification”. You can zoom in to work on small portions of the track more precisely, or zoom out to see more notes at once.

The Zoom level you choose not only affects how much of the track you can see, it also determines how precise your editing changes and additions can be. This is because the Zoom level sets the minimum number of “clocks” that you can move the mouse. When you’re zoomed all the way out, moving the mouse by a single pixel on the screen moves you 24 clocks (1/10th of a quarter-note) in the sequence. When you’re zoomed in all the way, you can move the mouse by individual clocks (1/240th of a quarter-note), allowing you to place notes (or, in other windows, any MIDI data) with single-clock accuracy. At the maximum zoom level, the left-hand edge of the Step Editor window may no longer be a measure boundary, because an entire measure will not fit into the window — instead, it will fall on a beat.

*Master Tracks Pro* gives you six different Zoom levels. To zoom in one level, choose the Zoom In command from the View menu or press ≈–[ (left bracket) on the Mac keyboard. To Zoom out, choose the Zoom Out command, or press ≈–] (right bracket) on the keyboard.

3.5 Zooming In
Viewing different tracks

The Step Editor window displays note data from only a single track at a time, and you must switch the display to another track to edit its data. Change tracks by clicking on the Current Track box (the box that says “T1” in it when you’re looking at Track 1) or by pressing the “T” key on the Macintosh keyboard. This brings up a pop-up slider, as described in Chapter 1 — set the slider to the number of the track you want to view and let go, or click above or below the “knob” to increment or decrement the track number, or type in the number of the track on the Mac keyboard. As you move the slider or type in a new number, the name of the track being selected (if it has one) appears above the number. When the track you want appears, click OK or press Return.

When you change tracks, the name of the new track (if it has one) will appear in the long box on the far right of the Current Track box. You can change the track’s name (or give it one if it hasn’t got one) by clicking in that long box. A dialog box opens for you to type in the name. Any name that you give a track in this window will appear in the Track Editor window, and indeed, all windows with a track name box.

Playing a sequence

As in the Song Editor window, you can play your sequence while you are using the Step Editor window. At your option, you can have the Step Editor window scroll through the track data while the sequence plays. Turn on the Follow Playback command on the Layout menu to enable this feature. As the track plays, a line of inverse video moves across the window, indicating the current beat. The Step Editor Window must be selected as the active (front) window for this indicator to show and for scrolling to take place during playback. The advantage of turning Follow Playback off is that you can freely examine and work on different sections of the track while it is playing, without the window constantly resetting itself to show the current measure.

The playback/record starting point can be set by selecting the arrow pointer on the second line of the Toolbar and clicking at the desired location in the window (this will only work, as always, if Auto is off). The starting point can be on a measure boundary, or anywhere within a measure.
As in the Song Editor window, regions can be chosen for editing while a sequence is playing. We’ll get more into this in a moment.

You can toggle various functions of the Track Editor window from within the Step Editor window, using special Macintosh key combinations, so that you don’t have to go back and forth so often. These commands will only affect the track currently showing in the Step Editor window:

Option-P: Enables/disables playback of the track
Option-R: Toggles the record-enable function of the track, and changes the Thru port and channel (if it is enabled) to the port and channel of the track (if it has been assigned)
Option-S: Turns Solo on or off for the current track
Option-L: Turns Loop on or off for the current track

**Editing Data**

Master Tracks Pro’s Step Editor window lets you work with data in a number of ways that fall into three main categories: regional editing, note insertion, and individual-note editing. Regional editing lets you alter both note and non-note data. Individual note editing only applies to notes.

**Regional editing**

With regional editing, you can quickly edit a group of notes all at once. Using the commands on the Edit and Change menus, you can move, copy, or delete the note data; transpose the pitches of all the notes in the region; change MIDI data such as MIDI channel and note velocity; and alter timing and expression in several ways. See Chapters 6 and 7 for more details on these features.

You can also edit non-note data, although you can’t see it. In the upper left corner of the window is an icon with a picture of two notes. If you click on it, it changes to the word “all”. This icon toggles the non-note editing function. When you see the notes, it means that any edits made in this window will only affect

---

3.6 The Notes/All Button
note data. When you see “all”, it means that edits will affect both note data and any other MIDI data (controllers, pitch bend, program changes, etc.) that happens to fall within the region you specify.

The setting of this icon also affects Edit operations having to do with this screen which may not be obvious — see Chapter 6 for details.

**The Time Indicator**

For many operations, you need to be able to locate notes precisely in the data area both in terms of time and pitch. That guidance is provided by the time and pitch indicators in the Toolbar, which were mentioned previously.

For many editing commands, the measure and beat markings in the measure ruler at the top of the step editor window will give you all the information you need to locate the end points of your region. For more precise work however, you can use the time indicator in the Toolbar to begin and end the region at exactly the right point. The time indicator usually displays the time value at the current position of the cursor, in measures, beats and clocks — the exception is when you have grabbed a note for editing, which will be discussed later.

Since all editing operations occur on clock boundaries, how precisely you can define the beginning and end of a region depends on the Zoom level. At the highest magnification, zoomed all the way in, you can define the region by individual clocks (1/240th of a quarter-note). When you’re zoomed all the way out, on the other hand, the resolution is much coarser, and the smallest movement of the mouse represents 24 clocks, or one-tenth of a quarter-note.

**Selecting a region to edit**

In the Step Editor window, there are a number of ways to set up regions for editing. Regions can have their boundaries on any clock, not just on measure boundaries, but they can only cover one track at a time.

To select a region, first choose the arrow pointer from the second line of the Toolbar, or press the “A” key on the Mac keyboard. Move the pointer into the data area of the window, above and to the left of the first note you wish to
include in the region (not on it). Click and hold the mouse button, and drag the pointer down and to the right, so it is both past and below the last note you wish to include.

As in the Track Editor window, you can “hot-scroll” the screen while selecting a region by dragging the pointer to the right or bottom screen boundaries. As you select a region, the region becomes highlighted in inverse video. Release the mouse button when you’ve included all the notes you want.

You have now defined a rectangular region that has horizontal boundaries (time) and vertical boundaries (pitch). Any notes (or other data if “all” is selected) within those boundaries will be included in the editing operation you choose next from the Edit or Change menu; any data outside the boundaries will not be included. (The vertical boundaries apply only to notes, regardless of what editing mode you are in, while the horizontal [time] boundaries apply to all data.)

The rectangle does not have to be selected from upper-left to lower-right in the manner described — that was just an example. You can define it by selecting any corner of the rectangle you like and moving up or down, and left or right.

If you want to select all the pitches within a time frame, double-click and hold at the left or right edge of the time frame at the second click, and move the mouse to the left or right. If you want to select one or more entire measures (with all pitches), single-click and hold in the measure ruler, and drag the mouse left or right for multiple measures.

All of these selection methods support Shift-clicking — if you click once in the data window, and then Shift-click somewhere else (either on the screen or at a point you’ve
scrolled to), the two clicks become the opposite corners of the selection rectangle (as long as neither of them is directly on a note). If you double-click in the data area and Shift-click elsewhere, the two clicks become the left and right sides of an “all-pitches” selection region. If you single-click in the measure ruler and Shift-click elsewhere, the clicks become the left and right sides of an all-pitches region that begins and ends on measure boundaries.

**Important:** Edit menu commands will only affect notes in the selected region if those notes begin within the region. That’s one reason to pay attention to the Zoom level while you’re selecting a region — a note can appear to be within the selected region when it actually starts slightly before the beginning of the region, and you may be zoomed out too far to see this. If the beginning of a note falls within the selected region, the entire note will be altered by the command you use, even if the end of the note isn’t included in the selected region.

There is an exception to this rule, however. A note in the selected region that is tied over from an earlier measure is recognized by commands such as Cut, Copy, and Clear if the region begins precisely on the measure boundary. In this case, the region will include that portion of the note that starts at the measure boundary — but not the portion that precedes the measure. Don’t worry too much about this for now — it’s explained more in Chapter 6.

3.10 Notes that start before a selected region are not included in the region unless the region starts on a measure boundary.
Inserting New Notes

Master Tracks Pro gives you two ways to insert new notes in your sequence in the Step Editor window: you can use the mouse exclusively, or you can enter the desired pitch by playing the corresponding key on your MIDI keyboard, in “step-time” entry.

You can “audition” notes by holding down the Command (≈) key. The pointer turns into a hand, with one finger pointing up. Move the hand up and down in the data area so that the finger is on the same level as a note you want to hear, and click the mouse. The note will sound, on the MIDI channel assigned for the track in the Track Editor window, at the velocity shown in the Step Editor’s velocity box, for as long as you hold the mouse button down.

You can re-trigger the note by releasing and pressing the mouse button, or you can hold the button down and move the mouse, and every time you reach a new pitch, it will sound. Besides reminding you what a particular track sounds like before you enter data into it, this feature is very useful for drum machines or samplers with split keyboards, in that you can look for a sound associated with a particular pitch easily without going to your keyboard or recording any data.

The first task in the entry process is to select values for the duration, velocity, MIDI channel, and articulation of the note(s) you want to enter.

**Duration** - Choose the duration, or rhythmic value, by clicking on the appropriate note icon at the left side of the top line of the Toolbar. Selecting the dot icon multiplies the duration of the note value by 1-1/2. You can also select note durations using the numeric keys on the Mac keyboard: typing “1” select the whole note, “2” the half, “3” the quarter, etc. up to “7” for the 64th. Typing “D” adds the dot to the selected value.

If you wish, you can select a combination of note values, and all the selected values *add together* for the total duration of the note you are inserting. To select more than one value, click on the first note duration you want to select, and
then Shift-click on the remaining note durations (this does not work with the Mac keys).

You can enter notes with non-integral duration values, referred to as “Tuplets”. To enter these, click over the word “Tuplet” in the tuplet box in the top line of the Toolbar. When the box is highlighted, any notes you insert will have the tuplet value shown in the box. For example, say the value in the tuplet box is 3:2, and you’ve selected the eighth-note duration icon. If you turn the tuplet command on, the timing of the notes you insert will be adjusted so that three of these notes would fit in the time normally occupied by two regular eighth-notes (i.e., a quarter-note). This is equivalent to eighth-note triplets. You can choose a wide range of tuplet values to create complex polyrhythms or to experiment with other unorthodox note timings. For example, for a 16th-note quintuplet (five notes in the space of a quarter-note), you would set the duration value to 16th-note, and then set the tuplet value to 5:4 — or set the duration to eighth-note and the value to 5:2.

To set a new tuplet value, click on one of the numbers in the tuplet box. A pop-up slider appears, which can be set anywhere from 1 to 64. When you’ve finished adjusting one number, adjust the other one. Remember that the tuplet will not actually take effect unless the Tuplet command in the left side of the tuplet box is highlighted. (To make tuplets from existing notes, use the Change Duration or Scale Time commands — see Chapter 7.)

**Articulation** - Articulation, velocity, and input channel are also set using pop-up sliders which appear when you click in the appropriate boxes.

Articulation refers to the percentage of the note’s duration value that it actually plays. An eighth-note duration with 50% articulation will actually result in a 16th-note. By varying the articulation setting, you can make changes in note length to define phrases as legato and staccato passages. Shorter articulations produce a more staccato effect. The range of the articulation variable is 1% to 100%.

**Velocity** - The velocity box gives you control over both the note-on and note-off velocities. Note-on velocity is usually (but not always) related to volume. Velocity values can range from 1 to 127 (a note-on velocity value of 0 is defined in the MIDI specification as a form of note-OFF, so it is not available). Very
few MIDI devices respond to note-off velocity, so unless you have one of those, it’s best to leave that parameter at 64.

You can choose to record or ignore the velocity from your keyboard when you step enter notes. Click on the On Vel and Off Vel rectangle to toggle the “Record Velocity” switch. A normal display will record keyboard velocity, while an inverse display will enter all notes with the velocity value chosen in the “On Vel” field.

**Show/Hide Velocity**

The velocities of each note can be shown as a line at the beginning of the note in the Step Editor. Simply choose Show Velocity from the Layout menu to activate. Velocities (when shown) can be edited by clicking on the head of the note with the arrow tool and dragging the line up and down. When changing velocity in this manner, the current value is shown in the Vel On field.

**Input Channel** - The MIDI channel control box (the one next to the Current Track box, marked “C1” or whatever the current MIDI channel is) determines the MIDI channel identity of the note(s) you place. If the track has a specific channel assigned to it in the Track Editor window, then this parameter will show that channel. If it is an unassigned track (the Chnl column in the Track Editor says “–”), it will say “C1”. You can change the setting of this parameter by clicking in it. A pop-up slider appears with a range of 1 to 16.

After you reset this parameter, any notes that you enter will have the new parameter setting as their channel number. Of course, if the track has a channel assignment, then these individual-note channel numbers will be irrelevant, but if it has no assignment, the channel number of each note will determine what MIDI channel it plays on. This setting will also affect which MIDI channel notes will sound on when the previewing “hand” icon is being used (assuming there is no channel assignment for the track).
Inserting the Notes with a Mouse

To insert notes using the mouse, first select the pencil icon in the Toolbar by clicking on it, or press the “P” key on the Mac keyboard. When you move the pointer to the data area, it becomes a crosshair that lets you position the new note exactly where you want it on the screen. You can place notes anywhere, but have the choice of free placement or a "Snap-to-Grid" option.

To activate “Snap-to-Grid”, click on the note icon in the middle of the bottom row of icons to highlight it. Any notes placed with the grid on will be quantized to the selected note value. Select different note values by double-clicking on the note icon. When placing notes with snap-to-grid off, watch the keyboard graphic at the left of the data area and the measure and beat markings along the top as you align the crosshair. Also keep an eye on the pitch and time indicators in the Toolbar so you can locate the position precisely.

When you have the correct position, single click on the mouse. A new note bar will be inserted into the data area at that position, its length corresponding to the duration, velocity and articulation you selected.

Step-Time Note Entry from a MIDI Instrument

Step-time entry from a MIDI keyboard is a very useful feature of most good sequencers. In Master Tracks Pro’s implementation of it, track number and duration are determined by the computer, and note pitch and velocity are read in from the MIDI keyboard.

You can select the durations, articulation, and input channel as described above. Note the relationship between duration and articulation: duration determines how far apart the notes will be (i.e., the rhythm), while articulation determines how long they will be. So using the same example as above, a string of notes with eighth-note duration and 50% articulation will be recorded as 16th-notes with a 16th-rest between each one.

When the "Vel" window is highlighted, you can step record the velocity of each note as it is played from the keyboard. When not highlighted, you record a constant value as set in the "Vel" window.
Once you’ve set the parameters, turn on step-time entry by clicking on the little “keyboard” icon next to the arrow in the Toolbar. (A track *does not have to be record-enabled* in the Track Editor window for step-time entry to be active.) Since you’re using your MIDI keyboard to enter pitch and velocity data, you don’t need a crosshair — the mouse pointer becomes an I-beam cursor when you move it into the data area.

Position the I-beam at the horizontal position where you want to enter the first note. Use the time indicator in the Toolbar for precision. Once you’ve positioned the cursor properly, click on the mouse to activate the insertion point for step-time note entry. (If you don’t position and click the cursor, the entry point defaults to the left edge of the window.)

Now you can enter notes by pressing the corresponding keys on your MIDI keyboard. Each time you play a key, a new note bar will appear at the pitch and time you specified, and the I-beam cursor advances to the next insertion point. As you continue to insert notes, the Step Editor window scrolls appropriately.

**Rests and Corrections**

Pressing Return on the Mac keyboard inserts a rest corresponding to the currently selected note duration. If you make a mistake during the pitch entry process, press the Delete (Backspace) key on the Mac keyboard to delete the last entry and move the cursor back. You can delete as many notes as you want with the Delete key, but only within the current pass — if you reposition the cursor with the mouse, then the Delete key will have no effect on notes entered before you moved the cursor.

By the way, the Delete key *always* moves the cursor back to the selected duration, whether or not any notes have been recorded in that space. For example, if you want to start step-time entry a 32nd-note before a downbeat, select 32nd-note as the duration, place the cursor on a downbeat, then press Delete once before starting to play the notes.

**Step-Timing Chords**

You can step-time enter chords just as easily as notes. The program determines whether two notes are to be treated as a chord if the second note begins before
the first note ends, i.e., if you press down the second key before you release the first one. This means that you don’t have to play all the notes in a chord perfectly simultaneously: you can easily construct chords of any size by simply playing them very legato, and not releasing any note until the next note is played. It also means that you must be careful when entering single-note lines not to play too legato, or the program may interpret what you are playing as chords.

Changing durations

During the step-time entry process, you can switch to new note durations using the note icons on the Toolbar, the Mac numeric keys, and/or the tuplet box. You can also speed up the process by assigning duration values to specific MIDI keys, using the Keyboard Setup command on the Goodies menu — see Chapter 10 for details.

Overdubbing and changing tracks

You can reset the I-beam cursor and start step-time recording anywhere on a track, even if there are already notes in the track. Unlike normal recording, step-time recording will not erase existing notes. As mentioned earlier, if you record a step-time track on top of an existing track and make a mistake, the Delete key will only affect the notes entered in the most recent pass (i.e., since you last placed the cursor), not any previously-entered or recorded notes.

You can switch tracks in the middle of a step-time recording by changing the value in the Current Track box (click on it or press “T” to bring up the slider). If you switch tracks in the middle of a pass, than any Delete key operations will only work on the current track, not on the previous track.

Editing individual notes

To move an individual note somewhere else in the track, or to make a copy of a note at another location, start by clicking on the icon of the pencil in the Toolbar, or press the “P” key on the Mac keyboard. The cursor now becomes a crosshair. Place the crosshair directly over a note (anywhere in it), click, and hold. A dotted border will appear around the note bar, and while you continue
to hold the mouse button, drag this “ghost note” to a new pitch and/or time in the sequence.

The time indicator window in the Toolbar has up to now been showing the location of the cursor. When you click on a note and start to move it, however, it changes to show the starting position of the note, to help you place it accurately. When the note is correctly positioned, release the mouse button. The ghost will be returned to life as a solid note bar at the new location, and the old note bar at the previous location will vanish. The time indicator will once again follow the cursor.

**Moving in Place: Shift-Clicking**

There will be times you want to shift a note’s position in time but not change its pitch, or vice-versa. To make these operations easier, *Master Tracks Pro* provides a way, similar to that used in many Macintosh graphics programs, of locking in a note’s pitch or start time during a move operation.

To lock in the pitch or start time, hold down the Shift key and then click and hold on the note. Now, as you continue to hold down the mouse button, whichever way you first move — horizontally or vertically — becomes the only way you can move: the mouse locks in the note’s position on the other axis. As above, the time indicator will follow the note’s starting position while you are moving it. So if you first move the mouse horizontally, you’ve locked in the pitch, and you can’t move the note vertically, only horizontally (in time). On the other hand, if your first mouse movement is a vertical one, you will be able to change the pitch of the note but the start time will be locked.

**Copying a Note: Option-Clicking**

If you hold down the Option key while clicking a note, then the “ghost note” that appears is actually a copy of the original note, and when you move it to a new location, the original note does not disappear, but stays where it is (it may “blink out” for a moment. The new note has the same duration, velocity, and channel attributes of the original, but obviously will be different in terms of pitch and/or starting time.
You can use the Option and Shift keys together, making it easy to build chords from a single note. The time indicator will follow the new note’s starting time as you place it.

**Stretching or Shrinking a Note**

If you click on a note with the crosshair cursor anywhere in the right half of the note, you can change its duration. Holding the mouse button, move to the right to lengthen the note, or move to the left to shorten it. The time indicator will show the beginning of the note. You can stretch a note as far as the right edge of the window. If you want to stretch it more, either Zoom out (=–) or scroll the screen so that the end of the note falls in the middle of the screen (yes, you can stretch a note that starts previous to the left edge of the window). There is also a limit to how small you can make a note this way — about two pixels at the current magnification (no, you can’t shrink a note so much it disappears).

**Erasing a Note**

To erase an individual note, first click on the eraser icon in the Toolbar, or press the “E” key on the Mac. Now when you move the pointer down into the data area, it becomes a crosshair inside a circle. To erase a note, simply position this eraser cursor anywhere along the note and click. The note will disappear from the window. If you have trouble erasing a note, move the window (with the scroll bar) so that the note appears as close as possible to the left edge, and zoom in on it. You’ll find it easier to erase notes at higher magnifications. You can also erase notes by selecting a region and choosing Clear or pressing the Delete or Backspace key on the Macintosh keyboard — more on this in Chapter 6.

**Altering individual notes**

Besides working with note data on a graphic level, *Master Tracks Pro* lets you deal with MIDI events numerically, for the greatest possible accuracy. You can also deal with an alphanumeric list of all MIDI events on a track in the Event
List window, discussed in the next chapter, or you can deal with individual events using the Edit Note window feature.

To get to the numerical characteristics of a single note, first select the arrow pointer from the Toolbar, or press “A” on the Mac keyboard. Then move the arrow directly over the note you want to edit, and double-click.

The Edit Note window will pop up in the vicinity of the note, although it won’t obscure the note. To help you remember which note you’re working on, the note becomes gray-highlighted.

The Edit Note window shows the start time (in measures, beats, and clocks), the note name and octave number, the On and Off velocities, the duration (also in measures, beats, and clocks), and the MIDI channel. Note that the duration is displayed in units relative to the time signature of the measure that the note begins in — i.e., if the note starts in a 3/4 measure and is four beats long, it will be displayed as “01:01:000” (one measure plus one beat), even if the measure it ends in happens to be a 4/4 bar.

To change one of the values in the window, select it by clicking on it. It will become highlighted. Use the arrow controls at the right of the window, or the arrow keys on the Mac keyboard, to change the value incrementally (holding the arrow or key down will make the value change rapidly), or else type in a new value from the Mac keyboard. (For pitch names, type the letter, then the “#” sign [Shift-3] if you need an accidental, then the octave number.) Master Tracks Pro won’t let you enter any invalid settings for these parameters, and will beep at you if you try.
You can also move among the various fields in the Edit Note window by pressing the Tab key.

Additionally, the Pitch value can be set by selecting the Pitch field, and then pressing the appropriate key on your MIDI keyboard.

Once all the parameters in the Edit Note window are to your liking, click on OK or press Return to finalize them and close the window. You can click on Cancel instead to return to the Step Editor window without making any changes.

Note Re-Mapping

You can isolate notes of a specific pitch in a track and transpose them to another pitch, in one operation. This is known as “Note Re-Mapping”. It is useful when you want to change the mode of a track (to go from C major to C dorian for example, you might change all the Es to Ebs and the Bs to Bbs), or even more commonly, when you have created a track using one drum machine, and want to play it on another on which the drum/note assignments are different.

To use this feature, first select the arrow cursor (or type “A”), and then move it to the left side of the window where the picture of the piano keyboard appears. Move the mouse so it is on the pitch that you want to change, and press the button. You will hear that pitch sound over the current MIDI channel, and all of the notes on that pitch will be selected.

Continue holding the button and drag up or down to the pitch that you want the notes transposed to. As you pass over each “key” on the keyboard, you will hear it sound over MIDI. When you arrive at the pitch you want, let go of the mouse button.

You can use this feature to copy selected notes as well: hold down the Option key as you select and drag the notes. The original notes will remain where they were, and new notes will appear at the destination pitch. This can be very useful for doubling individual drum sounds (putting a bass drum hit under every crash cymbal, for example), or for building chords out of individual notes.
3.16 Re-Mapping a Note

Note that this re-mapping transposes every note at the selected pitch on the entire track, from beginning to end, not just the ones showing in the window. If you need to transpose notes in only part of a track, use the Transpose function and the Change Filter (Chapter 7).
As we have seen, essentially only MIDI note data is edited in Master Tracks Pro’s Step Editor window. But Master Tracks Pro can edit all other types of MIDI data as well, and different graphic windows are provided for them. In addition, an “Event List” window shows all of the MIDI data on a track together, so that it can be compared and edited.

Non-note MIDI data can be recorded from a keyboard, just like notes, as part of a track. (In the Step-Time Entry mode, however, only note data is recorded.) It can also be entered into a track by hand, as in the Step Edit window, or by the Paste and Mix Data commands.

The Data Windows

Like the Track Editor and Step Editor windows, the MIDI Data windows are opened from the Windows menu, or by Macintosh Command-key combinations. The windows and their key combinations are as follows:

- Pitch Bend .................................................................≈ -4
- Channel pressure (aftertouch) ................................≈ -5
- Key pressure (polyphonic aftertouch) .................≈ -6
- Modulation (controller #1) .................................≈ -7
- Continuous controllers .................................≈ -8
- Velocity .................................................................≈ -9
- Tempo Map .............................................................≈ -0
- The Event List .........................................................≈ -2
- The Big Counter ......................................................≈ -B
If a window is open but hidden behind other windows on the screen, you can bring it to the foreground by choosing it on the Windows menu or with its Mac key combination. If a window is open, its name will appear on the Windows menu with a check mark. If it is the active window, its name appears in outline. Only one of the seven MIDI Data windows can be open at a time. If one is open and you open another, the new one will take the place of the old, assuming its position and size.

Common Features

The first six MIDI Data windows look and work essentially alike, and have many characteristics in common with the Step Editor window as well. We will look at the common operations of all the windows first, and then examine the specific characteristics of each window. (The Tempo Map window will be discussed in Chapter 11.)

Most of each window is devoted to a data area, where individual MIDI events on a track appear as vertical lines or as points. The height of each line or point corresponds to the numeric value of the event, while the horizontal location of the line or point specifies when in the track the event occurs.

Display Modes

Sometimes you will prefer to view MIDI events in a window as vertical lines — called “skyline” mode. Other times, you will prefer to see them as points — actually tiny crosses. You toggle between these modes by pressing any character key on the Mac keyboard (but not Tab, Shift, Return, space bar, etc.) when a MIDI data window is active. The mode setting will be the same for any MIDI window that is opened subsequently, until you change it by again pressing a Macintosh key.

4.1 Data Display Modes, Skyline (L) and Points (R)
“Ghost” Notes

A transparent view of the Step editor can be placed on any of the graphic edit windows, creating a “layered” view of notes and any controller window. Called “Ghost Notes” in a view window, this shows a grayed out copy of notes behind view data.

4.2 Ghost Notes in the Velocity Window

To turn on this display, click the box in the upper left corner of view window. The vertical position of the notes is the same as in the Step Editor window if it is open; if not, an arbitrary range is selected.

Icons and Information

At the top of each window, just below the window title bar, you’ll see a single row of icons and data called the Toolbar. The three icons in the left portion of the Toolbar are the same as their counterparts in the Step Editor window: an arrow for selecting data, a pencil for entering it, and an eraser for erasing it.

4.3 A Data Window Toolbar
To the right of the icons, there’s a time indicator that displays the pointer’s position in the track, in measures, beats, and clocks. Next is a “value” indicator, which gives the data value corresponding to the pointer’s current vertical position in the data area. Finally come boxes showing the number of the track currently on display, which MIDI channel will be assigned for new event insertions (again, this is only relevant if the track has no channel assignment in the Track Editor window), and the name of the current track. Click in any of these boxes to change its value — the track number and MIDI channel boxes are adjusted with pop-up sliders, while opening the track name box will give you a text dialog box. A name given to a track in this window will appear in all other windows as well.

Markers, Measures, Scroll Bars, and Zoom

Just below the Toolbar is the marker ruler. As in the Step Editor window, you can add, delete, or move markers at any point in the track, and move to them using Tab and Shift-Tab. You can hide the marker ruler with the Hide Marker command on the Layout menu if you like, which will slightly expand the data window. Markers remain active even if the ruler is hidden.

Below the marker ruler is the measure ruler, which marks the position of measures (numbers) and beats (vertical lines) in the track.

Use the scroll bar controls to move the MIDI Data window displays just as you would with the Track Editor or Step Editor. The measure ruler can help you keep track of where you are in the sequence as you scroll.

Playback position can be set by clicking at the desired location in any MIDI Data window (as long as the Auto function is turned off), the same way as in the Track and Step Editor windows.

You can use the Zoom In and Zoom Out commands on the Layout menu to get a close-up view of a small amount of data for precise work, or to see more of the MIDI data on screen at a time. To move in one zoom level, choose the Zoom In command on the Layout menu, or type ≈ – [ on the Mac keyboard.
To zoom out one level, choose Zoom Out, or type ≈–]. As in the Step Editor window, the Zoom level ranges between 1 and 24 clocks per pixel.

**Selecting MIDI data for Editing**

As in the Step Editor window, you use the various mouse pointers to make different kinds of changes on events in the various MIDI Data windows.

To use the commands in the Edit or Change menus on MIDI Data window data, you must first select a region within the track. As in the Step Editor, this is done with the arrow pointer, but your choices here are much simpler. First select the arrow pointer by clicking on its icon in the Toolbar. Then move the pointer within the data area to the left edge of the region you want to select, using the time indicator in the Toolbar to help you locate the desired point in the sequence precisely. Click the mouse and drag to the right. As you move the mouse, the region will be highlighted in inverse video.

When you reach the right edge of the region, release the mouse button. You can now perform Edit and Change menu operations on the selected region. Shift-clicking and “hot scrolling” are supported in the MIDI data windows, and you can select a region by moving either left-to-right or right-to-left. Note that there are no “vertical boundaries” to the selected area. Also, a selected region must be contiguous. You can select a whole measure by clicking in the measure ruler; drag the pointer left or right to select more whole measures.
Note: When you make an edit in one of the MIDI Data windows, only the type of data shown in that window is affected. For example, if you Cut two measures’ worth of pitch bend from a track, only the pitch bend data is cut — any notes or other controllers remain intact.

You cannot move data from one type of window to another: you cannot Copy a measure of pitch bend and Paste it into a channel-pressure window. (Which is not to say you cannot change a neat pitch bend move into a similar move on another kind of controller. To do that sort of thing, a “mapping” function is provided in the Continuous command on the Change menu — see Chapter 7.) You can, however, move MIDI data from one track to another.

Entering MIDI data

To insert individual MIDI events or modify existing ones, first select the pencil icon in the Toolbar. The pointer will then become a crosshair. (Use the Channel box in the Toolbar at the top of the window to select the MIDI channel for the new event if the track you are working on has no channel assignment in the Track Editor window.)

Now move the crosshair to the position in the data area where you want the data event to go. Use the time indicator in the Toolbar to locate the exact time in the track where you want to insert the event along the horizontal axis of the graph. Use the value indicator to position the pointer vertically for the correct value. Click the mouse. If you are in skyline mode, a vertical line will appear, extending from the bottom of the window (or 0 level) to the height representing the data value. If you are in cross mode, a single cross will appear at the point where you clicked.

You can insert multiple consecutive events simply by holding down the mouse button and dragging the pointer to draw a curve on the data area. This makes it easy to add smooth pitch bend or modulation wheel changes. You can draw a data curve in either the forwards or backwards direction. If you double back and draw over your curve, the last value entered will take precedence.

In skyline mode, when you insert consecutive events, the graph will appear to be filled in with solid black under the curve you draw. Nevertheless, each event along the curve can still be edited individually.
Data inserted with the pencil in a MIDI Data window can be “Undone”. Choosing “Undo” from the Edit menu will cancel the last data insertion, whether it was an individual event or a sweep.

**Changing and Erasing Data**

To change an event that is already part of a track, just insert a new event at the same time. When you do, the old event will be erased.

To erase events completely, click on the eraser icon in the Toolbar. The pointer will become a crosshair within a circle. Move the pointer directly over the event you wish to erase and click. The event line or cross will disappear. You can also drag the eraser over a series of events with the mouse button down and “wipe” them all out.

*The eraser does not have to be over the actual event to erase it* — putting the eraser pointer at any point on the screen and clicking the mouse will erase any event that occurs *at the time indicated by the pointer’s horizontal position*. Therefore, to “wipe” out a block of data, you do not have to trace over every individual event with the eraser — merely set it at a point corresponding to the beginning of the area you want to erase, hold the mouse button, and sweep it to the end of the area you want to erase. All events during the time period you’ve swept over will be erased. (You can also delete selected data with the Clear command or the Delete key — see Chapter 6.)

**Data density and the Zoom Factor**

The Zoom level you use in a MIDI Data window not only determines the screen resolution, it also determines the *density* of the data as it is being entered. If you enter data on a screen with 24 clock per pixel resolution, then you can enter only ten events per quarter note. If you enter data in the one clock per pixel view, 240 events can be entered during each quarter note.

High-resolution MIDI events (particularly controllers) tend to sound more natural, but they can use up much of the MIDI stream’s available bandwidth, causing delays or “choking” if the data gets too thick. Determining the correct resolution for a particular musical purpose sometimes requires a little experi-
mentation, but finding a good compromise is usually not difficult. The Thin Data item in the Change menu facilitates this (see Chapter 7).

Note that changing the resolution of the screen will not affect data that has already been placed in the track. Data placed in a zoomed in, high-resolution view (for example, 2 clocks per pixel) can be edited in a lower-resolution track (for example, 12 clocks per pixel). If such editing is done with an Edit or Change menu function, the resolution of the data will not change. However, if it is done with the pencil or eraser, the new data will only have the resolution of the current window.

The Pitch Bend Window

Pitch bend data can take either positive or negative values. A pitch bend value of 0 indicates no bend. Therefore, the Pitch Bend window has a horizontal dotted line running through the middle of the data area marking the zero point. The area above the line, which represents positive pitch bend values, is marked with a “+” in the left border. The area for negative values below the line is marked with a “−”. Values range from +127 to −128.

Shortcut Key: ≈ -4
The Channel Pressure Window

Channel Pressure, also known as aftertouch, affects all notes on a given MIDI channel. It has a range of 0 to 127.

Shortcut Key: ≈-5

![The Channel Pressure Window](image)

The Key Pressure Window

Key Pressure, also known as polyphonic aftertouch, affects individual MIDI notes. This window has an extra parameter on the second row of the Toolbar, "MIDI Pitch", which lets you specify which note to assign the key pressure event to. You can change the note simply by playing it on your MIDI keyboard (you don’t have to click anywhere), or you can click on the box to bring up a pop-up slider. You can adjust this by moving the slider itself, or by typing in the note name and number above the slider (accidentals can only be entered as sharps). If you change the MIDI Pitch, the data entered with any previous pitch setting will turn gray, while data entered with the current pitch setting will be in black.

![The Key Pressure Window](image)
Key Pressure has a range of 0 to 127.

Shortcut Key: ≈-6

**The Modulation Window**

Modulation refers to the “Mod” wheel (or lever) found next to the Pitch Bend wheel on many synthesizers. Modulation is actually MIDI Controller #1 and you can also edit or create Modulation data in the Controllers window. Modulation has a range of 0 to 127.

Shortcut Key: ≈-7

**The Controllers Window**

The Controllers window has an extra parameter, “Ctrl Number”, in the Toolbar that lets you specify the number of the MIDI controller you want to edit. Controller #1 is usually modulation wheel, #7 is usually volume, #64 is sustain pedal, and so on. You can work on the data for each controller individually — when you change the Ctrl Number setting (it uses a pop-up slider), only the data pertaining to that controller is displayed. Any editing you do, whether with the pencil and eraser or with the Edit and Change menus, will affect only the controller that is currently displayed.

Consult the owner’s manuals of your MIDI devices to see which controllers they support. A list of standard MIDI controller numbers appears at the end of this manual.

Shortcut Key: ≈-8
The Velocity Window

This window allows you to see and edit velocity as vertical lines for each note. The Pencil can be used to draw velocity “curves” on a track.

Shortcut Key: ≈-9

The Tempo Map Window

The Tempo Map window shows beat value, time signature and tempo. The tempo is represented by a horizontal line moving through the measures. Tempo changes can be inserted on any clock with the pencil pointer and erased with the eraser. Tempo is always indicated on every bar line — these cannot be erased with the eraser but they can be changed with the pencil.

Cut, Copy and Paste do not work in the Tempo Map window. If you wish to copy and paste the tempo map, you must do so in the Track Editor window. Select the measures you wish to copy using the measure ruler at the top of the Track Editor window by
dragging or Shift-clicking, and then paste them elsewhere (do not use Mix Data). After pasting, you can then strip out the data (notes, etc.) if you like, leaving only the tempo map. More on this topic can be found in Chapter 11.

Shortcut Key: ≈-0

The Event List Editor

The Event List Editor window shows an alphanumeric display of all of the data, MIDI event by MIDI event, on a single track. You can change the display so that it shows only certain types of data, and you can move forwards and backwards along the track in two different ways. You can edit any information that appears on the list, delete events, and add new events.

Shortcut Key: ≈-2

Clicking on the word “Measure” toggles the displayed time between SMPTE and measure/beat/clock. The Event List Editor can be a powerful “cue sheet” when using SMPTE as the display mode. “Hits” can be entered by simply typing in the SMPTE location and playing/typing the data.

Ignoring the window’s Toolbar for a moment, let’s look at the data list itself. Each MIDI event appears on its own horizontal line. The first column shows an icon denoting the type of event. The icons are, in the order they appear in the Toolbar: note, program change, pitch bend, controller, channel pressure, and key pressure. (Note that there is no icon for modulation — it’s displayed as controller #1.)

The second column shows the time at which the event occurs. The third column shows the channel number of the event (only relevant if the track is to be played back without a MIDI channel assigned in the Track Editor).

The columns that follow show the data associated with each event. Program
change, channel pressure, or pitch bend events will have a single data entry. Controller events will have two data entries: the first is the controller’s number, and the second the controller’s value. Key pressure events will also have two entries: the note number, and the pressure value.

Note events have four entries. Each note is actually two MIDI events, a note-on and a note-off. The entries are: the note name; note-on velocity, prefixed with an exclamation point (!); note-off velocity, prefixed with an upside-down exclamation point (¡); and duration, in measures, beats, and clocks.

Changing events

The way to change any data entry value on the list is to click on it once. The field will highlight, and you can type in the new value. If the value you want to change is a MIDI note or Program Change, you can also enter it by playing the MIDI note or sending the program change from your MIDI keyboard.

Press Return to enter the new value, or press Tab to move on to the next field in the same line. If you change the time of an event, the list will automatically re-order itself so that the event is in the proper place. Note that you cannot change the type of entry this way — to change a type of event, you must delete the current event and insert a new one.

Scrolling the List

You can move up and down the Edit List using the scroll bar at the right side of the window. You can also move to a specific spot in the sequence by clicking on the “Goto...” box in the Toolbar, and then typing in the measure, beat, and clock of the desired location.
Selecting a region

Just like in the other editing windows, you can select a region in the Event List Editor for an Edit or Change operation. To set an event as one boundary of a region, click in the *icon* for that event (not in any of its data fields). You can hold the mouse and drag up or down until you come to the other boundary, and then let go. (Like the other windows, this window will “hot-scroll” when you get to the top or bottom and there is more data beyond.) The region will be selected.

You can also click once at one boundary event, and then move or scroll and move to the other boundary event, and Shift-click.

Once you select a region, you can perform any operation on it from the Edit or Change menus. When you do a Paste or a Mix Data, you will get a dialog box asking you where (measure, beat, clock) to start the Paste or Mix operation. The box will appear with default values corresponding to the beginning of the last region you selected.

Inserting events

Inserting an event on the list is very simple. In the Toolbar, click the type of event you wish to insert. The measure field of the new event will be highlighted; type any new data you wish into it and any other fields you might want to change.

Removing Events

You can remove events from the Event List. Simply click on the event icon in the "Event" column, and press the Delete Key or choose Clear from the Edit menu.

There is one restriction on this operation - If two events on a track occur at precisely the same time, you will not be able to select them separately. In order to separate them you must change the time for one of them. The simplest way to do this is to click on the "clocks" column and change the value by one.
Filtering events

The “Filter” function on the Toolbar lets you eliminate certain types of data from the list so that you can see others more clearly, and also lets you select what kind of data to perform editing operations on. It does not erase the data, it temporarily removes it from view. If you have controller data on a track, for example, and only want to look at or work on notes, you can hide the controller data. If you just want to see program changes to make sure they’re correct, you can hide the notes. If there is something strange going on in a track, and you don’t know what it is, just look at one data type at a time until you find it.

Clicking and holding the mouse on “Filter” opens a small box which lets you check off which items you want to see. A check mark next to an item means all data of that type will appear on the Event List. No check mark means that type of data will be hidden. If a data type is hidden, it will not be affected by a Cut or Copy operation in this window.

Changing and naming tracks

As in the Step Editor and all the MIDI Data windows, you can only view one track at a time in the Event List Editor. You can change which track you’re looking at by clicking in the box on the Toolbar which contains the letter “T” and a number, and then using the pop-up slider that appears. You can also name or rename the track you are looking at by clicking in the box to the right of the track number, and typing the new name into the dialog box that appears. This new name will now appear in the Track Editor and all other windows.

The Big Counter Window

This window shows an enlarged display of the measure/beat/clock indicator. This enables you to see the current time when you’re not close to your computer.

Shortcut Key: ≈-B
4.16 The Big Counter Window
The File menu has a variety of commands that let you manage your sequence files. Many of these commands work just as they do in most other Macintosh applications, so if you’ve had any previous experience with the Mac you’ll already be familiar with how to use them.

The File menu also includes the “Save Preferences” command, which allows you to set up the program the way you like, and store that setup on your Master Tracks Pro working disk or hard disk.

*Master Tracks Pro* reads and writes two different types of sequence files: files created by *Master Tracks Pro* itself, and MIDI files. *Master Tracks Pro* files can also be opened by *Encore*, Passport’s professional notation software. MIDI Files are an industry standard format for storing MIDI sequences. If you own any programs that support this format, you will be able to share sequence files with these programs. We will discuss dealing with MIDI Files later in this chapter.
About Master Tracks Pro Files

A Master Tracks Pro file is a single sequence, either in its temporary form in your Macintosh’s memory, or stored more permanently on a disk. A file is open when you’re working with it in your Mac’s active memory, whether you loaded it from disk or started it as a new sequence from scratch. When you close a file, it is removed from memory, and you can only work on it again by reloading it (opening it) from the disk.

You can have up to 16 files open at a time, although only one file will be “active” at a time. (You cannot open the same file twice, but if you need to have two versions of a file open at the same time, you can make a duplicate of the file in the Finder before you open it, or save the original version under a different name using Save As, and then open that.) The name of the active file appears at the top of the Transport window. The names of all open files appear on the Songs menu, and you can choose which file you want to be active from that menu. You can also play multiple open files one after the other using the Playlist feature on the Songs menu. See Chapter 9 for more details.

Be sure to save your sequence files frequently while you work with them, so that you don’t lose your work because of a power failure, glitch in the fabric of the universe, or other problems with your system. You can store files on any disk or drive in your system, as long as there is enough space, using options in the Save and Save As commands.

Note: While you can load any file from a previous version into Master Tracks Pro, you may not be able to open a file created by the current version in a previous version.

Starting a new file

To create a brand new sequence, choose the New command from the File menu or press ≈-N on the Mac keyboard. When the new file is opened, any windows you had open remain on the screen in the same position, but all the existing data disappears. Master Tracks Pro calls the new file “Untitled” followed by a number, until you rename it with a name of your own choice using
Using the File Menu

the Save As command. (The program will let you save a file with the name “Untitled [number]”, but it is not good practice to do that.) Every time you open a new file it is given a unique number so that no two open files have the same name. If you already have 16 open files, the New command will be disabled.

Opening an Existing File

Choose the Open command or press ≈-O on the Mac keyboard when you want to load an existing file into Master Tracks Pro for playback or further editing.

As with all Macintosh programs, a dialog box will pop up showing the name of the disk in the currently selected drive at the upper right, and the names of all the Master Tracks Pro files stored on that disk in a scrollable box at the left. If the list of files is too long to fit into this box, you can use the scroll bar at the right side to scroll through the list to the file you want. You may also type the first letter of the file name to bring you to files starting with that letter, or the first few letters to bring you to your file.

If the file you want is on a disk in another drive, click on Drive to select another drive. If you want a file on a disk that’s not currently in any drive, click on Eject, wait for the drive to eject the disk, and insert the disk you want.

Once you’ve located the file you want to open, click over any portion of the name. The name will now be highlighted, indicating that it is selected. If you make a mistake, you can select a new file name just by clicking on it. When you’ve selected the correct file, click on Open or double-click on its name. The dialog box will disappear, and Master Tracks Pro will load the file, and make it the active file.

You can also open a file directly from the Finder by double-clicking on it. If Master Tracks Pro is on the same disk or on another disk that has been inserted into a drive, the program will automatically load, and the file will be open and active. You can load multiple files from the Finder by clicking on one, then Shift-clicking on all the others, and then double-clicking on one of them (or
typing ≈-O). The files will be opened in the order you selected them, with the last one being the active one. (This technique also works in MultiFinder with the program already running.)

After the file is opened, the same set of windows you were using before you opened the file will still be on the screen, but the data in the windows will now be from the newly opened file.

### Closing files

Use the Close command to end work on a particular file without leaving the program or closing any other files. When you choose the Close command, you’ll be given an opportunity to save the current file if you’ve made any changes since it was last saved.

If there are other files open, the file that was most recently active before the file you are closing will again become active. All the windows you’ve been using will remain on the screen, but they will show data for the newly-active file. If no other file was open, the windows will be empty and the title bar on the Transport window will say “Untitled [number]”.

If you want to close all of the open files at once, press and hold down the Option key, then open the File menu. The Close command now says “Close all”. Choose it and all of the files will close, and if any of them have been changed since the last time they were opened, you will get the opportunity to save the new versions.

Note that clicking in the close box of the Track Editor window does not close a file — it merely closes that window. Don’t be confused.

### Saving files

The Save command stores the sequence that is currently active onto the disk. As soon as you choose the Save command or press ≈-S on the Mac keyboard, Master Tracks Pro will save the current version of the sequence to the same disk
Using the File Menu

file that it came from, without any further action on your part, overwriting the existing file of the same name.

If the file has not been saved before when you execute the Save command, it will actually behave like a Save As Command.

Using the Save As Command

The Save As command lets you save a new file for the first time, or save a file that has previously been saved, with a new name or in a different folder or disk. This command is especially useful when you want to store different versions of a file as you work on it, so that you have the option of coming back to earlier versions later on.

When you choose the Save As command, a dialog box appears, which allows you to choose a name for the file before you save it. If you’re saving a previously saved file, the current name of the file appears in the file name field. If the sequence has never been saved before, the file name field will be blank.

You enter a new name by typing it in. If a name already exists, and you leave the file name field highlighted, the old name will disappear as soon as you start to type in the new name. You can change the folder on a disk where you want to put the file in the usual way, by clicking on the name of the folder or disk at the top of the dialog box, dragging down to a higher-level folder or the disk level, and then opening the desired folder from the list that appears. You can change the disk and the drive where you want to put the file by clicking on the Drive and/or Eject buttons.

If you decide you don’t want to save the file after all, you can click on Cancel at any time. To go ahead and save the file with its new name, click on Save or press Return. After a few moments, you’ll be returned to the main Master Tracks Pro screen.

Using the Revert to Saved Command

Choosing the Revert to Saved command restores the currently active file to the way it was when you last saved it. (If the file has never been saved, this com-
mand is disabled.) Use this command when you’ve made changes in a sequence that you know you don’t want to keep.

When you choose the Revert to Saved command, *Master Tracks Pro* pops up a dialog box asking you if you’re sure that you want to discard the changes you’ve made since the last time you saved the file. If you want to go ahead with the command, click on Yes, and the last saved version of the file will be loaded from disk, replacing the data that was in memory. To cancel the command, click on Cancel.

**Using MIDI Files**

MIDI Files are an industry standard format that has been adopted by many software manufacturers. They allow you to exchange sequencer files between various programs, including *Master Tracks Pro*. You can create files on *Master Tracks Pro* and play them with other programs, such as other sequencers or notation programs, and vice-versa.

MIDI Files are typically about 35% smaller than *Master Tracks Pro* files with the same amount of musical information, and thus take less room on your disk and less time to transmit by modem.

You can save the active sequence as a MIDI File by choosing Export MIDI File from the File menu. This will bring up a dialog box asking you to name your file. You cannot save a MIDI File with the same name as a *Master Tracks Pro* sequence file, so the dialog box defaults with the name of the current sequence and the prefix “M-” attached — for example, “M-Big Intro”.

You can open a MIDI File by choosing “Import MIDI File” from the File menu. A dialog box will appear showing all of the available MIDI Files, and you can double-click on one to open it. The MIDI File will open exactly as if it was a sequence file (with any options as shown below). The MIDI File’s name will appear in the Songs menu. If you have 16 files (*Master Tracks Pro* or MIDI Files) already open, you won’t be able to open a new MIDI File. Also, you can’t open the same MIDI File twice. You can work with the MIDI File just as if it was another sequence.
When a MIDI File is the active sequence, the Save command on the File menu is disabled. If you want to save it as a *Master Tracks Pro* file, you must use “Save As...”. (You cannot save it as a *Master Tracks Pro* file under the same name it has as a MIDI File.) If you want to save it as a MIDI File, choose “Export MIDI File.” You can Export a MIDI File with the same name that you Imported it with — the exported version will erase the earlier version. The Exported version can be a different Type than the Imported version.

If you would like to do some experimenting with MIDI Files, a MIDI File version of the Bach Invention we played with in Chapter 3 is on the *Master Tracks Pro* program disk, in the “Songs” folder.

MIDI File Options

Selecting MIDI File Options opens a dialog box giving you the choice of saving (Exporting) the sequence as a Type 0 or Type 1 MIDI File as well as Importing options.

A Type 1 MIDI File saves the sequence in multiple tracks. Each track has multi-channel capability, just like *Master Tracks Pro*. In a Type 1 MIDI File, tracks do not have channel assignments *per se*, but just as with the Type 0 MIDI File, notes are given channel assignments based on their track’s channel assignments or (with unassigned tracks) their original channel assignments. In Type 1 MIDI Files, track labels are preserved. This format is easier to use with multitrack files, since you don’t have to separate the tracks out after a transfer, the way you do with Type 0 files (use the Strip Data command in the Change menu for this — see Chapter 7), but fewer programs recognize it.

A Type 0 MIDI File puts all of the sequence data on a single track. Channel assignments are preserved on a note-by-note basis. If a sequence track has a channel assignment in the Track Editor window, then all notes on that track are saved assigned to that channel. If the track is unassigned to a MIDI channel

---

5.2 The MIDI File Options Dialog
(“—”), the notes are saved with their original channel identities. Type 0 MIDI Files are the most commonly used at the present time, and you will find it easier to exchange data with the largest number of other programs if you use this type.

You can also choose to export the Master Tracks Pro Conductor (Tempo) track as a tempo and meter track template.

The first Import option lets you choose to import the standard MIDI file format of "Lyrics" as Master Tracks Pro markers.

The second import option is useful for situations where you want to paste several files together and wish to use or ignore the first (initial) program and/or volume change.

Customizing the Program—the Preferences Command

Once you’ve been working with Master Tracks Pro a while, you will find that there are arrangements of windows and settings of various program parameters that you find particularly useful. These settings can be saved as a “Preferences” file.

When you choose Save Preferences, your settings are saved in a file in your System folder. Under System 7, the preferences file is stored in the Prefs folder inside your System folder.

Now, the next time you start Master Tracks Pro, the program will read the Preferences file as it loads, and will come up on the screen with the windows you want open at the positions and sizes you chose. In addition, the settings of the functions in the menus and windows just described will be as specified in the Preferences file.

Preferences Saved

When you choose Preferences from the File menu, the program takes a “snapshot” of the current positions and sizes of any open windows on the screen and also records the following data elements:
• In the Edit menu — the Change Filter settings and the MIDI File Options

• In the Change menu — the Transpose Map settings

• In the Layout menu — Show/Hide Grid, Show/Hide Markers, Follow Playback, Multi-Track Record, and Zoom resolution

• In the Goodies menu — Keyboard Setup, MIDI Setup, Click Setup, Chase Controllers, and Record Filter parameters

• In the Device List — the default device

• In the Master Fader window — the current mode (Live/Absolute/Record)

• In the Transport window — Auto, Thru, Metronome, Count In, and Sync setting.

• In the Track Editor window — the measure ruler numbering scheme (every third bar is numbered, or every fourth bar, etc.)

• In the Step Editor window — The All Data/Notes only setting

• In the Event window — The measure/SMPTE setting

• In any View window — The Ghost Notes on/off setting

---

**Quitting the Program**

Choose the Quit command or press ≈-Q on the Mac keyboard when you want to end a *Master Tracks Pro* session. If any of the open files have been altered since the last time you saved them, the program will give you a chance to save the new versions.

If you wish not to avail yourself of this opportunity — in other words, if you just want to shut everything down without saving — then when the first “Do You Wish to Save Changes…” dialog box appears, hold down the Option key as you click on “No”.

---

Using the File Menu 85
Master Tracks Pro’s Edit menu contains commands that are used within the Track Editor, Step Editor, or MIDI Data windows to edit MIDI data in selected measures or regions.

Selecting a region

To use any of these commands on a specific region, the region must first be selected using the mouse as described in the previous chapters on the Track Editor, Step Editor, MIDI data, and Event List Editor windows. When you select a region, it becomes highlighted.

Select All

If you want to use an Edit command on an entire sequence or track, you can skip the above step by using the Edit menu’s special command, Select All (or its command-key equivalent, ≈-A). If you choose this command when the Track Editor window is active, it selects the entire sequence. If you use it when the Step Editor, Event List Editor, or any MIDI Data windows are active, it selects the entire track (as displayed in the Current Track box in the window’s Toolbar). In the Step Editor, if the “mode” is showing “all”, then all of the data...
in the track is selected. If it is showing the two notes, only note data is selected. In the Event List Editor, only visible (non-“filtered”) events are selected. When you use the Select All command, the window’s entire data area (the sequence or track) becomes highlighted.

**Edit Menu Basics**

The Edit menu capabilities start with basic Cut, Copy, Paste, and Undo editing commands, much like those you’ll find in many other Macintosh programs. With Cut, Copy, and Paste, and a couple of supplemental commands, you can transfer data from any location in a sequence to any other location, or even to another sequence entirely.

Some of the Edit commands work slightly differently depending on which window you’re working with. Those differences are described with each of the commands.

**About the Clipboard**

The Clipboard is the temporary storage location for MIDI data that *Master Tracks Pro* uses when you move or copy data within a sequence, or from one sequence to another. For faster performance, the *Master Tracks Pro* Clipboard is stored in RAM, the computer’s internal memory, and not on disk like some Macintosh Clipboard files. The effect of this is to speed up editing considerably. But there is a trade-off. The problem with this approach is that the data in the Clipboard will be lost if you quit the program, or if you lose power or the computer fails for some other reason. If you want to save its contents, you must paste it into a sequence and save the sequence using the File menu commands.

**Undo**

At the top of the Edit menu is the Undo command, which can also be executed by pressing ≈-Z on the Mac keyboard. This command allows you to cancel the last operation you made on your sequence with any of the commands on the
Using the Edit Menu

Edit or Change menus, or to cancel the last Record or Punch pass. The Undo command on the menu will change to reflect what it is you can Undo — if the last alteration you made was a Paste, the menu command will read “Undo Paste”, and so on.

Undo also works when you are drawing data into any of the MIDI data windows (although not the Step Editor window). When you draw anything into a data window, the menu item changes to “Undo Insert Data”. If you choose it, the last insertion you made by clicking and releasing the mouse (which could be a single event or a sweep) will be cancelled.

If you change your mind about an Undo and want to “Un-Undo” it, the program lets you “Redo” an alteration. If you want to compare the way something sounds before and after an operation, you can toggle back and forth between Undo and Redo to your heart’s content.

As in most Mac programs, Undo only applies to the last change you made in the sequence. As soon as you use another Edit or Change command, or start recording a new track, or draw in new data, the previous change becomes permanent and can no longer be removed with Undo.

**Cut**

Use the Cut command to remove MIDI data from the region you’ve selected, and place it in the Master Tracks Pro Clipboard. You can execute the Cut command by choosing it from the Edit menu, or by pressing ≈—X on the Mac keyboard.

**Cutting in Step Editor**

In the Step Editor window, if the mode icon is showing two notes, only notes are removed — any controllers, program changes, or other data is left intact. If the icon says “All”, then all data for that region is Cut. In the MIDI Data windows, the Cut command removes only the data showing in that window on the track indicated in the Current Track box.
Cutting in the MIDI Data Windows

In the Controllers window, Cut will work only on data belonging to the controller number showing in the menu bar. In the Key Pressure window, Cut will work only on data belonging to the MIDI Pitch showing in the menu bar. In the Event List Editor, Cut will work only on visible data.

Cutting in Track Editor

In the Track Editor window, the Cut command removes all types of data in the selected measures and tracks. Sometimes the measures that are cut are removed from a track, and sometimes they are left intact, but empty (shown as hollow rectangles). What happens to the measures depends on how they’ve been selected:

• If you’ve selected an entire track (or more than one track) in the Track Editor window by clicking on the track number at the left edge of the right half of the window, the Cut command removes the track entirely.

• If you only select a few measures within a track (or tracks), the Cut command removes the data from those measures, but leaves the measures themselves intact. However, if you select all of the measures in a track from a point in the middle to the end of the track, the Cut command removes those measures completely, shortening the track.

Shortening a track by cutting measures off the end is the technique to use for changing the length of a track for looping purposes. The Loop function always goes to the end of each track, whether or not there is data in all of the measures.

By making sure that no empty measures appear at the end of a track, you can have the track loop as soon as the actual data on the track is finished playing (at the next measure boundary, that is).
• If you use the measure ruler at the top of the Track Editor window to select one or more measures across all the tracks in the sequence, the Cut command removes the measures completely, and the remainder of the sequence gets shifted to the left to fill in the gap. (This function is essentially duplicated by the Delete Measures command, described later.) This will also be the case if you select the measures within the data window and scroll down so that all 64 tracks are selected. (Since the measures are removed completely, the Tempo Map associated with those measures is also removed.)

Note: If you use this command to change the Tempo Map over a region that contains locked markers, you will get a message asking you how to handle the markers. See Chapter 11 for a discussion of this.

• If you select the measures within the data window and don’t select all 64 tracks, then the Cut command will remove data from the selected measures and tracks, but will leave those measures intact. (It will also leave the Tempo Map intact.)

• If you’ve selected the entire sequence in the Track Editor window using the Select All command or with the mouse, Cut removes all data, leaving a blank sequence with no Tempo Map.

Copy

The Copy command makes a copy of the data in the selected region and puts it on the Master Tracks Pro Clipboard. The existing data is not changed. In addition to selecting the Copy command with the mouse, you can also execute it by pressing ≡-C on the Mac keyboard.

The types of data and selection criteria for the Copy command are the same as they are for the Cut command. The Copy command, of course, cannot remove measures, but if an entire measure or group of measures is selected in the Track
Editor window across all 64 tracks and copied, the Tempo Map associated with that measure or group is put on the Clipboard along with the MIDI data.

Note that when you select a region and Copy it, the region stays selected. This allows you to perform a Change operation (see the next chapter) on a selected region while keeping it on the Clipboard — copy a region, change it, and then paste the original into a different place.

### Paste

Paste places the contents of the Clipboard (put there by a Cut or Copy) into the sequence, beginning at the location of the blinking cursor, and replaces any existing data that occupies the same measures and/or tracks. You can choose the command with the mouse, or use `≈-V` from the Mac keyboard. Note that, unlike most of *Master Tracks Pro*'s editing commands, you do not select a region for the Paste command to act on, you select a single point to insert data from. If you have selected a region and try to Paste, the command will not function.

If the Clipboard contains data from more than one track (in the Track Editor), data from the lowest-numbered track in the Clipboard goes into the track marked by the cursor, and data from subsequent tracks is automatically inserted into the next tracks, in order. So if you have copied data on tracks 4, 5, and 6, and place the insertion point on Track 11, the data will be pasted to tracks 11, 12, and 13.

You can paste data anywhere you like — into empty tracks, into the same tracks at a different point in the sequence, into tracks with data already on them, or into other sequences. Pasting is a “destructive” function: if you paste notes into a region that already contains notes, the new notes will replace the old ones. The destruction is regional, meaning that it depends on the size of the region on the Clipboard, not where the actual events are within that region — in other words, if you have copied one measure of notes and three empty measures onto the Clipboard and then paste it onto an existing track, you will end up with one measure of notes and three empty measures, even if there were notes in all four measures before you pasted. For a non-destructive paste, use the Mix Data command, described below.
Pasting in the Event List Editor

Paste works slightly differently in the Event List Editor. When you choose Paste, a dialog box comes up asking you where (measure, beat, clock) to paste the data. The value in the box will be the location of the beginning of the last regional selection you made, which makes it easy to paste into another track at the same spot, or into the same track at a different measure (change the measure, leave the beat and clock alone).

Pasting between windows

You can only Paste data from one window into the same type of window. For example, you cannot paste notes into a Pitch Bend window, or Pitch Bend into the Track Editor. You cannot even paste controllers into different controllers: if you have controller data on the Clipboard, you can only paste it into a controller window if the Controller number showing is the same as the Controller number of the window the data came from. (You can change one type of controller data to another, using the Continuous command described in the next chapter.)

However, data cut or copied from the Track Editor can be pasted into the Step Editor window, one track at a time (if you cut or copy more than one track, only the first track will be pasted). Any non-note data taken from the Track Editor will also be pasted into the track, regardless of whether the Step Editor is in “notes only” or “all” mode, and will appear when you open the appropriate windows.

Multiple Pasting

When you paste a region into a window, the cursor goes to the next clock position after the region you’ve just pasted. For example, in the Step Editor window, if you paste a region 100 clocks long starting right on a beat, the cursor will end up at clock number 101. Similarly, in the Track Editor, if you paste a two-measure section starting at measure 5, the cursor will be right at the beginning of measure 7.

This fact, combined with the fact that after a paste operation the data on the Clipboard remains on the Clipboard, means that you can perform multiple
pastes, one after another, simply by repeatedly choosing Paste or typing \(-V\). This can be useful when you want to repeat a passage a certain number of times — select a region that encompasses the passage, copy (or cut) it, and then paste it as many times as you want. (In the Step Editor, if you want the repeats to be rhythmically consistent, make sure the region you choose is a whole number of beats long.) One obvious use for this is constructing a drum track — you can create a one- or two-measure pattern, copy it, and then just paste it the number of times you need to fill up the whole track.

Clear

Clear works similarly to Cut, except that the data is removed without placing it in the Clipboard. This gives you an alternative way to remove portions of your sequence. It is useful when you want to remove data from your sequence, but you don’t want to erase what is already on the Clipboard.

To use the Clear command, choose it from the Edit menu after you’ve selected the region you want to clear. Alternately, you can simply press the Delete (backspace) key after selecting a region.

Like Cut, Clear only works on data in the current window: in the Track Editor, it removes all data; in the Step Editor it removes either all data or just notes, depending on the setting of the mode icon; in the Event List Editor it removes only visible data; and in the MIDI Data Windows it removes only the type of data displayed in the window.

Clear differs from Cut in that you cannot remove measures from a track with Clear, you can only erase the data within them. Therefore, if you select an entire track from the Track Editor window and select Clear (or press Delete), the track will still be there, it will just consist of empty (hollow) measures — whereas if you had selected Cut, the track would have disappeared completely. If you select all 64 tracks in one measure and choose Clear, you will end up with a measure with no data in it; had you chosen Cut, the measure would have been removed and all measures to the right would have shifted over to fill in the gap.
**Mix Data**

The Mix Data command works similarly to the Paste command, except that the data in the Clipboard that you’re inserting in the sequence is merged with existing data already in the sequence. Like Paste, Mix Data needs to see a single insertion point, not a region, to work with. The Macintosh keyboard equivalent for Mix Data is ≈-M.

The same restrictions on moving data among windows described above with the Paste command apply to the Mix Data command. As with Paste, data remains on the Clipboard after a Mix Data operation, and the cursor moves to the end of the region affected by the operation, so that multiple Mix Data commands are possible — so you can, for example, lay a short cymbal pattern on top of a kick and snare track by copying the cymbal pattern, setting the cursor to the beginning of the drum track, and repeatedly choosing Mix Data or typing ≈-M. The Mix Data command does not impose a Tempo Map over the mixed region.

**Dealing with Tied Notes**

As mentioned in Chapter 3, *Master Tracks Pro* handles notes that are tied over bar lines a little differently than you might expect. These rules are designed to make editing in the Track Editor easier, so that you do not always have to worry about whether the notes you want to work with begin precisely on downbeats.

**Notes tied into a region**

Normally, if you select a region of notes to Cut or Copy, and the region contains notes that started prior to the beginning of the region, those notes will not be affected by the operation. However, if the selected region starts on a measure boundary, any note in that region which is tied over from an earlier measure will be included in the region, but only that part of the note that falls within the region.
In other words, if a note starts on beat 4 of measure 1 and continues until beat 3 of measure 2, and you select a region starting on the beginning of measure 2 and choose Copy, the Clipboard will contain a note that starts immediately and has a duration of 2 beats. If you select the same region and choose Cut, the original note will get cut off at the beginning of measure 2, and the Clipboard will again contain a 2-beat note that starts immediately.

Notes Tied Out of a Region

A variation on this rule applies to notes that begin within a selected region and end after it. Under normal circumstances, notes like this are moved to the Clipboard in their entirety by a Copy or Cut operation. However, if the note extends past a measure boundary and the selected region does not, then the portion of the note that moves to the Clipboard is cut off at the measure boundary.

Here’s an example. A note starts at beat 3 of measure 1 and continues to beat 3 of measure 2. With the mouse, select a region that starts on beat 2 of measure 1 and continues to beat 4 of measure 1. When you Copy that region, the Clipboard will contain 1 beat of silence, and then a note that is exactly 2 beats long — i.e., as much of the note as appeared in measure 1. When you Cut that region, the first part of the note on the display is cut off, and only the part after the beginning of measure 2 remains. The Clipboard again contains 1 beat of silence followed by a 2-beat note.
6.7 Cutting a Tied Note Before a Measure Boundary and Pasting it One Measure Later

Remember, in the Track Editor, a selected region always starts on a measure boundary. In the Step Editor, a selected region can start on a note boundary if the mouse is clicked when the “clocks” indicator in the time indicator box reads “000”, or (and this is much easier) if the region is selected by double-clicking in the measure ruler.

Insert Measure

The Insert Measure command (≡-I) allows you to put empty measures into a sequence. You might use this command to insert a new section into the middle of a composition or to add a blank space or countdown at the beginning. When new measures are inserted into a track, they initially show up in the Track Editor as hollow boxes. All subsequent measures are pushed to the right.

You can use the command from any graphic editing window — in the Track Editor, put the cursor at the point where you want to insert the measure, and in the Step Editor, or MIDI Data windows, put the cursor at a point (or on an event) inside the measure that is going to follow the inserted measures (e.g., to insert measures between measures 4 and 5, put the cursor inside measure 5).

When you select the command, a dialog box opens up asking you how many measures to insert, and whether to insert them on all tracks (thereby making the whole sequence longer, including the Tempo Map), or just on the selected track (thereby shifting the remainder of that track over to the right, relative to
all the others). You cannot insert measures on more than one track at a time without inserting measures on all of them — if you want to lengthen just two or three tracks and leave the others alone, you’ll have to do the operation on each of the tracks, one at a time.

When you insert measures on all of the tracks, the new measures will assume the meter, beat, and last tempo of the measure immediately before the insertion point. If you want to change any of these, use the Conductor command from the Change menu (see the next chapter) after inserting the measures.

Insert Data

The Insert Data command is a shortcut command that combines the "Insert Measure" command (see above) and the Paste command. Insert Data automatically inserts measures and places the clipboard information into those measures.

Please note that since "Insert Measure" command is not un-doable, only the Paste portion of this command can be un-done.

Delete Measure

The Delete Measure command (≡-D) is the opposite of the Insert Measure command. It gives you a convenient way to remove measures from a sequence or from a single track. When you remove measures from an entire sequence, the Tempo Map for those measures is removed as well, and the sequence is shortened. The command is equivalent to selecting the measures from the measure ruler in the Track Editor window and choosing Cut — except the data is not placed on the Clipboard.

Note: If you use either the Insert Measure or Delete Measure commands in a region that contains locked markers, you will get a message asking you how to handle the markers. See Chapter 11 for a discussion of this.
**Editing MIDI Data While Playing a Sequence**

*Master Tracks Pro* allows edits to be performed while a sequence is playing. Any operation will take effect immediately — if the change is over a portion of a track that has not been played yet, then when the measure counter reaches that portion, you will hear the changes right away. If the change is over a portion of the track that has already played, obviously you won’t hear the changes until the next time you play the track.

In some cases, if a note is being sustained on a track you are editing, when you do the edit, the note will cut off. This is only temporary, and then next time you play the track the note will play for its full value.

The only edit operations that you can’t do while the sequence is playing are those that involve the Tempo Map in any way (although you can change tempos on a temporary basis while playing, using the Conductor window). Therefore, you cannot Insert or Delete Measures while playing, nor can you select a measure over all 64 tracks (using the measure ruler in the Track Editor) as this would affect the Tempo Map.

If you are playing a track while editing it, you should turn off Follow Playback, so that the screen doesn’t jump away from you while it plays.

**The Change Filter**

The Change Filter is a special set of parameters that can be used by *Master Tracks Pro* to limit or delineate the data that is affected by an operation on the Change menu. Once the parameters in the Change Filter are set up, they stay that way until you alter them. You can even save them as part of the Preferences file so that they show up the same every time you boot the program.

You can set the Change Filter parameters from the Edit menu, or you can set them from within any of the dialog boxes that open when you perform a Change operation. Because it is more relevant to the Change operations, we will save the detailed discussion of the Change Filter for the next chapter.
Show Clipboard

Show Clipboard pops up a small window which describes the current contents of Master Tracks Pro’s clipboard. The window tells you which tracks the data was taken from, the beginning and ending points (in measures, beats, and clocks) of the origin of the data, and whether the data was cut or copied.

The Clipboard window remains on screen until you close it. As long as it is open, the command on the Edit menu changes to “Hide Clipboard”. It’s likely that if you leave it open, the Clipboard window will get buried under other screen windows. If this happens and you want to see it again, the best thing to do is to close it (choose Hide Clipboard) and then open it again (Show Clipboard). This will bring it to the front.
While the Edit menu commands let you move or delete regions of notes, the Change Menu contains commands that allow you to regionally alter MIDI and timing data in sophisticated ways. Unlike the Edit menu commands, the Change menu commands will normally affect all notes and “continuous” data — controllers, pitch bend, and channel pressure — in the region selected, regardless of what window is currently open. So you can, for example, change the durations of notes in a region by selecting the region in the Channel Pressure window. An exception to this is the Scale Time command, which will be discussed shortly.

Some Change commands, like Velocity, work only on notes, while others work on both notes and non-note data. The Continuous command works only on non-note data, and the Conductor command works only on the tempo map and not on MIDI data at all.

The restrictions on using the Change commands are the obvious ones: in the Step Editor, Event List Editor, or any of the MIDI Data windows, you can only define a region on one track, while in the Track Editor you can define a region on as many tracks as you like. In the Track Editor, region boundaries must be on measure boundaries, while in the Step Editor, Event List Editor, and MIDI Data windows region boundaries can be on any clock.
Included in the Change menu are commands for changing the MIDI channel of recorded notes, note durations, note velocities, continuous MIDI data (controllers, pitch bend, and aftertouch), and tempo and meter in the selected region. There are also commands for stripping different types of data out of a track, transposing pitch, and for changing the rhythmic relationships of MIDI events.

As with Edit menu commands, you must first select a region before you can use the Change commands. To select a region, use the mouse as described in the previous chapters. Then pull down the desired Change menu item, and the operation will begin. All of the Change menu items have dialog boxes for determining how the operation should proceed. At any time, in any of those boxes, you can click on Cancel and you will return to the window you came from, with the region still selected, but with no operation having taken place.

Once you complete a Change menu operation, the selected region stays selected, which makes it easy to go ahead and perform another operation on the same data right away. Since many of the operations complement each other, this can be a great time-saver.

Also as with Edit commands, notes that begin before a selected region but end in it are not affected by Change menu commands, but notes that begin within the region and end after it are affected. (All the exceptions having to do with tied notes do not apply.)

Finally, like Edit commands, Change commands can be made while a sequence is running. The same restrictions apply — no operations can be made that affect the Tempo Map, so operations that cover all 64 tracks are not allowed. Also, the “Channel”, “Conductor”, and “Fit Time” commands can only be used when the sequencer is not running.

**Using the Change Filter**

Many of the Change menu dialog boxes have an item labelled “Change Filter”. This is a special set of parameters that let you limit what data will be affected by the Change operation. We will cover using the Change Filter at the end of this chapter.
Channel

This command permanently changes the MIDI channel assignments of all the data in a selected region (both notes and non-note data) to a new channel number. After selecting the region, choose the Channel command from the Change menu.

When the Change Channel dialog box appears, type in the channel number (1 to 16) you wish to assign to the data in the selected region. Click on OK or press Return on the Macintosh keyboard to complete the process. Click on Cancel to exit from the command without making any changes.

Remember that this command has no real effect on any track unless the track is not assigned to a MIDI channel in the Track Editor window (the Chnl field reads “—”). If all you want to do is change the playback channel of a track, it’s much easier just to change the Channel number in the Track Editor.

Duration

Choosing the Duration command pops up a dialog box that allows you to alter the duration of each note in the region — i.e., how long it lasts. The dialog box gives you two choices for changing note durations. The first option in the box lets you set all notes in the region to the same duration, which you can specify. The second option lets you change all of the durations by a given percentage.

Selecting a Constant Duration

Activate this option by clicking in the radio button next to the words “Set all values...”. Next, select the duration you wish by using the arrow controls (or Mac keyboard arrow keys) to choose the appropriate duration icon. The range available is 64th-note to dotted whole-note. When you select a duration icon, the box immediately to the right shows how many clocks that duration is equivalent to. If you want to set shorter or longer durations, or durations that fall between the given values, you can double-click on the numeric box and
type in the number of clocks you want the notes to be. The allowable range is 1
(1/240th of a quarter-note) to 32767 (a little over 34 measures in 4/4 time).

You can also select a tuplet resolution. Select the tuplet values you want by
clicking in the two boxes at the far right for the numerator and denominator of
the tuplet, and then click on the “tuplet” box to turn on the function. The
number in the clock box will change to reflect the tuplet value you’ve set up.

The tuplet values will be relative to the duration icon showing on the left side
of the dialog box. For example, if an eighth-note icon is showing, “3:2” means
the duration will be equal to one note in a triplet that fills the space of two
eighth-notes. Two eighth-notes = 2 x 120 = 240, divided by 3 = 80, so the
duration of these notes will be 80 clocks, and the number in the clock box will
be 80. If a quarter-note icon is showing, “5:4” means the duration will be equal
to one note in a quintuplet that fills the space of four quarter-notes: 240 x 4 =
960 \div 5 = 192 clocks. If the tuplet you’ve created doesn’t divide into an even
number of clocks, the program will round off the value to the nearest clock.

Selecting a Percentage Change

The second option in the Change Duration dialog box allows you to scale all
duration values in the selected region by a percentage of their current values, so
that their relative durations are preserved. Click in the radio button beside the
words “Change to...” to select it, so that the solid black dot appears. Now type
in the percentage of the current duration values, within the range of 1 to
9999%, you wish to change them by. The program will round values off to the
nearest clock value, and will not produce notes with a duration of 0. Values of
less than 100% will shorten notes, and values greater than 100% will lengthen them.

After selecting the option you wish, Click on OK or press Return to complete the command, or click on Cancel to return to your work without making any changes.

Note that in this dialog box, as in all Master Tracks Pro dialog boxes, you can move among the various numeric (or text) fields by pressing the Tab key. Each time you press Tab, the cursor jumps to the next field, and it becomes highlighted. If you need to set a lot of parameters in a dialog box, this can save a lot of mouse movement.

Add Clocks

The third option in the Change Duration dialog box allows you to add a specified number of clocks to every note in the selected region.

Velocity

The dialog box that pops up when you choose the Velocity command lets you change the velocity values for all notes in a selected region.

Velocity can affect a patch’s volume and/or its timbre, so changing velocity is useful for adding “punches” to a track or to change the loudness of a track or passage relative to other tracks. You can bring velocity values up or down over time to create swells, crescendos, and decrescendos.

The first task when this box is open is to decide whether your changes will apply to note-on velocities, note-off velocities, or both. Click in the radio button next to one or both of these choices in the dialog box. Most synths do not transmit or recognize note-off velocities, so you can usually leave that choice off.

Next, you must decide from among five options for altering the velocity values. Click the button next to the option you select. They are:
8.4 Change Velocity Dialog

- Set all velocity values in the region to a specific value, between 1 and 127.

- Change all velocity values by a specific percentage, from 1 to 999% (100% means no change). Any values calculated to be greater than 127 will be set to 127, and any values less than 1 will be set to 1. (A MIDI note-on command with a velocity of 0 is defined as a note-off, and you don’t want that.)

- Have all velocity values in the region change smoothly from one number at the beginning of the region to another number at the end of the region (i.e., create a crescendo or diminuendo). The values can go up or down, and they must be between 1 and 127.

- Have all velocity values in the region change smoothly by one percentage at the beginning of the region and by a different percentage at the end of the region, and interpolate everything in between. This allows you, for example, to perform a crescendo without imposing a strict note-to-note velocity increase over a region. Values can be between 1% and 999%. Again, the resulting velocity values will be between 1 and 127.
• Add or subtract (using a negative value) a set amount, between -127 and 127, to all velocity values in the region. When you choose this selection, you can also select “limits” for the operation so that no notes go above a certain level or below a certain level. This is useful for “compressing” tracks, or for changing the velocity of tracks which are being played on instruments with velocity switches (they change sounds when a certain velocity is reached), which you don’t want to trigger. Again, the resulting velocity values will be between 1 and 127.

After selecting which of these five options you wish to use, click on the appropriate data box(es) for that option, type in the value(s) or percentage(s) you want, and Click on OK or press Return.

Note that when changing velocity over time, the value calculated for a specific note will be based on its relative position in the selected region, not its numerical order in the region. This is best illustrated by the following example: Let’s say you select a region two beats long, and specify a velocity change over that region from 50 to 100. If the first note in the region occurs right at the beginning of the region, its velocity will be 50. However, if the first note occurs halfway through the region (one beat after it starts), its velocity will be 75. This may seem obvious, but it’s an important principle to keep in mind when selecting regions in which there are areas of no data. It applies equally to changes in continuous controllers, described below.

Continuous

Choosing the Continuous command brings up a dialog box with a number of functions having to do with data from MIDI controllers (including modulation wheel), Pitch Bend, or Channel Pressure (aftertouch). You can use this command to “map” data from one MIDI controller to another, or change the values of the controller data, or both.

Mapping One Controller to Another

The mapping function is useful if you have a master MIDI instrument that generates one kind of controller information, and a synthesizer that responds to
a different kind. For example, you may have a MIDI wind driver that generates lots of Breath Controller data (Controller #2), and a synthesizer that doesn’t read Breath Controller, but responds to Channel Pressure. By mapping the Breath Controller data to channel pressure, you can take advantage of the wind driver’s expressive capabilities with this particular synthesizer.

To map one data type to another, first select the type of data you wish to operate on in the selected region, from the choices listed under “Select Data Type” in the upper left corner of the dialog box. Click in the radio button next to the choice you select so that a solid black circle appears. If you’ve chosen the “Controller #” option, you must also type in the desired controller number, from 0 to 127, in the corresponding box. (A list of standard MIDI Controller numbers appears in Appendix C.)

Next, click in the box labelled “Map Data Type To” at the right of the dialog box. An “X” will appear in the box. Now choose the data type to which you want to map the existing data by clicking in the button next to your choice. Again, you must type in a number if you select the “Controller #” option.
Changing controller data values

To change data values, you must first select the type of data you wish to work on, as described above. Next, click in the box labelled “Change Data Values” so that an “X” appears in the box. As with velocity, you now have five choices:

- Set all values in the region to a specific value, between 0 and 127 (–128 and +127 for pitch bend). Unlike velocity, there is no reason not to allow controller values of 0.

- Change all values by a specific percentage, from 1 to 999% (100% means no change). Any values calculated to be greater than 127 will be set to 127 (pitch bend values below -128 will be set to -128).

- Have all values in the region change smoothly from one value at the beginning of the region to another value at the end of the region. The values can go up over time or down, and they must be within the normal range.

- Have all values in the region change smoothly from one percentage at the beginning of the region to another percentage at the end of the region. This allows you, for example, to exaggerate or make less prominent a controller move without interfering with its basic action or making it excessively smooth. It’s especially useful for MIDI-controlled mixing, in which you want to achieve an overall effect over a period of time without tampering with the smaller motions within that time. Values can be between 1% and 999%. Again, the resulting values will be between 0 and 127 (or -128 and +127 for pitch bend).

- Add or subtract (with a negative value) a set amount, between -127 and 127, to all values in the region. When you choose this selection, you can also select “limits” for the operation so that the values do not go above or below certain levels. Once again, the resulting values will be between 0 and 127 (pitch bend between -128 and +127).

After selecting which of these five options you wish, click on the appropriate data box(es) for that option and type in the value(s) or percentage(s) you’ve chosen.
You can perform both a mapping operation and a changing-data-value operation at the same time. The re-mapped data will have its values changed.

Once you’ve made all your choices, click on OK or press Return to complete the command. Click on Cancel at any time to exit the dialog box without making any changes.

Keep in mind that no operation in this box will take place unless at least one of the boxes “Map Data Type To” and “Change Data Values” is checked. Selecting a radio button or entering a controller number in a box is not enough to make the operation happen.

*Note:* Operations in the Continuous window will not create controller data on a track — it will only alter data that is already there, either recorded or drawn in. If there is no data there to begin with, these operations will have no effect. Also, as with the Velocity command, the value a controller ends up with after a Continuous “change over time” operation depends on the position of the controller event within the selected region, not whether it is the first event to occur.

**Pitch Bend Range**

Bend ranges vary among MIDI instruments. If you use Master Tracks Pro to record a melodic line that contains pitch bend using a particular synth module, you may find that the bend range changes when you play the sequence back using a different synth module. The Pitch Bend Range feature lets you easily adapt the bend range to suit different synth modules.

The Change Pitch Bend dialog allows you to enter the bend range of the original module (in semitones) and the range that you wish to change to. You can still use
Using the Change Menu

111 Using the Change Menu

the “Pitch Bend” option in the “Change Continuous Data” dialog (Change Menu), but this method is more simple and straightforward.

Conductor

Within every Master Tracks Pro sequence is a track called the Tempo Map. The Tempo Map contains meter and beat information for every measure, and tempo information for every clock in a sequence. All of the tracks in a sequence follow the meter and tempo dictated by the Tempo Map. You can change the Tempo Map within the Tempo Map window (see Chapter 11), and you can also perform some operations on the Tempo Map using the Conductor command. (Do not confuse this command and its dialog box with the “Conductor Window” entry on the Windows menu, which merely opens or brings forward the real-time Conductor window on the screen.)

You can select a region for editing with the Conductor command from any window. However, the command only operates on measure boundaries — if you are in the Step Editor window and select a region that starts somewhere in measure 10 and ends somewhere in measure 13, the Conductor command will operate from the beginning of measure 10 to the end of measure 13.

Once you select a region and choose “Conductor”, a dialog box opens up. At the top of this box are small text boxes with the starting and ending measure numbers of the region you’ve selected. In point of fact, unlike the other Change menu commands, it is not necessary to select a region before choosing Conductor, because of these boxes. Therefore, the Conductor command on the Change menu is always active (in black type).
If you don’t select a region first, then the dialog box will open with the entire sequence selected: measure 1 in the left-hand box and the last measure of the sequence in the right-hand box. If you don’t want to work on the whole sequence, click in one or both of the boxes and type in the measure numbers you want.

Besides choosing it from the Change menu, you can also access the Conductor command by double-clicking on the time signature in the Conductor window.

**Changing the Meter**

To change the meter (time signature) over the specified measures, click in the box next to the words “Set Meter”. Then click on the upper and lower meter-setting boxes immediately to the right, and enter the new meter. The upper number can be anywhere between 1 and 16; the lower number must be 1, 2, 4, 8, 16, 32, or 64.

When you change the meter in a measure, the data in and around the measure does not move — only the barline does. So if, for example, measure 10 is a 4/4 measure and you change it to 5/4, then a note previously on the downbeat of measure 11 will now be on the 5th beat of measure 10.

**Changing the Beat**

At the same time you select a meter, you must also select a beat value. The beat value has no real effect on the music, it merely affects the metronome. In a 4/4 measure, a beat value of a quarter-note will cause the metronome to sound once per beat, while a beat value of an eighth-note will sound twice per beat. In a 6/8 measure, a beat value of a dotted-quarter will cause the metronome to sound on every third eighth-note, which is standard practice.

If you want the metronome in a 4/4 measure to go twice as fast, for example, but not change the basic tempo, you can change the beat to eighth-note and double the tempo. The metronome indicator in the Conductor window will then reflect this change.

To change the beat value of the specified measures, click in the box next to “Set Meter” and use the arrows next to the beat indicator (or the Macintosh arrow
keys) to select the beat value you want. You cannot select a beat value that does not go evenly into the time signature — for example, you cannot set a beat value of dotted-quarter note in a 4/4 measure.

Remember that you are setting both parameters simultaneously — if you have a complex passage with changing time signatures over several measures, and you wish to change the beat value of those measures, you cannot do it in one operation, because then all of the measures will end up with the same time signature. Therefore, you must set the beat for all the measures first, and then change the time signature in each measure individually. Alternatively, you can change the beat value in each measure individually.

**Setting Tempos**

The Conductor command can do five tempo-changing tasks over a selected region:

- Set all tempo values in the region to a specific value.
- Change all tempo values up or down by a specific percentage.
- Add or subtract (with a minus value) a set amount to all tempo values in the region. Limits can be imposed on this function so that the tempo never goes faster than a certain speed or slower than a certain speed.
- Have the tempo of the region change smoothly, up or down, from one value at the beginning of the region to another value at the end of the region.
- Have all tempos in the region change smoothly from one percentage at the beginning of the region to another percentage at the end of the region. This is useful for achieving an acceleration or deceleration over a period of time in which you have already made tempo changes, and you don’t want to lose them. This operation will maintain the proportionality of those tempo changes while it creates an overall speed-up or slow-down.

After selecting which of these five options you wish, click on the appropriate data box(es) for that option and type in the value or percentage(s) you want.
The range of permissible values for tempos is 10 to 300 bpm with the beat value set to quarter-note (with the beat value at eighth-note, the maximum tempo is 600 bpm, and at sixteenth-note, the maximum is 1200 bpm). Any existing tempo values that are changed by addition or percentage multiplication so that they are out of range will be truncated to the maximum or minimum values.

Note that when you are changing meter and/or beat, you must have one of the tempo operations selected. If you don’t want to make any changes in the tempo (just the beat or meter), then select “Change to .... % of current values” and type in “100”. There will be no change in the tempo, and it will be as if this part of the window were turned off.

Click on OK or press Return to complete the Conductor command. Click on Cancel to exit the command without making any changes to the sequence.

Looking at the Results

If you go to the Tempo Map window (from the Windows menu or type ≈-0), you can see the results of the Conductor command’s actions directly. When tempos in a region are set to a specific value, then only one tempo change occurs per measure. When tempos are changed by addition or percentage multiplication, tempo changes occur exactly where they did prior to the change.
— at least once per measure, more than that if there were other tempo changes inside measures before the operation. When tempos are changed over time, then a new tempo change occurs on each beat within the specified time (a beat being defined here as the denominator of the time signature: every quarter-note in 4/4 time, every eighth-note in 4/8 time, etc.) You can also insert tempo changes by hand in the Tempo Map window — see Chapter 11. If you want tempo changes to occur on places other than even beats, then you must enter them manually in the Tempo Map window.

Listening to the Results

The Conductor commands let you set up a complex rhythm track before you record any notes. Since you can change meter and beat on every bar, and tempo as often as you like, you can easily create a highly accurate click track for a rhythmically complex tune. Try using the commands to create a track with wildly varying meters and tempos and listen to it with the metronome on (“Click”, on the Transport window, enabled).

A Tempo Map is a sequence, even if it has no notes in it. You can save it to disk and use it as a rhythmic template for other sequences, and you can export it as a MIDI File for use in other programs.

Locked Markers

If you use the Conductor command to change the Tempo Map over a region that contains locked markers, you will get a message asking you how to handle the markers. See Chapter 11 for a discussion of this.

Strip Data

The Strip Data command gives you a way to set limits on the data being cut or copied from a selected region. The various limitations offered to you can be used one at a time or in combination.

Data selected in the Strip Data dialog box can either be Cut, in which case it is removed from the selected region and placed on the Clipboard, or it can be
copied, in which case it is placed on the Clipboard without removing it from the track. The choice of whether to cut or copy is made at the bottom of the dialog box with radio buttons. Once the data is on the Clipboard, it can be pasted anywhere in a sequence, or in another sequence, or forgotten about.

Setting Up the Operation

Items in the Strip Data dialog box are selected with checkboxes. If there is an “X” in an item’s box, then the data named in that item will be stripped. If the box is blank, the corresponding data will be left alone.

The first item is Channel. If this item is selected, only data in the region that is assigned to the channel in the box (type in the channel number you want) will be stripped. Remember, this will deal with individual data items as they are recorded, and the setting of a track’s Channel assignment in the Track Editor window will have no bearing on what data is affected by this command.

The next items are Pitch Bend, Channel Pressure, Key Pressure, Modulation, and Program Change. Checking on any of these will strip the appropriate data from the track(s).
Controllers will strip all controller data, unless the radio button directly below it is checked, in which case only data from the controller whose number appears in the box immediately to the right will be stripped.

Notes will strip all notes from the region, unless the radio button directly below it is selected, in which case only notes between the specified notes will be stripped. (The specified notes are included in the range of notes that gets stripped.) The range of possible notes is C-2 to G8. Accidentals must be referred to as #’s, e.g., G#3. You can also specify notes by their MIDI numbers, i.e., 0 to 127, or by clicking in a box and then playing the note you want on your MIDI keyboard.

Using Strip Data

The Strip Data command has many uses. You can create keyboard “splits” by stripping different ranges of notes from a track and pasting them to other tracks. You can remove controller information from one instrument and make it apply to a different one. You can change a single-track Type 0 MIDI File into a multitrack sequence by stripping the data from the single track one channel at a time, and pasting it to other tracks. You can use it to conserve memory and keep MIDI data flow down by removing unnecessary controllers from tracks (like aftertouch recorded from a DX7).

Remember that the various items in the Strip Data dialog box can be combined, so that you could, for example, only take out pitch bend on channel 4, or take out notes above middle C and sustain pedal (controller #64), leaving everything else.

Note that some of the action of the Strip Data command is duplicated in the MIDI Data windows. For example, if you want to remove pitch bend from a track, you can do it with Strip Data, or you can open the Pitch Bend window, select a region, and choose Cut or Clear. Strip Data is especially useful when you want to work on more than one track at a time, or when you want to remove more than one type of data at a time.

The action of the Strip Data command can be further enhanced by the Change Filter — see the discussion later in this chapter.
Thin Continuous Data

The Thin Continuous Data feature allows you to reduce the density of continuous MIDI data (pitch bend, pressure, and/or controllers), saving memory and also keeping the MIDI data stream from “choking”. The bandwidth of MIDI is not unlimited — it allows about 1000 commands to be sent each second — and when you are using a lot of continuous data on several tracks, it is quite possible to exceed that bandwidth. The result is that data gets to its destination late, and tempos slow down and speed up seemingly randomly, or notes sound out of time or even get lost completely. If continuous data is used conservatively, the chances of this happening are much reduced, and this command can help.

Selecting the Thin Continuous Data function opens a dialog box that lets you select specific types of data for thinning over the region you’ve already selected. You can choose to thin Pitch Bend, Modulation (Controller #1), Channel Pressure, Key Pressure, and/or all Controllers, or only one specific controller. You can then specify how much to thin out the data, both in terms of time and in terms of data value.

The “Times” value you specify will be the density over time of the data — that is, how fast the commands will occur — after the thinning is completed.
Specifying 1 clock will essentially change nothing, unless two events happen to occur at the same time, in which case one of them will be eliminated. Specifying higher numbers will cause the events to occur further apart. The “Values” value specified will determine how the data will “jump” from one event to the next. Specifying a high number will cause the resolution of the data to become relatively coarse, and more step-like than continuous. Specifying 1 will mean only redundant data — that is, commands that occur twice in a row with the same value — will be eliminated.

The thinning operation has some “intelligence” programmed into it — it doesn’t just wipe out data blindly. In any region being thinned, the operation will always maintain the first data value, the last value, and the highest and lowest values, and if the values go up and down repeatedly, it will maintain all of the peaks and all of the lowest dips.

Generally speaking, putting lower numbers in these values will produce results that have less audible effect on the music, which is desirable. Higher numbers will have more of an effect on the data density, and will therefore help more to prevent choking, but the effect may be more audible. A certain amount of experimentation is sometimes necessary — start with lower numbers, and if you still have problems, increase them gradually.

7.11 Before and After a Thin Continuous Data Operation
Thin Notes

The Thin Notes dialog allows you to remove duplicate notes within a certain clock range and then in order by the following removal precedence:

1. shorter duration
2. lower velocity
3. second in line

Transpose

The Transpose command changes the pitch of all the notes in the selected region up or down. The transposition is chromatic — all notes are transposed equally. It can be chosen from the Change menu or by typing ≈-T.

When you choose this command, a dialog box appears which asks you to enter the note you are transposing from, and the note which you want to transpose to. To enter these notes, click on the appropriate box, and then type in a pitch letter name, a # sign if you’re entering an accidental, and the octave number. Valid pitches range between C-2 and G8. Alternatively, you can type in the MIDI pitch value (0 to 127), or play the appropriate note on your MIDI keyboard.

The actual entries that you type in are not crucial, but the interval between them is. In other words, if you type E5 in the “from” box and E6 in the “to” box, the transposition will be exactly the same as if you typed C3 in the “from” box and C4 in the “to” box — up one octave. The dialog always opens with “C3” in both boxes, so it might be faster for you to think of your transpositions relative to that note where possible.
You can also tell the Transpose function to make all notes a specific note. This is particularly useful when you are mapping one drum machine to another (although the Re-Mapping function in the Step Editor is faster), or when you want a rhythm instrument, like a kick drum, to exactly follow a bass line: copy the bass line to a new track, and then Transpose all the notes on that track to the note corresponding to the kick drum.

Press Return or click on OK to enter the transposition and return to your work. Click on Cancel to exit without making any changes.

Transpose Map

The Transpose Map is a simple, yet powerful way to transform sequences and convert drum parts. With this feature, any note(s) over the entire range of MIDI can be quickly assigned to any other note using our unique keyboard display.

7.14 The Transpose Map Dialog

Simply click on the note box and type in (or play from your MIDI instrument) the new note for that pitch. You can display the note boxes as MIDI note numbers instead or pitches.
To create special "mode" tables you can select to copy all pitches to their relative octaves.

You can also Save and Load custom maps. The file extension .MTPM will be created for custom Maps.

Humanize

The Humanize command is an especially useful feature designed to make a sequence — especially one entered in step-time or already quantized — less machine-like and rigid. It does this by randomly shifting the start time, duration, and/or velocity of each note in the selected region.

When you select the Humanize command, a dialog box appears that lets you choose whether to apply the randomization effect to start times, durations, or velocities. Click on the box next to each option you want to select. You can select one, two, or all three.

Next, you must enter a maximum value for each of the changes. The Humanize command will randomly change the value of each note in the selected region, adding or subtracting a number somewhere between 0 and the maximum value. For example, if you tell the program to humanize start times to a maximum of 3 clocks, some notes will be delayed 3 clocks, some delayed 2, some delayed 1, some advanced 1 clock, some advanced 2 clocks, some advanced 3, and some not moved at all.

In the case of start times and durations, type in the maximum number of clocks that will be added or subtracted to existing values when the Humanize command goes to work. For velocities, type in a number between 1 and 127.

In practice, very small values work best for achieving subtle variations in highly mechanical music. Large values will produce wide and random changes that are sometimes useful, but not always predictable.

When you’ve made your selections, click on OK or press Return to enter them and complete the command. Or click on Cancel to exit without making any changes.
Quantize

The Quantize command aligns the start times of all notes in the selected region to an imaginary timing “grid”. The grid divides the region into intervals of a set number of clocks. When you use the Quantize command, the command moves the start time of every note within the region so that it falls precisely at the beginning of the nearest grid interval.

Everything or Just the Attacks

The first choice in the Quantize dialog box that opens when you invoke the command is whether you want to quantize entire notes or just the start (attack) times of the notes. If you choose (with the radio button) “Attacks only”, then the start time of the note will be quantized, while the end of the note will stay where it is, thereby changing the duration. This is useful if you have an event whose ending time is more important than its duration. If you choose “Entire note”, the duration will be maintained, and the end of the note will move right along with the beginning. This is generally more musical, and is useful when a note has a certain envelope characteristic which you want to maintain.

Setting the Quantization Value

The most common use of quantization is to rhythmically “correct” notes that have been played in by a live performer so that they fall directly on a beat or subdivision. Another use is to set up rhythms — especially polyrhythms — that would be difficult if not impossible for a human to play, such as 13 over 7. For that reason, Master Tracks Pro lets you quantize to just about any rhythmic value imaginable. The procedure for setting up quantization values is the same.
as used to set up duration values explained earlier in this chapter: you can choose a timing value with the arrows (or arrow keys) from among the rhythmic icons; you can type in a numerical value; or you can design a “tuplet” value (see the earlier discussion under "Duration" about setting up tuplets).

Ahead of and Behind the Beat

In a conventional quantization function, notes that lie more than 50% of the way between two points on the quantization “grid” will be quantized to the later point, while notes that are less than 50% of the way are quantized to the earlier point. Master Tracks Pro lets you change this ratio with the “Include notes up to...” function, so that if you consistently play a little early or a little late to the beat, you don’t end up with lots of notes moved to the wrong place.
The program defaults with an “Include notes...” setting of 35%. This means that notes 35% or less ahead of the beat will be quantized to the beat (moved later), while notes more than 35% ahead will be quantized to the previous beat (moved earlier). Another way of looking at it is that notes up to 65% late will be quantized to the previous beat.

This setting favors players who are late — players who tend to rush and find themselves ahead of the beat should use a setting like 70%, in which case only notes more than 30% late will be quantized to the next beat.

Intensity

As mentioned in the discussion on the Humanize command, quantization can make a musical passage sound overly mechanical if it is not used carefully. One way to overcome this is with the Intensity parameter in the Quantize dialog box. The Intensity parameter determines how close to the actual quantization point the program will bring notes when they are quantized. If the Intensity is set to 100%, the notes will be quantized exactly to the quantization “grid”. If it is set to 0%, they won’t be quantized at all. If it is set to 50%, they will move halfway towards the grid.

Here’s an example. You have a note that occurs 100 clocks after a beat, and you are quantizing to quarter-notes. If the Intensity interval is set to 100%, the note will be moved to occur right on the beat (clock 0). If it is 70%, the note will move 70% of the way towards the beat, and will
end up 30 clocks after the beat. If it is 20%, it will occur 80 clocks after the beat. If it is 0%, it will stay 100 clocks after the beat.

Swing

The Swing function will impart a swing feeling to a track by delaying the start of every alternate note by a designated amount. For example, if you have a measure of even eighth-notes and you use the Swing function set to eighth-notes, then every second eighth-note — the “and” of every beat — will be delayed by the amount you specify. In addition, the duration of the first eighth-note on each beat will be lengthened, and the duration of the second eighth-note will be shortened.

You can set the Swing function to work with any length note from 64th to whole-note (you can’t swing dotted notes), and you can set the Swing ratio anywhere between 50% and 75%, in increments of 1/10th of a percent. Setting it to 50% means there will be no swing — the notes will come out exactly even. Setting it to 75% means that the second note will occur three-quarters of the way into the beat (assuming the beat is equal to twice the quantization factor). In other words, again using eighth-notes, a ratio of 75% will produce a dotted-eighth followed by a sixteenth. “Triplet swing” can be produced with a ratio of 66.7%, which is the default setting for the function.

You can use the Swing feature without Quantizing, although the function works better on quantized notes, or notes entered in Step-Time.

Sliding Notes

Swing at 50%

Swing at 66.7%

Swing at 75%

7.18 Examples of Swing Settings
A very useful feature of the Quantize command is the ability to shift or slide tracks slightly forwards or backwards. When this function is turned on, then after the quantization is performed, all the notes in the track are moved the specified number of clocks to the left or the right. This is invaluable for creating passages that are a little ahead of the beat or a little behind, or to compensate for synthesizer voices with especially long or short attack times.

You can also slide notes without quantizing them — just turn on the slide function and make sure the quantization function is turned off.

When you’ve set up all your selections, click on OK or press Return to complete the Quantize command. If you wish, you can click on Cancel to exit without making any changes. (If you Cancel, the settings you make in the window will be maintained, so you can come back and try the operation again later without having to set up all the parameters from scratch.)

Here’s a good example of how to combine commands over a selected region to achieve a musical goal. To emphasize a downbeat, drummers will sometimes rush a fill at the end of a bar and leave a bit of a gap before the downbeat. You can create this effect by selecting the fill, quantizing it to sixteenth-notes, sliding it over to the left, say, 12 clocks, and then (remember, you don’t have to re-select the region) Humanizing the start times 6 clocks. This will give the effect of the fill being early, but the timing change won’t jump out at you, but is subtle, thanks to the randomization.

Slide notes affects note data only - Pitch Bend and other controller information on a track is not moved. See the following section on the Slide Data command.

**Sliding Data**

The "Slide Data" command differs from slide notes in that all data - (including controller info) is moved as specified.

**Fit Time**

7.19 The Fit Time Dialog
The Fit Time command lets you stretch or squeeze a given section of music so that it fits exactly into a particular amount of time. It works by scaling all the tempos in the Tempo Map for the selected region proportionally, so that the relationships between any existing tempo or meter changes in the region are preserved. In this way, although you change its overall timing, you don’t lose the feel — accelerandos, ritards — of the music.

Unlike the Conductor command, Fit Time will work on any selected region, whether or not it is on measure boundaries. It will create tempo changes at the beginning and end of the region (regardless of whether they fall on even beats) as well as on any beats where it deems it necessary.

When you choose Fit Time, the dialog box that opens shows the time of the selected region as it stands, in minutes, seconds, and frames (there are 24, 25, or 30 frames per second, depending on the settings in the MIDI Setup dialog box — see Chapter 14). To change the time of the selected region, merely type the numbers you want into the boxes. (You can use the Tab key to move among them.) The Tempo Map over the selected region will be recalculated to reflect the new time. The notes themselves will not move, and the barlines will stay where they were — only the Tempo Map (which is only visible if its window is open) will be affected.

Fit Time is a remarkably useful feature for film and video work. It works equally well whether you are using internal sync or MIDI Time Code. (With conventional MIDI Sync — clocks and pointers — the internal Tempo Map is ignored, and so the Fit Time function unfortunately doesn’t have much use.) Its effects can be subtle or gross, and it can be used to advance or delay a single note or to change the timing of an entire piece. It could be considered the function that most sets apart Master Tracks Pro from a conventional tape recorder: you cannot change the timing of a musical passage on tape to fit a visual cue without altering its pitch and the sound of the orchestra, but that is precisely what Fit Time accomplishes.

You can also use Fit Time to create a blank sequence, with just Tempo Map
information, in preparation of writing a film track. If you know, for example, that you want to cover a scene that lasts 14 seconds and 10 frames and you want to do it in four measures of music, you can select the first four measures of a blank sequence, choose Fit Time and type in 14 seconds and 10 frames, and then when you click OK you will end up with a Tempo Map which has the correct tempo for a four-measure piece exactly 14 seconds and 10 frames long. The tempo is calculated for you — you may never have to use a clickbook or calculator again.

Although it has many uses, Fit Time also has its limits. Don’t try to squeeze or stretch a section a ridiculous amount. Remember that only tempos between 10 and 300 quarter-notes per minute are allowed, so trying to make a two-second region last for 60 minutes will definitely not work.

Locked Markers

If you use this command to change the Tempo Map over a region that contains locked markers, you will get a message asking you how to handle the markers. See Chapter 11 for a discussion of this.

Scale Time

The Scale Time feature changes the timing relationship of the events in a selected region to the rest of the sequence, without changing the Tempo Map.

When you select a region and choose this command, a dialog box opens. If you type two numbers into the dialog box, the program will move the start times of all events in the region so that they are further away or closer to the beginning of the region by the ratio between the two numbers. For example, if the ratio you specify is “1 to 2”, then each event will be twice as far from the beginning of the region as it was before the operation, and the effect will be that the passage now plays at half speed, with respect to the rest of the sequence. The Tempo Map controlling the sequence, however, is not affected. If
the ratio is “2 to 1”, the events in the region will play at double speed.

You can specify any two positive integers (no zeroes or negative numbers) for the ratio. If you enter “10 to 317”, then the music will slow down by a factor of 31.7. If you are scaling notes, you can also specify whether note durations will be affected by the Scale Time operation, in addition to start times. If you put an “X” in the box marked “Scale note durations”, then the length of each note will be altered by the specified ratio.

Scale Time is an excellent way to set up polyrhythms with existing material. If you have an eighth-note melody and you want to stretch it out to dotted-eighths while maintaining a constant rhythm underneath, select the melody and Scale it with a ratio of 2 to 3. If you suddenly want a rhythm track to run at triple-speed for a measure, select a measures’ worth of the track, and Scale it with a ratio of 3 to 1. (You’ll have to Copy the resulting third of a measure and Paste it twice to fill out the bar.)

If you expand a region with Scale Time, and there is data already on the track after the region you are expanding, the expanded data will overlap into the existing data. If you shrink a region, the end of the region will be left empty — data from subsequent measures will not be “pulled in” to fill the gap.

As we mentioned at the beginning of this chapter, Scale Time works on both
notes and non-note data, but not always at the same time. If you execute the command from the Track Editor or Event Editor window, all data is acted upon. From the Step Editor window, non-note data is affected only if the window is in “All” mode, otherwise only notes are affected. From any of the MIDI data windows, only the data displayed is affected — not the notes and not any other data.

The Change Filter

Normally, all data within a selected region is affected by a Change operation. But data which is affected by the operation can be restricted by the Change Filter. The Strip Data function goes a certain distance towards being able to isolate specific types of data for editing; the Change Filter goes much further, and lets you do so without removing the data from its context. It provides a way to narrow editing commands so that they work only on very specific musical events.

Whenever you choose a Change-menu command (except Conductor, Thin, Fit Time, or Scale Time), the dialog box that opens contains the item “Use Change Filter”. If you click on the box next to “Use”, then the Change Filter parameters that have been set up previously will become active in the operation that follows. If you click in the oval surrounding the words “Change Filter”, the Change Filter dialog box opens, and you can set the parameters right then and there. (You can also open the Change Filter dialog box and set the parameters from the Edit menu by choosing “Change Filter”.)

The Change Filter parameters work similarly to the parameters in the Strip Data dialog box, except they are somewhat more sophisticated. When an item is selected by putting an “X” in the box immediately to its left, then only the data within the range specified in the boxes to the right of the item is affected by the Change command. You can use as many items as you like.

For example, a Transpose command on a track would normally involve all pitches. If you just wanted to transpose pitches in the octave C3 to C4, then within the Transpose dialog box, you could click on “Change Filter”, and then within the Change Filter dialog box, click on “Pitches” and specify the notes
The first item in the Change Filter dialog box is, indeed, Pitches. Pitches can be entered in the “from” and “to” boxes by typing in their names from the Mac (always use “#”s for accidentals); by typing in their MIDI numbers (0-127); or by playing them on a MIDI keyboard. Being able to isolate data by pitch is extremely useful and has many applications. One obvious one is that it will let you quantize the snare drum on a track (if the drum’s note is C#4, set both Pitch parameters to C#4), and leave the other drums alone.

Durations

The second item is Durations. The parameters are in clocks (240 clocks = 1 quarter-note) and can be set anywhere between 1 and 9999. Limiting durations in an operation can be useful in a number of ways. If your keyboard technique
isn’t perfect and you occasionally hit two keys instead of one, chances are the wrong notes will be very short, say around 20 clocks, and you can eliminate them, leaving longer notes alone, by setting the Durations parameters in the Change Filter to 1 and 25, and using Strip Data in the Cut mode. If you have a string part that alternates staccato and legato, and you want to bring out the long notes without making the whole track louder, you can use the Velocity command, increasing all notes by 150%, but specifying in the Change Filter only durations between, say, 180 and 1000.

**Velocities**

The next item is Velocities, which refers only to note-on velocities, and can range from 1 to 127. Sorting notes out by velocity is another good way to eliminate keyboard mistakes — Strip out all the notes with velocities below 20, for example. It also has expressive uses: you can exaggerate accents on a track, for example, by increasing note velocities by 125% *only* if they exceed 80 to begin with.

**Channel**

This item is useful when dealing with multi-channel tracks (which are unassigned in the Track Editor window), which you might have as a result of importing a Type 0 MIDI File, or recording a guitar controller not in Multi-Track Record mode. By turning this on, you can work only on notes within the track that are assigned to a specific channel. It makes it possible to work with a multi-channel track without having to Strip each channel’s data and Paste it onto another track.

**Measures**

This item lets you specify that the operation will not apply to every measure, but only to some — alternate measures, every third measure, every fourth, etc. It is chosen with radio buttons: the default is “all measures”, but you can change it by clicking on the other button next to the word “Every” and typing in the number you want. The beginning of the editing region is considered to be in the first measure, regardless of whether it is at the beginning of the measure or somewhere in the middle — measure number 2 begins at the next
measure boundary.

An example of how this feature can be used: Break up a melody line between two instruments by stripping off (in Cut mode) every second measure and pasting it to a different track. Another example: Humanize the fills on a drum track, but leave the rest of the track in strict quantized rhythm, by applying the Humanize function only to every fourth measure.

Beats and Sub-Beats

The final item in the Change Filter dialog box restricts the action of a Change command to particular beats or fractions of beats within a measure. The filter is enabled by clicking in the box next to the word “Start”.

Each one of the little circles that looks like a note-head is actually a radio button. By clicking in it you are telling the program that if it finds a note occurring at this rhythmic location in the measure, it should perform the operation on it. Notes occurring elsewhere in the measure are to be left alone.

The window allows you to specify rhythmic locations in measures up to nine beats long. These locations can be on beats, or on sub-beats — either 1/4-beats (sixteenth-notes, assuming that a quarter-note is a beat), or 1/3-beats (triplet eighth-notes). If you apply this filter to a measure that’s, say, four beats long, than any instructions you give for notes occurring on beats 5 through 9 are ignored. (If your measure is more than nine beats long, you cannot address any beat past 9. Sorry.)

Here’s an example of how this item can be used: you have a passage of eighth notes in 4/4 time over several measures, and you want to accent certain notes in the passage, which fall on the downbeat and on the “and” of 3. You would click on the first sixteenth-note in the group labelled “1” and the third sixteenth in the group labelled “3”. Enable the filter by clicking next to “Start”, and then use the Velocity command to increase the specified notes by 130%.

Another use for this filter would be if you only wanted to quantize notes occurring on beats, leaving the notes between beats to fend for themselves. Or the converse: make the rhythm a little more fluid by humanizing the beats
within the bar, but leaving the downbeat right on zero.

You can click on as many radio buttons as you want, even all of them. You can mix 1/4-beats and 1/3-beats freely, even within the same beat. Option-click to clear all sub-beats.

The text box in the “Start” line lets you specify an overall tolerance for the locations. If this box says “0”, then only data occurring precisely on the designated locations will be included in the operation. Numbers larger than 0 mean that the events can be a little “off”, either before or after the location by the specified number of clocks, and still be included. To decide what number to put in the window, it helps to keep in mind that a quarter-note is 240 clocks, therefore a sixteenth-note is 60 clocks, and a triplet eighth-note is 80 clocks. To keep everything in perspective, if you turn on all the sixteenth-note radio buttons and set the window to 40 (half the distance between two sixteenth-notes), all of the data in a measure will be included in the operation.

Keep in mind that this filter by itself does not actually quantize notes within the specified window, it merely makes them available to a Change operation.

The beat restrictions can be useful when working with non-note data as well. To help avoid MIDI “choke” on beats, when lots of things tend to happen at the same time, you can strip all Channel and Key Pressure within 5 clocks of every beat. Or, you can create a certain kind of expressive gesture by doubling (increasing by 200%) the modulation on only the fourth beat of every bar. You can create a percussive track out of a continuous sound by setting Controller #7 (MIDI Volume) to 127 on the first 16th-note of every beat, and setting it to 0 on the second 16th-note.

Combining filters

Remember that all of these filter parameters can be used together, so that you can specify (to use an absurd example) that an operation will only affect notes between C#5 and B7, if they are at least 40 clocks but no more than 600 clocks long, if they have a velocity between 62 and 90, if they were recorded on channel 12, and if they occur within 4 clocks of the third sixteenth-note of the second beat in measures divisible by 7! You will certainly come up with more
practical combinations.

Executing and Recalling the Change Filter

When you have finished setting up the parameters in the Change Filter, press Return or Click on OK to return you to the dialog box you came from (or, if you accessed the Filter from the Edit menu, to the main screen). When you get back to the dialog box, you will see the Filter has automatically been enabled. Set up the rest of the parameters in the dialog box, and click OK or press Return, and the Change is executed according to the dialog box parameters and the Change Filter restrictions.

Once the parameters in the Change Filter are set up, they stay that way until you specifically alter them (or Quit Master Tracks Pro). This is true even if you end up disabling the Change Filter or even Cancelling the operation from which you called up the Filter. You can save the Change Filter parameters as part of the Preferences file, so that the dialog box opens with the same parameters every time you boot the program.
The Windows menu provides access to any of the main Master Tracks Pro

operation and data windows. If a window is not currently on the screen, or if it is hidden behind other windows, you can open it, bring it to the front, and make it the active window either by choosing it from the Windows menu or using the appropriate command-key combination from the Macintosh keyboard. When a window is open, a check mark appears next to its name on the Windows menu. When it is the active window, its name appears in outline.

We have covered the action of most of the windows in previous chapters, but here they are again, for reference. Remember that only one of the MIDI Data windows (≈-4 through ≈-0) can be open at a time. Opening one while another is open will cause the new one to assume the size and position of the old one. Also remember that the current window sizes and positions can be saved using the Save Preferences command on the Edit menu.
The Main Windows

Track Editor

The Track Editor window allows you to see and name all the tracks in your sequence. It lets you choose which tracks to play, record, solo, and loop. You can enter MIDI channel assignments and initial MIDI program numbers and MIDI volume commands for each track in the sequence. The right half of the window provides a graphic display of the sequence in units of measures, and shows you where the end of the sequence falls. It allows you to select regions for editing or changing on a measure-by-measure basis. You can also place and display markers that allow you to quickly find specific places in a sequence.

Event List Editor

The Event List Editor window presents all the MIDI data on a track in alphabetic form for precise editing. It allows you to insert, delete, and alter individual events, as well as select regions for Edit and Change operations.

Step Editor

The Step Editor window lets you see and edit MIDI note data graphically. You can input, move, stretch, copy, and erase individual notes anywhere on the graph, and you can also edit note parameters numerically. You can record notes in step-entry mode, and you can select regions of notes for Edit and Change operations with a resolution of up to 1/240th of a quarter-note. In this window and all of the MIDI Data windows, you can place and display markers with sub-measure resolution, and name tracks.

The MIDI Data Windows

Please note that any of the following windows can have a transparent view of the Step Editor place on them. See Chapter 4 for more info.
PitchBend

The Pitch Bend window allows you to display and edit pitch bend data. You can enter, edit, and erase individual pitch bend events, and you can draw in consecutive events graphically. You can also select regions of pitch bend events for editing.

Channel Pressure

The Channel Pressure window lets you work with MIDI channel pressure data, also called “aftertouch”. Using a graph in the window, you can add, edit, and erase individual channel pressure events, and you can also draw them in consecutively on the graph. Regions of channel pressure events can be selected for editing operations as well.

Key Pressure

The Key Pressure window is the window for displaying and working with MIDI key pressure data, also called “polyphonic aftertouch”. You can enter, change, or erase key pressure events on the graph in the window, draw in consecutive events, or select regions of events for editing operations.

Modulation

The Modulation window lets you display and edit MIDI modulation data (Controller #1) which usually corresponds to the mod wheel on your synthesizer. The graph lets you input, edit, or erase modulation events, draw them in as a group, and select events in regions for editing operations.

Controllers

The Controllers window lets you enter and edit data for any MIDI controller, numbers 0 through 127. (Remember, Modulation is Controller #1, not #0.) Using the graph in the window, you can enter, edit, or erase individual controller events, draw them in consecutively, and select them in regions of editing operations. A list of standard MIDI Controller assignments appears in Appendix H at the end of this manual.
Velocity

The Velocity window lets you see and edit the velocity of any note. You can edit or erase individual velocities, and you can select them regionally for editing operations.

Other Windows

Tempo Map

The Tempo Map window shows in graphic form the time signature (meter), beat unit, and tempo of a sequence from moment to moment. You can insert, erase, and edit individual tempo changes, and select regions for editing.

The Big Counter

The Big Counter window allows you to see an enlarged view of the Measure/SMPTE counter.
The Songs Menu

*Master Tracks Pro* lets you open several sequence files at a time and move among them freely. It also lets you play all open files in any order you like, for live-performance situations. Create a “Song Set” containing a list of songs stored on disk that will load automatically, in order.

Using Multiple Songs

To open multiple sequences, or “Songs”, just go to the File menu and Open them. Each file will open and become the “current” sequence as soon as you open it. As you open each file, its name is added to the Songs menu, and you can view the entire list when you open that menu.

The current sequence — the one you can listen to and edit — is denoted on the menu by a check mark. If you want another sequence to become the current one, simply select it from the menu (you cannot do this while a sequence is playing, however, which is just as well). Sequences that are not current are still open, and if you want to store them on disk, they must be saved as individual files.

To close a sequence, you must first make it the current sequence, and then if you have made any changes in it since the last time it was saved, the program will ask if you want to save this latest version. When you Quit the program, if there are any open sequences which have undergone any changes since the last time you saved them, you will be asked if you want to save each of them, one at a time.
a time. (If you just want to shut everything down without saving, hold down the Option key when you click on “No” the first time you are asked if you want to save, and the rest of the files will close without asking.) The same thing will happen if you hold down the Option key while selecting “Close”.

The maximum number of songs that can be open at one time is 16. If they are particularly long, or if you are using a Macintosh with a small amount of memory (or you have allocated a small amount of RAM in MultiFinder), you may be limited to fewer than 16.

The Playlist

Besides helping you keep track of multiple open songs, the Songs menu lets you construct a “Playlist” for playing any number of sequences automatically, one after another, without selecting or loading them separately.

Choosing the “Song Playlist” command from the Songs menu opens up a window in which you can construct a Playlist from the currently open songs. You can arrange the songs in any order. If the order you see isn’t right, use the mouse to move any song into a different slot by clicking on the song name, holding the mouse button, dragging the song into the slot where you want it, and releasing. The other songs in the list will move aside to make room for the change.
You cannot insert a blank song into a Playlist slot, nor can you “double” a song on a Playlist — if you want to play a song twice, Save it under a different name (use Save As), then re-open the original version. Both versions will now be on the Playlist and you can arrange them as you wish.

The “Start” arrow lets you select a starting point for playing the Playlist. Click and drag it to move it. If you have some songs open that you don’t want to include on the Playlist, put them at the beginning of the list and move the Start arrow below them.

Once you’ve determined your song order and starting point, you can set up how the songs will flow into each other. You can have them go automatically, with a pause between them (for applause, of course) that can be anywhere from 0 to 999 seconds (for really thunderous ovations) long. Or, you can tell the program to wait before going on to the next song until it receives a MIDI message, or until you press a key on the Macintosh. The MIDI message can be any note or controller (like sustain pedal, portamento pedal, data switch, etc.) you designate. You can also wait for a signal before the first song in the list plays. Click Play (or hit the Space Bar) and then send the signal (Mac key or MIDI message) and the song will then play.

If you click on the radio button next to “Note”, you can specify which note will start the next song by typing in its name (use #’s for accidentals), or its MIDI number, or by playing it on your MIDI keyboard. If you click on the radio button next to “Controller”, you can type in the number of the controller command you want the program to wait for.

Note that this setting will be global for the entire Playlist — the program will always wait the specified number of seconds, or wait for the designated notes or controller, before proceeding to the next song, regardless of where in the Playlist it happens to be.

To get the Playlist started, click on Play in the Playlist window or press the Space Bar. To leave this window, click on Exit. The window will maintain the Playlist after you close it, unless you close any of the individual song files or open new ones. To stop the playback without leaving the window, click on Pause or Stop. If you clicked Pause, the song will start playing from where you left off when you click Play again or hit the Space Bar. If you clicked on Stop
the song will restart from the beginning when you hit the Space Bar or click Play. Click on Exit to stop play and leave the window.

**Saving and Loading the Playlist**

When a Playlist is constructed, you can save it to disk, just like any other file, using the Save Song Set command. The Song Set is just a list — it does not actually contain the sequences in it, which must be saved individually. When you load a Playlist from disk, using the Open Song Set command, all of the sequences on the list open automatically, in the correct order. For this to happen, however, *all of the sequences must be in the same folder on the desktop as the Song Set itself*. If any sequences are not in the folder, they will not load, and you will get an error message (other sequences which are in the folder will load, however).
The Layout Menu

The Layout Menu contains several commands that determine the appearance of data windows. These commands can influence your interaction with the program in important ways.

Show/Hide Grid

This command is a toggle that lets you switch between two versions of the Step Editor window grid. The grid always displays a dotted vertical line at each measure boundary, but you have two choices when it comes to the light horizontal lines that represent pitch: you can display a dotted horizontal line for every “white key,” or you can hide the full grid and display only the solid horizontal lines at octaves.

The octave grid gives an uncluttered screen, while the full grid provides more help in precise placement of notes. Which grid you use is a matter of convenience and personal style.

When the full grid is visible, you can switch to the octave grid by choosing Hide Grid on the Layout menu. Conversely, when the octave grid is on screen, you can switch to the full grid by choosing Show Grid.

9.4 Hide Grid (L) and Show Grid (R)

Show/Hide Markers

This is a toggle command that lets you display or remove the marker ruler from the Track Editor, Step Editor, and MIDI Data windows. Using markers and
the marker ruler is discussed in the chapters on the Track and Step Editor windows and in Chapters 10 and 11.

When the marker ruler is not visible, you can display it by choosing Show Markers on the Layout menu. To remove it, choose Hide Markers. This toggle is global for all windows: setting it in any window sets it for all of them. With markers hidden, the Data areas of the windows expand to show more data. Note that when they are hidden, the markers are still active: you can still Tab and Shift-Tab to them, and they will always appear in the Markers window.

This command interacts must be set to "Show Markers" in order to see the Position Indicator window (see below).

**Show/Hide Program Changes**

This is a toggle command that lets you display or remove the Program changes from the bottom of the Step Edit window.

**Show/Hide Velocity**

This is a toggle command that lets you display or remove the Velocity display at the beginning of notes in the Step Edit Window.

**Show SMPTE Time**

This is a toggle command that lets you display either SMPTE time or Measure/Beat/Clock time in relevant windows.

**Show/Hide Position Indicator**

This is a toggle command that lets you display or remove the Position Indicator in the Marker area of the Track Sheet. This display is only available if you also select "Show Markers".

**Follow Playback**

When the Follow Playback feature is active, the Track Editor, Step Editor, and MIDI Data windows scroll as the sequence plays, displaying a highlight to
indicate the beat or measure that is currently playing. With this feature off, these windows remain as you left them during sequence playback.

To activate the Follow Playback feature, choose it on the Layout menu. When the feature is active, a checkmark appears next to it on the menu. To deactivate Follow Playback, simply choose it again. The check mark will disappear.

When Follow Playback is deactivated, you can scroll to and examine any location in any window independently of the playback (measure counter) position. If you are editing a track while the sequence is playing, it is usually more convenient to have Follow Playback deactivated, so the window doesn’t jump around when you’re trying to select a region.

Multi-Track Record

This is a toggle command that lets you choose either normal recording or Multi-track recording. See Chapter 1 for more details.

Zoom In and Zoom Out

The Zoom commands let you choose how much data you see in the Step Editor and MIDI Data windows. To get the big picture on your sequence, use the Zoom Out command to place more measures on the window. For precise work, use the Zoom In command to show a smaller amount of the sequence at higher “magnification”. Six separate levels of zoom are available, so you can easily adjust the display to fit your needs.

The Zoom level set by the Zoom In and Zoom Out commands also determines the number of clocks displayed per pixel on the screen, and thus affects the resolution at which you can edit data in the Step Editor and MIDI data windows. (A pixel is the smallest dot on the Mac screen and the minimum distance interval you can move your mouse.)

If you zoom all the way in to the highest level of magnification, each pixel represents a single clock (1/240th of a quarter-note). This is the best level for precise work when you’re editing notes, pitch bend, or other MIDI data. When you zoom further out, the clock-per-pixel ratio increases, to a maximum of 24 clocks (1/10th of a quarter-note) per pixel.
The setting of the Zoom level can also affect how densely MIDI data will be placed in a track. For details, see the discussion of “Data Density and the Zoom Factor” in Chapter 4.

Note: if any measures in the current sequence use a smaller division of the measure than quarter-notes (e.g., if a time signature is 6/8, 5/16, etc.), then the widest “zoom out” level will not be available.
The Goodies menu contains a number of important features that greatly enhance *Master Tracks Pro’s* flexibility. Many of the program’s more advanced functions are accessed from this menu.

The first six entries open and close operational windows.

**Memory**

The Memory window helps you keep track of how much RAM the program is using at any one time. To open it, select this item from the menu. It will stay open until you close it.

It is possible, if you are working with several large sequences simultaneously, that *Master Tracks Pro* will run out of memory and will not be able to perform certain operations. This window can serve to warn you when this might happen. It shows how much memory is used by the current songs, how much is used by the Clipboard, and how much is still available in RAM for additional musical data — either the computer’s total memory, or, if you are running it under MultiFinder, the program’s allocated RAM.

If you encounter a memory shortage, there are several things you can do:
• Close any sequences you are not currently working on.

• Use the Strip Data or Thin Continuous Data functions to eliminate or thin out controller, pitch bend, and/or pressure data wherever possible.

• Clear the Clipboard by copying a blank measure. This frees up any memory in the Clipboard for use in the sequence.

• If you are running any DAs at the same time as Master Tracks Pro, close them.

• If you are running the program under MultiFinder, allocate more memory to Master Tracks Pro by doing the following:

  Quit the program, go to the Finder, click once on the Master Tracks Pro icon and type ≈-I, or pull down “Get Info” from the File menu. In the box labelled “Application memory size (K)”, type in a number that is about 200 greater than the number that appears there (initially, that number should be 1000). Close the “Info” box and re-start the program.

### The Tempo Window

The Tempo Window displays the current sequence tempo, meter, and beat. It also provides a scroll bar for making temporary changes to a sequence’s tempo. It is discussed in Chapter 1. Most of the time, this window will be open.

### Transport

The Transport window contains controls for operating the sequencer: Play, Stop, Pause, Record, Fast Forward, and Rewind. It also contains counters for showing the current start position for the sequencer, both in measures/beats/clocks and in hours/minutes/seconds/frames. In addition, it contains controls for setting various sequencer functions, including Punch-in and -out, audible click, audible count-off, auto-return of the sequence counter, MIDI Thru (echo) setting, and synchronization mode.
Using the Goodies Menus

You cannot “put away” the Transport window; however, it could end up being hidden behind another window, in which case selecting it from the Windows menu will bring it to the foreground. The Transport window is also the only window that you do not need to select before you can work in it. If another window is selected, such as Track Editor, there is no need to “de-select” it in order to operate the Transport controls.

This is not true of the Measure Counter, however — clicking in any of the counter fields will select the Transport window, bringing it to the foreground, and de-select any other windows.

10.4 The Transport Window

Markers

The Markers window shows all of the markers in a sequence in order, displaying each marker’s name, musical location (measure/beat/clock), and real-time location (hour/minute/second/frame). In this window markers can be added, deleted, re-positioned, and locked.

To change the location of a marker — either in real time or musical time — click on any number in either of the marker’s time fields, and type in a new number. You can move among the digits in the field by using the Tab key. When you enter any new numbers in the musical-time (“Measure”) column, the real-time (“Time”) column is automatically re-calculated, and vice versa. When the time is changed, if the marker is now out of order, it will automatically re-position itself on the list. To change the name of a marker, double-click on the name, and type in the new name. Press Return when you are done.

To delete a marker, single-click on the marker’s name and then click on the box marked “Delete” at the top of the window. To add a new marker, simply click
on the box marked “Add” and a new marker named “Marker n” \((n)\) will be added to the list, and it will be given the Measure and Time numbers of the last marker already on the list.

![Markers Window](image)

10.5 The Markers Window

You can lock and unlock markers from this window. Locked markers are useful for showing “fixed” points in a sequence, which might correspond to specific visual events or sound effects on a film. A locked marker will not immediately move when you perform any operation on the measure it is located in which affects the timing of the marker, such as a Conductor change, Fit Time, or Insert Measure. If you try, you will get a dialog box asking you whether the marker should stay where it is in real (i.e., SMPTE) time, or should move with the music. You can also specify at that time whether markers will always stay with time or move with music. Unlocked markers will always move with the music. See Chapter 11 for more on this.

To lock or unlock an individual marker, click in the column labelled “Lock” in the line for that marker. A little padlock icon will appear. To unlock, click on the padlock. To lock or unlock all of the markers on a list, click at the top of the window where it says “Lock All” or “Unlock All”.

Clicking in the center box at the top of the window opens the MIDI Setup dialog box, for setting the sequence’s synchronization mode and start time, among other parameters. More details later in this chapter.
The Markers window can stay open while other windows open and close. If it becomes hidden by other windows, select it from the Windows menu and it will come to the forefront.

Markers can be moved within any of the data windows while a sequence is playing, but they cannot be moved in the Markers window while a sequence is playing.

**Notepad**

The Notepad provides a convenient way of recording memos, track assignments, marker lists, and any other text data you might feel would be appropriate to accompany a sequence. The contents of the Notepad are saved with the sequence it is opened inside of, and they are automatically loaded into *Master Tracks Pro* whenever the sequence is opened, whether you actually open the Notepad or not.

The Notepad accepts text data like any Macintosh text processor. It is in fact very similar to the original Macintosh “Note Pad” desk accessory, except that each sequence file has its own Notepad, and *Master Tracks Pro*’s version puts all information on a single “page” of unlimited length. The Notepad window can be re-sized as large or as small as you like. Text in the window will be re-formatted to fit the current size, and the window size will be remembered when you close the Notepad and open it again.

The Notepad window has two functions in it: “Get track info” and “Get markers”. The first will bring the track information — track number, channel, initial program and volume, and name — into the Notepad, headed by the sequence name. The second will bring the list of all markers, including name,
musical time, and actual time, into the Notepad, again headed by the sequence name.

Once entered into the Notepad, text can be manipulated in all of the usual ways, using the mouse and the commands on the Edit menu. Text in a Notepad can also be imported from and exported to other Macintosh applications through the Macintosh Clipboard, using the Edit commands.

**Master Fader**

The Master Fader window is used to control the overall volume of selected tracks. See Chapter 1 for more info.

The rest of the items on the Goodies menu deal with various advanced features of Master Tracks Pro.

**Sysex**

Sysex is a feature that allows you to send and receive MIDI system exclusive data, such as synthesizer patches, to and from the MIDI devices in your system. You can store this data in files on disk, and then retrieve it at any time to send to your instrument. Since each instrument has a different system exclusive data format, you can only do “bulk dumps” with Master Tracks Pro — that is, you can store and send data as one continuous file, and the data cannot be edited.

*Note: Master Tracks Pro only supports system exclusive transfers to and from MIDI devices that do not require “handshaking”. Consult your owner’s manual to see if your particular device requires handshaking.*

To use the Sysex feature, choose Sysex on the Goodies menu. When you do, the System Exclusive dialog box appears.

**Receiving System Exclusive Data**

Before you can receive system exclusive messages from your synths or other MIDI devices, you’ll need to know how to send them from the devices. Con-
sult your owner’s manuals for instructions. When you’re ready to proceed, click on Receive in the System Exclusive dialog box. Then instruct the transmitting device to start sending. Master Tracks Pro will now record any system exclusive data it receives.

You can receive up to 512 separate system exclusive messages in one file. When you send the data back to the device later, it will be sent on the same channel it was received on. To assist you in recording multiple system exclusive messages in a single file, the program counts the number of messages it receives and displays the count. In addition, each time a new message is received, the program attempts to identify the System Exclusive ID byte sent with the message. If it is successful, it will display the manufacturer’s name in the memo field in the dialog box.

When you’ve finished sending the system exclusive data from the device(s) to Master Tracks Pro, click on Stop in the dialog to shut off the receiving process.

Now you need to store the system exclusive data. Begin by giving the file a name. Click on the Filename field and type in the name there. You can also place a memo about the data in the Memo box. To do so, click in the box or press Tab, and enter your memo.

When you’ve named the file and written the memo, click on Save. A File dialog box will pop up. The name in the Filename field here will default to the name you’ve given the file from within the System Exclusive box. You can keep that name or type in another one, and then save the system exclusive file as you would any other Macintosh file.

Sending System Exclusive Data

To send a system exclusive file to your MIDI device, the first thing you need to do is retrieve it from the disk. Select Sysex from the Goodies menu and click on
Open. This brings up a standard File dialog box. When you’ve located the desired file, open it.

Before you can successfully send a system exclusive file to a MIDI device, you must first get the device ready to receive it by following the appropriate steps listed in its owner’s manual. When you’re ready, click on Send in the System Exclusive dialog box. *Master Tracks Pro* will send the file in its entirety. Usually the receiving device will inform you about whether or not the transfer was successful.

When you’ve finished your system exclusive operations, click on Quit in the dialog box to return to the main program screen. If you have any data in the receive buffer that you haven’t saved to disk, the program will ask you if you want to save it.

**Loading and Sending Multiple Messages**

*Master Tracks Pro*’s Sysex feature remembers the MIDI Channel (also sometimes referred to as the “Device ID”) of each message it receives, and when it sends a system-exclusive file with multiple messages, each message will go out on the same channel it came in on. If you want to save all of the patches associated with a particular sequence, and each of your MIDI devices has a selectable Basic Send and Receive channel, set each device to a different channel and then dump their contents consecutively into a *Master Tracks Pro* Sysex file while the “Receive” button is highlighted in the Sysex dialog box. Then save all of this information as one file.

When you want to reload all your equipment with the patches for the sequence, just load the Sysex file and click on Send, and watch each of your MIDI devices receive its information in turn.

**Keyboard Setup**

One of *Master Tracks Pro*’s most useful features is the ability it gives you to operate all the sequencer transport controls, and to select durations in the Step Editor, using a MIDI keyboard, freeing you from the need to move back and forth between the Mac and your synth.
Selecting the Keyboard Setup command pops up a dialog box that lets you configure *Master Tracks Pro* for MIDI keyboard control of these functions. When you’ve made your configuration settings, click on OK to enter them and return to the program, or click on Cancel to return without entering the changes. Your MIDI keyboard setup can be stored using the Preferences command from the File menu.

The options for transport control are at the left side of the Keyboard command dialog box. To assign a function to a MIDI key, click in the box to the left of the function name and an “X” will appear. Then click on the text box to the right of the function name, and immediately play the key to which you want to assign that function. (Alternatively, you can type in the pitch letter name and octave number [use #’s for accidentals], or the MIDI Pitch number [0-127].) You can de-activate any individual command by clicking in its box and removing the “X”.

Being able to activate the functions individually allows you to use only the ones you really need, leaving you more keys to play. You can assign the same key to Play and Stop or to Record and Stop, and the program will toggle between the two functions when you play that key. When you are recording a sequence, the keys that you assign to Record, Stop, and Pause will not be recorded.

Now to activate the assignments you’ve made, click on the small box next to “Use in Transport”. An “X” in the box means that keyboard transport control is now active. You can turn it off again at any time, without disturbing the settings, by clicking on the box again.

In Chapter 3, we described how to perform Step-Entry recording in the Step Edit window. The Keyboard dialog box allows you to change Step-Entry durations from the MIDI keyboard itself, by assigning each duration to a specific MIDI key (which you then cannot use for note entry). As with the transport controls, each duration can be assigned a MIDI key by clicking on the box to the left of the duration icon until it displays an “X”, then clicking on the text box to the right of the icon, and playing the desired MIDI note from the
keyboard, or else typing in the note’s name or number. In addition to the standard durations, you can also assign a key to:

- a rhythmic “dot”, which increases the most recently-set duration by 50%,
- a rest,
- the “backspace” (or delete) key, which erases the last note entered, and
- the “tuplet” toggle, although the nature of the tuplet still has to be set on the screen.

You can assign as many, or as few, of the durations and functions as you like.

To enable the Step-Entry keyboard input function, click on the box next to “Use in Step Input”. An “X” will appear in the box indicating that keyboard control of note durations is now active. You can turn it off again by clicking on the box once more.

You can use both the Step-Entry and the Transport keyboard controls at the same time. The program will prevent you from assigning the same MIDI key to two different functions within the same set of controls (except as noted above).

**MIDI Setup**

The MIDI Setup dialog box lets you choose which software Ports (A and B) are connected with which Macintosh ports (modem and printer) or connection to the Apple MIDI Manager. It also lets you choose what mode of synchronization to use when running the sequencer, and how to respond to synchronization information. Choosing “MIDI Setup” opens a window with a number of radio buttons and parameter boxes. The window can also be opened from the Markers window, by double-clicking on the numerical display (the sequence Start Time) at the top in the center of the window. MIDI Setup parameters are stored in the Preferences file.

*Master Tracks Pro* will automatically sense the presence of a multi-port interface such as the MOTU MIDI Time Piece. Please refer to the MTP manual for more information on multi-port use.

The rest of this section deals with *Master Tracks Pro’s* internal MIDI Drivers.
Assigning Playback Ports

As discussed in the section on setting channels in Chapter 1, *Master Tracks Pro* will assign a track to play back on a channel on either of two software Ports (referred to below with an upper-case “P”), A and B. This gives the program effective control over 32 MIDI channels (or more depending on the interface), as each Port can address 16 MIDI channels. You can take advantage of this feature if you have two MIDI interfaces, one connected to each physical (hardware) port (lower-case “p”) on the Macintosh — the modem port and the printer port. (A track’s playback setting will also affect how data is recorded on it in the Multi-Track Record mode — although this does not apply to normal recording.)

The MIDI Setup window lets you decide which software Ports will be assigned to which physical ports. You can assign both software Ports to a single physical port, or to different ports. (You cannot connect a software Port to both physical ports.) If you want to take advantage of the program’s 32-channel capability, you will assign them to different ports. To set up the assignment, click on the radio button for each software Port that assigns it to the physical port of your choice. If you are using only a single MIDI interface, then you should assign everything to just one port.

Assigning the Record Port

In normal record mode, *Master Tracks Pro* only allows you to input MIDI data on either physical port. Use the next row of radio buttons to choose the physical port to which your main MIDI controller will be connected.
Assigning the Synchronization Port

*Master Tracks Pro* can record or play a sequence based on the computer’s own internal clock, or locked to incoming MIDI synchronization signals. When you are using the sequencer with an external synchronizer, the information from the synchronizer has to come in through a cable connected to a physical port — the next row of radio buttons lets you choose which port to use for this purpose.

It is generally a good idea to keep incoming data for recording and incoming synchronization data separate, so whichever port you select for recording, you should select the other for synchronization (unless you only have one interface, in which case you will have to merge the incoming data).

When you are using MIDI Time Code synchronization (selected elsewhere in this window), the program forces you to keep those signals separate: synchronization information will only appear at the printer port, and you will only be able to record from the modem port. Therefore, you cannot use MIDI Time Code sync and record MIDI data at the same time with a single MIDI interface.

Transmitting Sync Commands

*Master Tracks Pro* lets you transmit MIDI synchronization commands (start, stop, continue, Song Position Pointer, and clocks) whenever you play or record a sequence. These commands can be used to control a drum machine or another sequencer, or they can be converted into audio (FSK) signals which can be recorded on tape. Recorded FSK signals can then be used later on to synchronize the sequencer to the tape.

You can tell *Master Tracks Pro* to send MIDI sync commands out the modem port, printer port, both ports, or neither. MIDI sync can be sent even when the sequencer is itself being synchronized to an external timing device.

If you have no need to send MIDI sync, you should probably turn it off of both ports. It uses up a fair amount of the MIDI data stream’s bandwidth, and can cause or exaggerate some timing problems under extreme conditions.
A set of radio buttons on the left side of the screen selects the type of synchronization that the program will use when it records and plays sequences. “Internal” means the program will play from the computer’s internal clock, and all transport commands (start, stop, rewind, etc.) will be handled by the computer.

“External” means that the program will accept MIDI start, stop, continue, clocks, and Song Position Pointer commands. These commands are generated by other sequencers, drum machines, and tape-to-MIDI convertors such as the MIDI Time Piece, Roland SBX-80 or the J.L. Cooper PPS-1 (in “FSK” mode). When the program is in “External” mode, the tempo, as well as the play, stop, and continue functions, and often the rewind and fast-forward functions as well, are under the control of the external device, although the Record function is toggled from the program.

“MIDI Time Code (P)” means that the program will read MIDI Time Code data, as generated by devices such as the MIDI Time Piece or the J.L. Cooper PPS-1 (in “MTC” mode). When the program is in “MIDI Time Code” mode, the Tempo Map of the sequence is still active (although the overall tempo of the sequence will change if the speed of the incoming MIDI Time Code data changes). The play, stop, continue, and rewind and fast-forward functions will all be under external control, although the Record function is toggled from the program.

Note: The “(P)” is a reminder that MIDI Time Code will only be read by the program if it appears at the Printer port.

If these three choices seem familiar, it’s because they are exactly the same as the choices provided when you toggle the “Sync” box on the Transport window, discussed in Chapter 1.

To the right of these buttons are four buttons for setting the type of SMPTE-derived MIDI Time Code that the program will respond to. (This setting makes no difference when using Internal or External sync — only MIDI Time Code.) The choices are 24 frames per second (film), 25 frames per second (European television), 30 frames per second “non-drop” (North American
television), and 30 frames per second “drop frame” (also North American television). The type of SMPTE timecode that has been recorded on the audio or video tape you are synchronizing the sequence to will determine this selection.

See the next chapter for more information on using external synchronization.

**Start Time**

These parameter boxes let you set a starting time (also known as a “synchronization offset”) for the sequence when you are synchronizing the program to MIDI Time Code. It is rare that you will want a musical sequence to start right at the point on a tape where the SMPTE timecode reads zero — more likely it will read something like 1 hour, 12 minutes, 35 seconds, 14 frames. This feature allows you to determine at exactly what SMPTE time on the tape (as transmitted over MIDI Time Code) Master Tracks Pro will start to play its sequence. You enter the time by typing in the hour, minute, second, and frame number of the starting point. Point and click on each field separately, or use the Tab key to move among them.

The numbers you enter here will become the “Start Time” for the sequence even if you are not using MIDI Time Code synchronization (although it will have no effect on the actual playing of the sequence in Internal or External sync modes). When the measure counter is at 01:01:000, the “Current Time” indicator below it will show this Start Time, and as you play or move about the sequence, this figure will be added to the actual length of the sequence in the Current Time indicator. In addition, the Start Time will appear in the window at the top center of the Markers window, and the “time” fields of all the markers in the window will have this value added to them.

Besides being saved in the Preferences file, the Start Time is also saved with the sequence file when you save it, and will appear automatically when you re-open it.

**SMPTE Dropout Parameter**

When playing or recording a sequence to SMPTE-derived MIDI Time Code, it is always possible that there will be a dropout on the SMPTE track on the
master tape, causing the MIDI Time Code stream to be interrupted. Normally, this would cause a sequencer to stop. *Master Tracks Pro*, however, lets you overcome tape dropouts by letting the sequencer continue to play for a certain period of time without incoming MIDI Time Code. During that interval, hopefully the SMPTE track will re-appear, and the MIDI Time Code will resume, and you’ll never hear the difference.

Setting this parameter to 0 means that the program will stop immediately when the MIDI Time Code stops. Setting it to 1 means that the program will tolerate a one-second dropout of the time code before it stops, and setting it to 2 means that there can be a two-second dropout. (Setting it to 1 or 2 also means that the sequencer will continue for that many seconds after you stop the tape, which is a small price to pay for dropout-proofing.) During the one or two seconds of un-synchronized play (also known as “flywheeling”), the sequencer will run at the tempo it was running at just before the drop-out (by reverting to internal clock), thereby avoiding any sudden jumps in speed.

Again, this setting has no effect when using Internal or External sync.

**Click Setup**

The Click and Count features (turned on from the Transport window — see Chapter 1) can use either the Macintosh’s internal speaker or an external MIDI device to sound the metronome beat. This command lets you make that choice, and determine exactly what outgoing MIDI data will serve as the metronome.

Choose this item from the menu, and a dialog box opens. At the top are two radio buttons. Choosing “Internal” means the metronome will sound at the Macintosh speaker (and at the computer’s audio output, from which it can be amplified). The volume can be set from the Macintosh “Control Panel” desk accessory.
Choosing “MIDI” means the metronome will be generated as MIDI notes. The boxes immediately below let you determine what notes they will be. The first row, “Bar click”, determines what will happen on the downbeat of each measure (remember, time signatures and beat settings can change throughout a sequence, and the metronome click will follow those time signature and beat changes faithfully). The next row, “Beat click”, determines what happens on each of the other beats in the measure.

You get to choose the Port (A or B), MIDI channel, MIDI note, note-on velocity, and duration for each type of click. The duration is in arbitrary values from 1 to 8; 1 is equal to about 10 milliseconds, and 8 about 120 milliseconds. Most drum machines don’t respond to note durations (they just sound when they receive a note-on), so you may not have to worry about this parameter.

Note: you can also access this window by double-clicking in the “Click” box in the Transport window.

Chase Controllers

When you are editing a complex sequence, you often need to jump around to different parts of the sequence to listen to particular passages. When you stop a sequence at one point, and then start at another, it can happen that your synthesizers are set to the wrong program numbers. That’s because there may be a program change in the sequence that hasn’t been played because you skipped over that section. Or, a program change was executed in a track and then you jumped back to a point before it was supposed to occur, but your synthesizer is still set to the later program.

The same thing can happen with controllers and other continuous data. If you are in the middle of a
big pitch bend sweep and you stop the sequence and move to somewhere else, your synthesizer is left with the pitch bend still engaged, and it will be way out of tune when you next start the sequence. If you do a volume (controller #7) fade at the end of a sequence, and then re-start the sequence earlier, the synthesizer will still be faded down, and you won’t hear anything!

_Master Tracks Pro_ overcomes this problem with its “Chase” feature. When the program is “chasing”, it means that if you start a sequence in the middle, the program will look backwards over the entire sequence, to determine whether there are any program changes, controller changes, pitch bends, and/or aftertouch commands on each track prior to your starting point. (This includes the initial program changes and volume settings in the Track Editor window.) If there are, then before the sequence starts to play, the program will send out the most recent changes and commands on each track, thereby setting all of the synthesizers to their proper state.

The program is intelligent enough to know the difference between, for example, controller #6 and controller #8 commands, and if it finds great gobs of both of these on a track, it will only send out one — the latest — of each.

The Chase Controllers command opens a dialog box that lets you turn on the chasing function, and also lets you determine what data the program will chase and what data it will ignore. The check box at the top turns on and off the function. An “X” in it means the program will chase the designated commands.

Each type of command then gets its own check box — an “X” means the program will chase that type: Pitch Bend, Program Changes, Channel Pressure, Key Pressure, and Controllers. The “Controllers” parameter can be refined further: three radio buttons let you chase all controllers, only certain controllers (you get to choose up to four by typing their numbers into the boxes), or all controllers except certain controllers (again, choose up to four).

Generally speaking, this feature will be used with every box enabled, and “all controllers” chosen. The program doesn’t run any faster if you do only partial chasing, but the options are there if you find you have a use for them.
As it is recording a track, *Master Tracks Pro* can selectively record only the MIDI data you wish, filtering out any data that you don’t want to record. Choose the Record Filter command on the Goodies menu to bring up a dialog box that lets you choose which combination of MIDI data types will get recorded. The Record Filter is similar to the Strip Data command on the Change menu, except that it gets rid of the data before it gets into the sequence.

With this feature you can independently accept or reject each MIDI data type: pitch bend, channel pressure, key pressure, modulation, program changes, notes, and MIDI controllers (*all* of them). For example, you may want to conserve memory by filtering out aftertouch, which some keyboards generate continuously. You can also have the program recognize data on only one MIDI channel, rejecting other channels, and you can have it quantize the notes as you record.

Each type of MIDI data has a check box next to it. An “X” in the box means that data will be accepted when a track is recorded. If there is no “X”, that type of data will be rejected. Data on all channels will be recorded unless the “Only on channel” box is checked. When this is checked, type the number (1-16) of the channel whose data you want to accept into the box immediately to the right, and data on all other channels will be ignored.

The quantization function works similarly to the Quantize command on the Change menu (see Chapter 7), although it is somewhat simplified. You can select a quantization factor using the duration icons or by typing in clock numbers, or by setting up a “tuplet”. You can specify how far ahead or behind the beat notes must be to get quantized one direction or another — the default setting of 35% means notes 35% or less ahead of the beat will be moved to the next beat, while notes more than 35% ahead will be moved to the previous one.
This chapter will explain some of the more advanced uses of Master Tracks Pro. At the end of the chapter are answers to a few common questions that will crop up when using Master Tracks Pro.

Using Loops

Individual tracks can be looped during playback. This feature is especially useful with short repeating sections such as bass or drum parts. Loops encourage speed and spontaneity in music-making and also save memory. Use them to work out your ideas.

To take advantage of this feature, record the part you want to loop once, and then edit if necessary. Trim the loop using the Cut command (not Clear) to get the proper number of measures to loop — a track ends where there are no more filled or hollow measures present on the track in the Track Editor window (even if it’s not the end of the sequence — which is indicated by the grey vertical bar). Turn on the track’s loop control and let the part play back. Lay down other parts or even other loops against it by recording on other tracks.

Remember that the loop is only stored in memory once, and always starts at the beginning of the sequence. You can start the sequence in the middle, and the looped track will start and then loop when it reaches the end, but if you start playback past the point where the looped track ends, the track will not playback at all. A track cannot start to loop in the middle of a sequence; if a track starts at measure 6 and is set to loop, then each time around you will first hear five measures of silence, because the loop will include the first five (empty) bars.
Once your song or song section is complete, you should copy and paste the looped part into the track so that it fills out to the end of the sequence. This will give you the flexibility of *Master Tracks Pro*’s song structure, and it will also let you create subtle variations in the loop each time it plays using the Change menu or other regional editing commands. Once you have copied your looped part you can append as many copies of it as you like by repeatedly selecting Paste (≈-V) or Mix Data (≈-M). The insert point automatically moves to the end of each paste.

*Master Tracks Pro*’s loop feature requires you to loop to the nearest measure but if your phrase ends in the middle of a measure and you want to loop it anyway, this can be accomplished by re-barring the last measure of the track. Let’s say you’re working in 4/4 time but you want the track to loop a two-and-a-half-bar phrase. Select measure 3 (which should be the last bar of the track) and choose Conductor from the Change Menu. Click in the circle next to Set Meter and set the meter to 2/4 time. Measure 3 will now become a 2/4 measure, and measure 4 can be Cut from the track. Your track will now loop where you want it to.

### Re-barring

Except when you are working with odd-length loops, time signatures and placement of measure boundaries within a *Master Tracks Pro* sequence are normally a matter of convenience for editing, and have no effect on the way the music is actually played. However, it can be helpful to keep them in mind if you are planning to use a sequence generated with *Master Tracks Pro* in a music-notation program that reads MIDI Files, such as Passport’s Encore™. Changing bar lines within *Master Tracks Pro* may be easier than doing so in a notation program, so you might want to make sure all your time signatures and bar lines are correctly lined up before exporting the MIDI File.

### Working with the Tempo Map

The Tempo Map is the timing basis of any sequence. It is accessed in the Tempo Map window (≈-0), and can also be changed using the Conductor command on the Change menu.
11.1 The Effect of Fit Time on the Tempo Map
The resolution of the tempo map is the same as any other data window — 240 clocks per quarter-note — and you can place tempo changes on any clock. (Meter and beat changes, for obvious reasons, can only occur on measure boundaries.)

**Placing and Erasing Tempo Changes**

You can place tempo changes by selecting the pencil icon from the window’s Toolbar (or pressing P on your Mac’s keyboard), then moving the crosshair pointer to the location and tempo value you want, and clicking the mouse. You can erase a tempo change by selecting the eraser icon (or pressing “E” on the Macintosh keyboard), and moving the crosshair-in-a-circle pointer to the exact spot at which the change occurs, and clicking. You have to be right on top of a tempo change to erase it — if you are at all off, nothing will happen. Zoom In if you have trouble.

There is always a tempo setting at the beginning of every measure. This tempo setting can be changed (by inserting a different tempo), but it cannot be erased. If you insert a tempo change in the middle of a measure, it is only effective until the next tempo change — which will be at the next measure boundary (if not sooner). If you want to change the tempo of a sequence from a point in the middle of the sequence all the way through to the end, use the Conductor command from the Change menu, and set the new tempo for all of the measures in question. You can then go into the Tempo Map window and make the other tempo changes earlier, if you like.

For example, say you are going along at 120 bpm and you want to change the tempo right in the middle of measure 6 to 180 bpm, and keep it there until the end of the sequence at measure 20. First, open the Conductor command dialog box, select measures 7 through 20 and “Set all tempos” to 180. Then go into the Tempo Map window, select the pencil, and put the cursor on beat 3 of measure 6, at a value of 180, and click.

**Using the Conductor Command**

When you use the Conductor command to put a new tempo into one or more measures of a sequence, normally the tempo setting will appear only at the
beginning of every measure. If you use any of the “Change over time” commands, however, then tempo changes will occur on every beat. If you have multiple tempo changes inside one or more measures and you use the Conductor command on those measures, the original tempo changes will be erased and new ones — either on the measure boundaries or on the beats — will be inserted.

This rule does not apply if you use the “Add” feature or either of the “change by percent” features on the measures in question. In these cases, all of the tempo changes will remain where they are, but their values will change up or down.

The Fit Time command works the same way as the “change by percent” feature: it will perform its calculations on existing tempo changes — on measure boundaries, on beats, or between beats — and leave them in place, just changing their values proportionately so that the overall time of the selected region is what you specify. The Fit Time command may, however, add additional tempo changes, either at the beginning of the region selected, or on beats within the region.

*Master Tracks Pro* calculates tempos in whole numbers of beats per minute. If you import a sequence or tempo map from another source, any fractional or decimal tempo values will be rounded off to the nearest whole number. It may also happen that when you specify a Fit Time or other operation that would result in a fractional tempo, the program will alternate between two whole-number tempos over the region to achieve the desired result.

**Working with External Synchronization**

*Master Tracks Pro* generates its own time base from the Macintosh’s highly accurate internal clock when sync is set to “Internal” in MIDI Setup (or “Int” on the Transport window). When “Transmit Sync” is on, it will send out MIDI timing messages, including Song Position Pointer, Start, Continue, MIDI clocks, and Stop, corresponding to the Transport window activity. For example, whenever you move the Transport to a new location in the sequence, a corresponding MIDI Song Position Pointer message is sent out. This can be used to control drum machines or other sequencers.
MIDI ("Ext") sync

If Sync is set to “Ext” in the MIDI Setup, the program accepts a time base reference from an external MIDI source, in the form of MIDI “Clocks”. The source can be another sequencer, a MIDI drum machine, a tape-sync-to-MIDI convertor such as the MIDI Time Piece, or a SMPTE-to-MIDI convertor such as the Roland SBX-80 or Fostex 4050. Connect the MIDI output of the convertor to the input of the Macintosh’s MIDI interface. Go to the MIDI Setup dialog box (from the Goodies menu) and set the “Receive Sync on Port” radio button to the hardware port (modem or printer) that the MIDI interface receiving the MIDI sync is connected to — a typical setup might have the Master Keyboard/Controller connected to the modem port and the external sync box connected to the printer port.

MIDI clocks only occur 24 times per quarter-note, so Master Tracks Pro will interpolate its 240 clocks per quarter-note from the incoming MIDI Clocks.

The Play, Stop, and locating functions of Master Tracks Pro will now be taken over by the external MIDI source. When the program receives a Song Position Pointer command, followed by a string of Clocks, the measure counter will automatically locate to that point and the sequence will start to play. When the Clocks stop, the program stops. (If the synchronizer does not send Song Position Pointer, you will have to reset the external source back to the beginning of the song each time you start, and set Master Tracks Pro’s measure counter to 0 as well, or else each device will have no way of knowing where the other is.)

If you want to Record or Punch a track, stop the tape, set up the Record and/or Punch parameters (enable tracks, set In and Out times, etc.), and click on Record before you start the external MIDI source.

You can edit any data while the sequence is running while synched to MIDI Clocks, except Conductor and Tempo Map data. If you want to hear what an edit sounds like without running the external source, you can take Master Tracks Pro out of Ext Sync mode and put it in Int Sync mode, and then put it back into Ext Sync mode when you want to run it with external timing again. (The sequencer must be stopped every time you change the synchronization mode.)
When synced to MIDI Clocks and Song Position Pointers, all tempo and meter changes are under the control of the external synchronizer, and the Tempo Map in the sequence is ignored. If you have tempo changes in a sequence you want to preserve, you have to enter them into the synchronizer — consult the synchronizer’s manual for the best way to do this. Some synchronizers have a “learn” function which allows them to record a tempo map as it comes into them. To use this function, connect a MIDI cable between the Macintosh interface’s output and the synchronizer’s input. Set Master Tracks Pro on Int Sync, and turn “Transmit sync” on. Set the synchronizer to record the incoming tempo information, and then start the sequencer. Again, see the synchronizer’s manual for more instructions.

MIDI Time Code (“MTC”) sync

MIDI Time Code (MTC) is an addition to the MIDI specification that allows direct synchronization of MIDI devices, like sequencers, to SMPTE timecode without first converting it into MIDI Clocks and Song Position Pointer commands.

SMPTE timecode is the standard form of synchronization in recording studios, video production studios, and audio-for-video post-production facilities. It is an audio signal that can be recorded on tape, and it serves two functions: to tell the world how fast the machine is going, and where on the reel of audio or video-tape it is at any moment. This information is used to synchronize machines to each other, and to automate editing, among many other tasks.

Each spot on the tape has a unique timecode number based on the location’s elapsed time: hour, minute, second, and frame. The number of frames in a second is determined by the timecode format. There are four formats in current use: 24 frames per second (standard for film), 25 frames per second (European television), 30 frames per second “non-drop” (North American television), and 30 frames per second “drop frame” (also North American television, with certain frames left out to make up for timing discrepancies inherent in the medium).

SMPTE timecode cannot be run through a MIDI cable, because it goes too fast and is electrically incompatible. But there are devices that can convert SMPTE into MIDI Time Code, which is a series of MIDI commands that convey to a
MIDI-reading device the same information as SMPTE timecode: where am I, and how fast am I going. This way MIDI sequencers and other time-dependent devices can be part of a professional SMPTE-based system.

One of the major advantages of using MIDI Time Code with a sequencer is that MIDI Time Code is tempo-independent, unlike MIDI Clocks and Song Position Pointers. When you use a conventional SMPTE-to-MIDI Clocks-and-Pointers convertor, all of the tempo information has to be entered into the convertor, which is often a difficult and tedious process, and editing tempos all has to be done by hand. The convertor then sends out actual tempo information, and the sequencer follows. Furthermore, many such convertors, once you have created a tempo map inside them, do not allow that tempo map to be stored, and if you want to use the convertor for different pieces of music, then every time you do a new piece, you have to reconstruct the tempo map all over again.

MIDI timecode, on the other hand, sends no tempo information, just a steady stream of data based on the speed of the SMPTE timecode it is derived from — that is, the speed of the tape. A sequencer reading MTC uses that stream as a time base to generate its own tempos. For a program that allows complex tempo changes like Master Tracks Pro, this means that all tempo changes can be manipulated freely within the sequencer. Furthermore, a Tempo Map created within a sequence is automatically stored as part of that sequence, and is loaded back in when the sequence is loaded in.

Plainly, Master Tracks Pro’s advanced tempo-editing functions — the change-over-time features of the Conductor command, the Fit Time command, the editing capabilities of the Tempo Map window — are of little use when the sequencer’s tempo is being determined by an outside source. All of these features, however, are usable when the program is reading MIDI Time Code.

To use MIDI Time Code with Master Tracks Pro, start by running an audio cable from the SMPTE output of your audio or videotape deck to the “SMPTE In” jack of your SMPTE-to-MTC convertor. Then run the MIDI output of the convertor to the interface connected to the Mac’s printer port. Remember that when using MIDI Time Code, you must use the Printer port to read the sync signal, and you can only record incoming MIDI data on the modem port. Set the MIDI Setup dialog box to receive MTC, or toggle the “Sync” box in the
Transport window until it reads “MTC Sync”.

Now you must determine a starting time for the beginning of the sequence. If you are using a videotape with “burned-in” timecode (numbers that appear in a little window on the screen), you can determine the hour, minute, second, and frame number of the point in the tape at which you want the music to begin. Open the MIDI Setup dialog box and type these numbers in where it says “Start Time”.

While you’re at it, click on the radio button corresponding to the SMPTE format on the tape you are using — this is very important. You can also set the SMPTE dropout time. Start with it at 0 — if you run into trouble, you can always reset it later.

If the videotape does not have burned-in SMPTE (or you’re syncing to audio tape), you can find out the SMPTE location of your starting point by running the tape, and looking at the “Current Time” indicator on the program’s Transport window. If the program is receiving MIDI Time Code, this indicator should show the absolute time of the incoming code, whether the sequencer is running or not. Stop the tape right at the point where you want the sequence to start, and look at the Current Time indicator. Enter that time as the Start Time in the MIDI Setup window. This method is not quite as accurate as using burned-in SMPTE, but it will usually be satisfactory. You can always make adjustments later, if necessary.

The Play, Stop, and locating functions of Master Tracks Pro will now be taken over by the external tape recorder. When the program receives a MIDI Time Code number of a frame that corresponds to any point within the sequence, it will automatically locate to that point and start to play. If it receives an MTC number that is before the sequence’s starting point or after its end, it will display the number in the “Current Time” indicator, but otherwise will do nothing.

If you want to Record or Punch a track, stop the tape, set up the Record and/or Punch parameters (enabling tracks, setting In and Out times), and click on Record before you start the tape. You can edit any data while the sequence is running synched to MIDI Time Code, except Conductor and Tempo Map data. You can edit Conductor and Tempo data when the sequencer is stopped.
Using the Fit Time command to make a musical cue fit precisely into a visual sequence on a videotape is one of the more exciting uses of Master Tracks Pro’s MTC capability: use the burned-in SMPTE to determine the starting point of the visual sequence and exactly how long it is (subtract the starting time from the time at the end), then set Master Tracks Pro’s Start time to the visual’s start time, select the region comprising the musical cue, choose Fit Time, and type in the length.

If you want to hear what an edit sounds like without running tape, you can take Master Tracks Pro out of MTC Sync mode and put it in Int Sync mode. Put it back into MTC Sync mode when you want to run it with tape again. (The sequencer must be stopped whenever you change synchronization mode.)

Locked markers

Whenever you do any changes in a Tempo Map, whether directly in the window or using the Conductor command, if there are markers in the affected area, they will stay at the measure, beat, and clock where you set them. This is not true, however, if you have locked them in the Markers window.

Locked markers are useful in a situation using external synchronization, as they can be used to mark not just musical cues, but also visual events, sound effects, or other cues.

When you change the timing on a section with locked markers, you will get a dialog box warning you of the situation. You then have a choice: you can move the markers with the music, as if they weren’t locked, in which case their Measure numbers will stay the same but their Time numbers will change (this would be appropriate if the marker is a musical one called, for example, “horn theme”); or you can keep the markers with time, in which case their Time numbers will stay the same but their Measure numbers will change (for example, “big flash”).

You can also tell the program not to show you this box every time you try to move a locked marker by clicking on one of the “Always” buttons. If you are working primarily with markers that are real-time based, click “Always stay with time”. If the markers are primarily music-based, click “Always move with
music”. To clear the “always” status and get this dialog box back, open the Markers window and click on “Lock all” or “Unlock All”.

### Printing the screen

You can save a picture of the screen in PICT format from within *Master Tracks Pro*, and also print the screen on a printer connected to the Printer port (assuming you don’t have a MIDI interface there). This is a feature that lets you easily document your compositions, default settings and other dialog box settings.

Save the screen by pressing ≈-Shift-3. The first picture will appear on the desktop at the “root” level (not in any folder) as “Screen 0”. Subsequent attempts will show up as “Screen 1”, “Screen 2”, thru “Screen 9”. You can only save up to ten screens (saving more will erase the first ones).

You can Print the screen without saving it to disk by pressing ≈-Shift-4.

### I’ve Got A Question

Here are answers to a few common questions about *Master Tracks Pro*.

**I click Play, but there’s no sound.**

If the sequencer is not running (the Measure Counter isn’t changing), check to see that the Sync box is set to “INT Sync”. If it isn’t, the program will wait to receive external timing signals before it plays.

Also make sure that “Count In” is not enabled — if it is, you will have to wait a measure’s worth of beats before starting, and you may not be hearing this count-off if the Count is assigned to a MIDI channel (in the Click Setup dialog box) that is not being received by any device in your system.

If the sequencer is running, it may be that no tracks are play-enabled. Make sure the “P” column on the Track Editor contains a black triangle on those tracks you want to hear, and that you haven’t “Solo”-ed a track that has no data where you happen to be playing. Also check your MIDI cables and interface, and the port assignments in the MIDI Setup dialog box.
Finally, make sure that you haven’t inadvertently turned down all of your synthesizers by sending them MIDI Volume (Controller #7) “0” commands at the end of a sequence, and then not sending an initial volume command at the beginning when you start it again.

I record-enabled a track, then went into step-time entry, and the information is on the wrong track.

The record-enable function and the step-time entry function are independent of each other. Step-time entry will occur on whichever track is showing in the Current Track box in the Step Editor window. Step-time entry is non-destructive — i.e., if there is data already on a track, it will not be erased when more data is entered over it.

The notes coming out of my synthesizer sound “phasey” when I play it. Or I have a 16-voice synthesizer but it only seems to be playing eight notes.

You may be getting “doubled” notes caused by Master Tracks Pro echoing MIDI data back to a synthesizer which is itself being played from a keyboard. This is because you have the “Local Control” switched on — meaning that the synthesizer is being controlled by its own keyboard — plus the program is taking all the incoming data and routing it through the “Thru” function and sending it back out again a millisecond or two later. Correct the situation either by switching Local Control off (consult your synthesizer’s manual) or turning off the Thru function in the Transport window.

I have data in the Clipboard, but I can’t seem to Paste it into my sequence.

First, make sure you have selected a single point to Paste (or Mix Data) from, not a region. Master Tracks Pro will not Paste data into a region. Second, make sure the type of data you are trying to Paste is the same as the window you are trying to Paste into. You can only move data from one window to an identical window — the exception being that you can move data from the Track Editor to the Step Editor, one track at a time.

I put the cursor in a measure in the middle of my sequence to do some editing, but then every time I click Play, it jumps back to the beginning, or somewhere else in the sequence.
The “Auto” function in the Transport window is on. This means that the cursor will go back to the previous starting point each time you click on Play or Record. You can reset the cursor by typing a new measure, beat, and/or clock value into the Measure Counter (click on it or else type “.”), or by turning off the Auto function and moving the cursor.

Let us hear from you.

You can play a part in the evolution of *Master Tracks Pro*. We are always extremely interested in your feedback on the program and your suggestions for further enhancements. The current version of *Master Tracks Pro* is the result of suggestions and comments from thousands of users just like you. Let us know what you want to see next and we will try to implement your ideas.

Remember, you have not just purchased a disk and a couple of hundred printed pages — you have invested in the expertise and experience of all the people involved in the *Master Tracks Pro* project, both within Passport Designs, and among the ranks of the program’s users. Thank you for your support.
Before you can use Master Tracks Pro, there are certain hardware and software requirements that you need to be aware of. You have a choice of MIDI drivers. The driver you choose will be determined by weighing your needs and may be limited by the hardware you’re using.

**MIDI Drivers**

MIDI software requires the use of a “driver” to send information out of the Macintosh modem and printer (serial) ports. The MIDI Setup item in the Goodies menu gives you the choice of using either the Passport MIDI driver, the Apple MIDI driver (MIDI Manager), the MOTU MIDI Time Piece, or OMS. The Passport MIDI driver is included in the program. The Apple MIDI driver is a System extension that is installed by the Master Tracks Pro Installer. The MIDI Time Piece uses a special implementation of the Passport driver. OMS is an alternative driver that can be helpful for configuring large MIDI systems. The driver you use depends on what kind of computer you have and whether or not you are using other MIDI software.

If you run Master Tracks Pro and choose the MIDI Setup item from the Goodies menu, the MIDI Setup dialog box will appear. The MIDI Setup dialog allows you to select a MIDI driver and choose the serial port that you will use for your MIDI interface.

Master Tracks Pro initially defaults to the Passport MIDI driver. Your MIDI driver and port selections can be saved with preferences.

If the Passport MIDI driver is selected, you can designate the port that Master Tracks Pro will use for receiving and transmitting MIDI data.
Note: The Passport MIDI driver requires System 7. Use MIDI Manager if you are running under System 6.

If MIDI Manager is selected, Master Tracks Pro will use the Apple MIDI driver. We highly recommend using the Apple MIDI driver. It can be used effectively on all but the slowest Macs. If you’re not sure, try it out to see how it works. If you experience difficulty (hung notes, MIDI data “choke,” or other performance problems), you can always switch to the Passport driver.

Choose MIDI Time Piece if you are using a MIDI Time Piece multi-port interface and are not using OMS. See MIDI Time Piece Support on page 13 for more information.

Note: The MIDI Time Piece driver requires System 7.

Choose OMS if you are using OMS to configure your MIDI system. See OMS Support/New MIDI Setup on page 23 for more information.

What is the Apple MIDI Manager?

MIDI Manager is a System extension from Apple computer that was designed to enable the Macintosh operating system to support MIDI. There are actually three necessary components: MIDI Manager, the Apple MIDI driver, and the PatchBay. The PatchBay lets you “connect” MIDI software to the Mac serial ports and other MIDI Manager-compatible programs. MIDI Manager and PatchBay are necessary if you have more than one application sharing the MIDI port. If you have a Mac Plus or SE, you’ll need at least 2.5 meg of memory and System 6.0.2 or higher to use MIDI Manager. MIDI Manager can be used with great success on Macs with 68020 or higher microprocessors.
PowerBooks and Master Tracks Pro:  
MIDI Manager version 2.0.2

Master Tracks Pro’s installation program will automatically install MIDI Manager v2.0.2 if you are running on a PowerBook. MIDI Manager v2.0.2 will prevent the loss of incoming data that can occur when using one of these computers and transmitting large blocks of data such as System Exclusive transfers. MIDI Manager v2.0.1 is installed for all other computers.

The fixes in MIDI Manager v2.0.2 only affect the modem port on PowerBooks. The printer port’s behavior has not been improved and it should not be used.

Note: If at any time you wish to install MIDI Manager v2.0.2 you can do so using Master Tracks Pro’s Custom installation option. You should be aware, however, that MIDI Manager v2.0.2 may cause problems during floppy disk insertion on the Macintosh Plus. According to Apple, the fixes for the modem port are only required for the 140, 145, 160, 170, or 180 model PowerBooks.

If you are using MIDI Manager and you install Master Tracks Pro to a hard disk that you are using with a PowerBook but the initial installation was done with a desktop Mac, you’ll need to make sure that MIDI Manager v2.0.2 is installed on the PowerBook. There are two ways to do this. You can run a Custom Install on the PowerBook and install only MIDI Manager v2.0.2. The other option is to do a Custom Install of MIDI Manager v2.0.2 after installing Master Tracks Pro to your desktop Mac. You can then copy or move the necessary components to a folder on your hard disk so that you can manually copy them to the PowerBook’s System folder. You’ll need MIDI Manager v2.0.2 (Extensions folder>System folder), the Apple MIDI Driver (System folder), PatchBay Help (System folder), and PatchBay (Apple Menu Items folder(System folder).

Note: If you’re using a Mac Plus, be sure to either remove MIDI Manager v2.0.1 from your System folder before installing v2.0.2 or re-install v2.0.1 after installing v2.0.2.
Connecting to the Serial Ports

If you are using the Passport MIDI driver, you can simply assign Master Tracks Pro to one of your Mac’s serial ports (printer or modem). Use the MIDI Setup dialog (Goodies menu) to assign the port.

If you chose the Apple MIDI Manager option, the port connections are made automatically. If you run the PatchBay DA or application while Master Tracks Pro is running, you’ll see (at least) two icons, one representing Master Tracks Pro and one representing the Apple MIDI driver. For more information, read the PatchBay Help file after you have installed MIDI Manager.

MIDI Time Piece Support

Master Tracks Pro supports Mark of the Unicorn’s MIDI Time Piece (MTP) multi-port interface. The MTP works only with the MIDI Time Piece driver or OMS. MIDI drivers are selected in the MIDI Setup dialog (Goodies menu). See MIDI Setup for more information. The MIDI Time Piece driver is a special version of the Passport driver and is included in the Master Tracks program.

*Note: The Passport and MIDI Time Piece drivers require System 7.*

If you use OMS with Master Tracks Pro, there are no distinct differences between using the MTP and any other MIDI interface. The devices you’ve specified in your OMS setup appear in place of the port designations in Pro.

If you use Master Tracks Pro’s MIDI Time Piece driver, some changes occur in Pro’s interface. When you click on the channel field (“Chnl”) in the Track Editor’s Track Sheet, the Choose Port/Channel dialog offers a choice of sixteen ports divided into two sets of eight ports each (cables A through H and K through P). If you have one MTP you can use either one of these groups by setting it to 1-8 (A-H) or 9-16 (K-P). If you have two linked MTPs, you can use all sixteen ports.

You can choose from 16 channels on each port. As in the regular channel dialog, selecting a box in the column headed by a dash (-) means that data will be transmitted on that port on the channel on which it was recorded. See the
manual for channelization specifics and for information on Multi-Channel tracks and selecting ports and channel numbers from your Mac keyboard.

Master Tracks Pro supports the MTP’s “smart” (cablizing) mode. If you are running Master Tracks Pro with another application that does not fully support the MTP, click Stop in Pro’s Transport window to set the MTP to “dumb” (non-cablizing) mode before you switch to the other application. In plain English, when the MTP is set to dumb mode, all data will be sent to all eight MIDI outs (sixteen with two MTPs). If you do not switch to dumb mode, data will only appear at one of the MTP’s MIDI outs.

Note: Due to limited buffer size, Chase Controllers works with the MTP two ports at a time (you can see the MIDI Out lights on the MTP chase). Also sysex messages are not “cabled” for the MTP.

Connecting the MIDI Time Piece
As stated previously, you can use a MIDI Time Piece with Master Tracks Pro if you’re using either OMS or the MIDI Time Piece driver. If you use OMS, refer to the OMS and MIDI Time Piece documentation for details about connecting the MTP to your Mac and configuring OMS.

If you want to use Master Tracks Pro’s MIDI Time Piece driver, follow the instructions below to connect the MTP to your Mac.

1. Connect the Computer jack on the back panel of the MIDI Time Piece to your Mac’s modem port. You must use the modem port.
2. Set the MTP’s speed to 1 megahertz. On the MIDI Time Piece I, set the switch on the MTP’s front panel to “1 Megahertz Asynchronous”. On the MIDI Time Piece II, use the Global Hardware Setup menu to set the Mac Speed to 1MHz. The MIDI Time Piece driver does not support the MTP’s FAST mode.
3. Turn the MIDI Time Piece on.
4. Run Master Tracks Pro.
5. Choose the MIDI Setup item from the Goodies menu. The MIDI Setup dialog appears.
6. Use the pop-up menu (MIDI Uses...) to choose the MIDI Time Piece driver.
7. Click OK.
The MIDI Setup dialog was getting a bit unwieldy, so we’ve split it into two dialogs (see also New Dialog—Sync Setup). The MIDI Setup dialog serves two purposes. Its primary use is to select a MIDI driver. It is also used to map undefined ports to an available port.

There are four driver choices: Passport Drivers, MIDI Manager, MIDI Time Piece, and OMS (see Installation for more information about the Passport Drivers and MIDI Manager). MIDI Manager and OMS are only available if you’ve installed them in your System. MIDI Time Piece is only available if you have a MOTU MIDI Time Piece connected to your modem port (see MIDI Time Piece Support on page 13 for more information.)

If you choose OMS, an OMS menu will appear to the right of Master Tracks Pro’s Goodies menu. This menu allows you to choose an input device and to alter your OMS setup.

If you open a sequence created with another MIDI setup, Master Tracks may need to map undefined ports to a port available to your setup. For example, if you attempt to load and play a sequence created with a MIDI Time Piece (which can have up to 16 ports) on a system configured for the Passport Driver (which supports only two ports), you can route data from the additional ports to one of the ports available with the Passport Driver.

*Note:* The Passport Driver requires System 7.x. If you’re running under System 6.0.7, you’ll need to use either MIDI Manager or OMS.
The Sync Setup dialog is used to specify the clock or sync source that Master Tracks Pro will use for its timing reference. You can also choose a port on which to transmit sync information. (In previous versions of Master Tracks Pro, sync setup was part of the MIDI Setup dialog.)

You have four options for transmitting sync data: No Sync, MIDI Clocks, MIDI Time Code, and MIDI Machine. No Sync doesn’t really require an explanation; when you choose No Sync and play a sequence, no sync data will be transmitted. MIDI Clocks transmits standard MIDI start, stop, continue, song position pointer, and clock messages. MIDI Time Code transmits...you guessed it: MIDI Time Code. And MIDI Machine transmits the MIDI Machine Control messages for start, stop, and locate along with MIDI Time Code. (See MIDI Machine Control for more information.)

It is generally recommended that you dedicate a port to transmitting sync data when you have multiple ports available. Use the port pop-up to designate the port.

There are three choices for a sync source: Internal, External, and MIDI Time Code. Internal uses your computer’s own internal timer as the basis for Master Tracks Pro’s clock. External enables Master Tracks to sync to external sources that transmit MIDI start, stop, continue, clock, and song position pointer messages. MIDI Time Code allows Master Tracks to sync to an external source that generates MIDI Time Code. Master Tracks can receive MIDI Time Code on any port, but make sure that there is only one source.

The checkbox labeled “Respond to MIDI Start/Stop in internal sync” enables you to start or stop Master Tracks Pro from an external device even when Pro is synced to the computer’s internal clock. Some MIDI keyboards, for example, have buttons that can be dedicated to specific tasks such as sending MIDI start or stop messages.

The remainder of the Sync Setup dialog’s features are exactly the same as described in the User’s Guide (except the SMPTE frame-rate is now chosen with a pop-up rather than radio buttons).
MIDI Machine Control

The MIDI Machine Control (MMC) messages for Start, Stop, and Locate have been mapped to Master Tracks Pro’s Transport controls. Master Tracks will send MMC messages only when the Sync Setup dialog has been set to transmit them (see New Dialog—Sync Setup for more information).

You may have to experiment to find the most efficient setup for your system. For example, we found that the best way to control an ADAT’s transport from Master Tracks Pro is to transmit MMC messages to the ADAT while syncing the sequencer to MIDI Time Code (MTC) from the ADAT (some sort of SMPTE to MTC converter is necessary to do this).

Note: When Pro’s sync source is MIDI Time Code and you are locating to a specific point in a sequence/tape, it will actually locate to a point 3 seconds prior to that in order to give you some pre-roll.
MIDI Thru

In order to set up the best working environment, there is an item in Master Tracks Pro’s Transport window that deserves some attention right now. It is the small button labeled “Thru.” Perhaps it’s best to start by explaining what MIDI thru is.

If you have a MIDI instrument or sound module, chances are pretty good that it has MIDI in, out and “thru” ports. Generally speaking, the thru port transmits MIDI data as it’s received by the MIDI in port (the data goes “through” the instrument and is immediately re-transmitted). How is this useful? It allows you to chain several MIDI devices together and control them all with one stream of MIDI data.

Master Tracks Pro’s MIDI thru feature is slightly different. When MIDI thru is turned on in Master Tracks Pro, MIDI data received at the MIDI in port of your computer’s MIDI interface is immediately transmitted from the interface’s MIDI out port. This enables you to play into Master Tracks Pro with a MIDI instrument and have that MIDI data control a separate MIDI instrument or sound module at the same time.

MIDI thru is turned on by clicking the Thru button in the Transport window. The Thru button also indicates the MIDI channel that the MIDI thru data will be transmitted on. When no thru channel assignment is made ( - ), the data is transmitted on the channel it was received on.

There are two ways to set the MIDI thru channel. You can double-click on the Thru button and enter a channel number in the dialog that appears. Or, if you have assigned channels in the Track Sheet window, record-enabling a track will automatically switch the Thru channel to that track’s MIDI channel.
Common MIDI Setups

It would be impossible to describe each possible combination of MIDI instruments and interfaces here. But there are a few general assumptions that can be made. Three very basic MIDI systems are described in this section.

System One

The most basic setup you could have would include a Mac-compatible sound module and your computer running Master Tracks Pro. There are several sound modules available that can connect directly to your computer’s modem or printer port, without the need for a separate MIDI interface. You still need to make sure that Master Tracks Pro is “connected” to that port via your driver and port selection in the MIDI Setup dialog (Goodies menu). If you don’t have a module that connects directly to your Mac, you can also use any MIDI sound module and any Mac-compatible MIDI interface.

With this setup you could use the mouse or Master Tracks Pro’s graphic, on-screen keyboard to enter notes. You can also use your computer’s keyboard to enter notes (QWERTY Note Entry mode). If you have a faster Macintosh, you can even record simple melodies in real time from your computer’s keyboard.
System Two

System two consists of a single MIDI instrument with its own sound generating capabilities, a MIDI interface, and your computer running Master Tracks Pro. The MIDI out of the instrument is connected to the MIDI in of the interface; the MIDI out of the interface is connected to the MIDI in of the instrument.

There is also a slight variation of this setup. If you are using a multitimbral instrument with the ability to receive MIDI data on several channels simultaneously, you may want to turn the instrument’s local control off. An instrument’s local control is normally on. What this means is that its keyboard is controlling its internal (“local”) sound-generating hardware. When local control is off, the performance data from the instrument (notes, pitch bend, sustain pedal, etc.) is transmitted via the MIDI out port, but it does not control the local synthesizer hardware. In other words, you play the keyboard and the only thing that comes out is MIDI data, no sound. If you connected the instrument’s MIDI out to its own MIDI in, you would generate sound. Turning local control off essentially splits an instrument into a master controller and a separate sound module.

So, why would this be useful? If you are working on a song with multiple tracks on multiple MIDI channels, you can turn on Master Tracks Pro’s MIDI Thru option and use Master Tracks Pro to determine which channel (and
therefore which of your synth sounds) is currently being played by the keyboard (record-enabling a track will automatically switch MIDI Thru to that track’s channel). That’s generally much easier than changing the channel on your synth every time you want to work on a different staff.

**System Three**

A slightly more sophisticated setup uses a MIDI master controller (a keyboard or some alternate controller) and one or more sound modules. This requires you to use Master Tracks Pro’s “Thru” feature.
Some changes have been made to Master Tracks Pro’s menu items since the publication of the original manual for version 6.

**File Menu**

The Import/Export MIDI File items have been removed. If you choose Open, you can now open any type of file that is supported by Master Tracks Pro (Pro files and Standard MIDI files). If you open a Standard MIDI file, edit it, and then save it, it will be saved as a MIDI file, not a Master Tracks Pro file. If you want to save it in a different format, choose the Save As item from the File menu. The Save As dialog now contains two radio buttons enabling you to choose between Master Tracks Pro and Standard MIDI file formats. The Standard MIDI file type is selected in the MIDI File Options dialog.

**Expanded MIDI File Support**

Type 0 standard MIDI files (multiple channels on a single track) are automatically “exploded” when opened. That is, data is stripped out according to channel, and each channel’s data is assigned to its own track in Master Tracks Pro.

Any file with the extension “.MID” can be selected from the Open dialog. This enables you to open files on shared PC volumes, PC floppies, or from a BBS without having to change the file type.
Change Menu

There is a new item in the Change menu called Join Notes. This is used to rejoin broken notes. For example, if you select a measure or measures across all tracks and choose Cut from the Edit menu, you remove not only note data but also the selected measures. If a note begins before the selected region, sustains through it, and ends after the region, a new note-on message is inserted at the beginning of the first measure following the cut. If you were to look at this region in the Step Editor window after making the cut, you would see what appears to be one note that sustains across the measure line. But it is actually two notes butted up against each other. To make them a single note, select both notes in the Step Editor and choose Join Notes from the Change menu.

The Device List Bank Select

The MIDI spec allows for up to 128 presets. Some instruments respond to a “bank select” message that give you access to multiple banks of up to 128 presets each. Simply enter the appropriate bank number in the Bank text box and then choose the desired preset.

Please note that this will only work with instruments that respond to this command via MIDI. These include the Roland Sound Canvas, the Peavey DPM3SE, Kurzweil K2000, Korg Wavestation and a few other instruments.

The fact that an instrument has more than 128 presets does not necessarily mean that it will respond to bank select messages. For example, the Emu Proteus 1 and 2 do not respond to MIDI bank selection.

Roland GS instruments require a special bank switch message. Simply select the Roland GS checkbox when working with these instruments.

When saving a MIDI File, the bank select message at the beginning of a track is automatically exported along with the initial program change.

You can change any device (except Generic, Generic 8x8 and General MIDI) to any other available device.
Using the Built-in QuickTime Synthesizer

**Built-In Synth**

The new version of QuickTime® includes a built-in, General MIDI-compliant synthesizer. We have made it possible for you to play your Master Tracks Pro songs back through the Mac’s sound system using this QuickTime built-in synth, thereby eliminating the need for any additional hardware. You’ll probably still want to use your home keyboard or other MIDI instrument for recording purposes, but you can get surprisingly good playback quality using just Master Tracks Pro and the built-in synth.

**Installing QuickTime 2.0**

QuickTime is a System extension from Apple Computer that allows your computer to play back digital video with an accompanying audio and MIDI soundtrack. In order to support MIDI playback, the QuickTime™ Musical Instruments System extension is also needed. This extension, in tandem with QuickTime 2.0 and the Mac’s sound capabilities, gives you a software MIDI synthesizer which Master Tracks Pro can use.

If you choose to do a complete installation of Master Tracks Pro, QuickTime will be installed to your System. If not, you can run the installation again and either do a complete re-installation or do a custom installation choosing just QuickTime and any other components that you’d like to install.

*Note*: QuickTime 2.0, QuickTime Musical Instruments, and Sound Manager 3.0 are necessary to use the built-in synth. These require System 7 and a 68020 or better processor and will be installed automatically if you choose the Easy Install option.
Using the Built-In Synth

To use the QuickTime synthesizer, choose Built-in Synth Mode from the Goodies menu. Several changes from the normal operating mode occur when you do this.

- The MIDI Setup dialog is unavailable.
  
  *Master Tracks Pro's MIDI output is directed exclusively to the Built-in Synth, so port selections are unnecessary.*

- MIDI In, Out, and Thru are disabled.
  
  *Any external MIDI instruments connected to your computer via a MIDI interface cannot be used for either note entry or playback. You can use Master Tracks Pro's on-screen, graphic keyboard to enter notes, but you may experience a discernible delay between the time the note is played and the time it actually sounds. This delay varies depending on the type of computer being used.*

- Master Tracks Pro’s Device List dialog will not appear.
  
  *Normally, the Device List dialog appears when you click in the Track Editor’s Program Name column (see the User’s Guide for more information). When the Built-in Synth is active, QuickTime’s Choose Instrument dialog will appear instead. See Choosing Instruments for more information.*

- No channel dialog appears.
  
  *The Built-In Synth supports the 16 standard MIDI channels, but port selections are ignored. Therefore, when you click in the Track Editor’s Channel column, a pop-up appears that lets you choose a channel only. If you choose ‘-’, the track will play on the MIDI channel on which it was recorded.*

As noted previously, there is a delay associated with the Built-in Synth. This can make it difficult to record in real time. But, since all of the notes are delayed by the same amount, pre-recorded and step-entered songs will play back fine.

The Built-in Synth will play back through your Mac’s internal speaker. You can use your Mac’s audio out jack to connect it to your stereo or other monitoring system.

The Built-in Synth status (on or off) is saved with preferences.
Choosing Instruments

Choosing instrument sounds for the Built-in Synth is simple. Simply click in the Track Editor’s Program Name column just as you would to select sounds for any other synthesizer. Instead of the Device List dialog, you’ll see QuickTime’s Choose Instrument dialog.

First you need to choose an instrument category. Instrument categories group similar instrument sounds together. For example, there are different categories for Piano, Guitar, Strings & Orchestra, and Sound Effects. Each of these categories contains several instrument choices. There is also a category for Drum Kits. This is only available when the staff is assigned to MIDI channel 10, in accordance with the General MIDI spec (which dictates that drums are always on channel 10 in songs arranged for General MIDI instruments). Click on the Category pop-up menu to see all the choices.

Next you need to choose a specific instrument. Click on the Instrument pop-up to see the choices. You can click on the dialog’s keyboard to hear the sounds.

You may notice that some of the choices are italicized. The Built-in Synth contains all 128 instrument names available under the General MIDI spec. It does not, however, contain all 128 sounds. One sound may be mapped to several different instruments. For example, in the Strings & Orchestra category only Violin and Timpani are not italicized. The same sound used for Violin is also used for Viola, Cello, and the other italicized choices. This is just so that General MIDI songs will play back with sounds that approximate the intended sounds. That doesn’t mean it’s the best sound for your song. Sometimes a different sound might make a better substitute. When you’re writing your next country hit, transposing Slap Bass 1 up an octave or two might sound more like a Telecaster than Electric Clean Guitar does. Feel free to experiment.

A Word About General MIDI

General MIDI is an extension of the MIDI specification that defines common, specific instrument and channel assignments for General MIDI-compatible songs and instruments. This allows MIDI song files to be played back on any General MIDI synthesizer with the proper instrumentation and sounds.
A new item, Keyboard, has been added to the Windows menu. The Keyboard window is a graphic, on-screen keyboard that can be “played” with your mouse or from your computer’s QWERTY keyboard. This enables you to input music from a keyboard in step time or real time without the need for a MIDI keyboard.

Playing the Keyboard
To play the keyboard with your mouse, simply click on the keys. If a MIDI sound module is connected to your computer, you will hear the notes sound as you click on the keys. The instrument sound you hear is determined by the current Thru channel and the sound that’s assigned to that channel. (You can change the Thru channel by double-clicking on the Thru button in the Transport window or by record-enabling a track in the Track Editor.)

To play the graphic keyboard from your computer’s keyboard you must first enable QWERTY note entry mode. Click the checkbox labeled QWERTY Keyboard Note Entry or press Q. The illustration shows the QWERTY keys you can “play” and their corresponding notes.

Input notes in step time or real time just as you would with a MIDI keyboard.

Chords
As you may already have noticed, you can’t enter chords with your mouse. You also can’t play more than a few notes at a time from your QWERTY keyboard. There is, however, a simple method for step-entering chords. Hold the shift key and click on the notes that make up the chord. When you release the shift key, the notes will be scored as a chord.

You can also use the shift key to enter chords from your QWERTY keyboard.
Changing the Octave
You can click any of the keys in the Keyboard window with your mouse, but if you’re using your QWERTY keyboard your range is limited to an octave and a fourth (from C to the F in the next highest octave).

To shift the range up or down by octaves, drag on the little QWERTY keyboard icon in the Keyboard window (you must be in QWERTY Keyboard Note Entry mode to do this). You can drag the keyboard icon left or right in one octave increments. You can also use the + and - keys to transpose up and down, respectively.

Setting the Velocity
Note events entered with the Keyboard window, using either the mouse or QWERTY keyboard, are assigned default velocity values of 100 (note on) and 64 (note off). You can set the velocity values using the Step Editor’s menu bar. Set the note-on and note-off velocities to the desired values. (Click directly on the numbers in the menu bar and use the pop-up to set new values.) Then click within the velocity box (anywhere but the numbers) to highlight the entire box. When the box is highlighted, Master Tracks Pro will use those velocity values for all notes entered. This is true whether the notes are recorded in real time or entered in step time.

Displaying the Playback
When you play a sequence back in Master Tracks Pro, the Keyboard window will indicate which notes are being played. The Keyboard honors muted and soloed tracks, so you can view individual parts as they play. For example, if you just want to see (and hear) the bass line in a song, solo the bass track in the Track Editor window.
Using the Assignable Faders

The faders in the Track Editor window can be assigned to any of the 127 standard MIDI controllers. Like the Channel and Program Name columns, the Controller column is expandable. When minimized, the Controller column simply shows the controller number assigned to that track’s fader. Click on the “Ctl” heading to expand the column. The expanded column shows the controller name. Click in the column to change the controller. Use the pop-up slider to choose a controller or, if you know the controller number, enter the number from your computer’s keyboard. If you press and hold the option key while choosing a controller, that controller will be assigned to all the tracks.

Tip: When the controller pop-up is on screen, you can use the up and down arrow keys to browse through the controllers. Pressing the left or right arrow key OKs your choice.

The faders are recordable. Hold the shift key while record-enabling a track to go into fader record mode. The fader record icon will appear in the Record column. Begin recording and move the fader as desired. Data for the assigned controller will be recorded as you move the fader. If any other MIDI data had been recorded previously, the controller data will be merged into it. If data for the current controller had been recorded previously, it will be overwritten by the new data.

If you want to send more than one type of continuous controller message to a single destination (for example volume and pan), simply assign multiple tracks to the same channel and assign the appropriate controllers to those tracks.

Note: Recording fader movements in normal record mode will overwrite all pre-existing data in the track.
Keyboard Shortcuts

Transport Commands

- Space Bar .......................................... Start and Stop Transport
- Enter Key .......................................... Record
- Left arrow ......................................... Move to beginning of previous measure
- Right arrow ....................................... Move to beginning of next measure
- Period (“.”) ........................................ Brings up Go To Dialog
- M ...................................................... Click (metronome) On/Off
- / ........................................................ Count (count-in) On/Off

Track Editor Commands

- Numeric keys 3–0, +, – ..................... Change measure ruler display value
- Tab ................................................... Move to next marker
- Shift-Tab........................................... Move to previous marker
- Backspace (Delete) ............................ Clear selected data.

Window Commands

≈ - 1 ..................................................... Track Editor Window
≈ - 2 ..................................................... Event List Editor Window
≈ - 3 ..................................................... Step Editor Window
≈ - 4 ..................................................... Pitch Bend Window
≈ - 5 ..................................................... Channel Pressure (Aftertouch) Window
≈ - 6 ..................................................... Key Pressure Window
≈ - 7 ..................................................... Modulation Window (Controller #1)
≈ - 8 ..................................................... Controllers Window (all Controllers)
≈ - 9 ..................................................... Volume Window
≈ - 0 ..................................................... Tempo Map Window
≈ - B ..................................................... Big Counter Window
≈ - K ..................................................... On-Screen Keyboard Window
**File Menu Commands**

- N ................................................ Create new sequence
- O ................................................ Open sequence from disk
- W ................................................ Close current sequence
- W ................................... Close all sequences
- S ................................................. Save current sequence to disk
- R ................................................. Revert to Saved
- E ................................................. Export a MIDI File
- Q ................................................. Quit *Master Tracks Pro*

**Edit Menu Commands**

- Z ................................................. Undo/Redo most recent change or record
- X ................................................. Cut selected region
- C ................................................. Copy selected region
- V ................................................. Paste at designated point
- M ................................................ Mix Data at designated point
- D ................................................ Delete measure(s)
- I .................................................. Insert measure(s)
- A ................................................. Select All

**Change Menu Commands**

- U ................................................ Change Conductor
- ................................................ Strip Data
- T ................................................ Change Transpose
- H ................................................ Humanize
- = ................................................ Quantize

**Layout Commands**

- \ ................................................ Show SMPTE/Measure Time
- / ................................................ Multi-Track Record
- [ ................................................ Zoom In
- ] ................................................ Zoom Out
Goodies Commands

- F ................................................. Master Fader
- Y ................................................. Sysex
- L ................................................. Chase Controllers Dialog

Step Editor and MIDI Data Window Commands

Numeric keys 1–7, D ......................... Select duration value and “dot”
Tab ................................................ Move to next marker
Shift-Tab ........................................ Move to previous marker
≈ - [ ................................................ Zoom In
≈ - ] ................................................ Zoom Out
Return .......................................... Enters a rest in Step Editor
Backspace (Delete) ......................... Clear selected data.
                                Delete last note in Step-Editor
A ....................................................... Selects Arrow pointer
P ....................................................... Selects Pencil pointer
E ....................................................... Selects Eraser pointer
T ....................................................... Track selector (pop-up slider)
C ....................................................... Controller selector (Controllers window)
Option-P ........................................ Toggles (turns on/off) track playback
Option-R ........................................ Toggles the record-enable function of the track (and selects Thru, if enabled)
Option-S ........................................ Toggles track Solo
Option-L ........................................ Toggles track Loop
Up-arrow/Down-arrow ................. Increment/Decrement selected value
                                (Edit Note window, and duration values in dialog boxes)

Any other letter, number, or punctuation key Toggles between “skyline” display mode and “cross” display mode (MIDI Data Windows)
OTHER SHORTCUTS

Hiding the Track Sheet

The Track Sheet portion of the Track Editor window can be hidden by clicking on the “Tk” button in the upper left corner of the window. This enables you to view a greater number of measures.

Arrow Keys and Pop-up Sliders

The up and down arrow keys can be used to change the values of Master Tracks Pro’s pop-up sliders. For example, when you click in the Track Editor’s Prg (minimized Program Name) column a slider will appear. Use the up or down arrow key to choose a new program number. Then press the left or right arrow key to enter your choice.
The MIDI Specification allows for 128 different Continuous Controllers, numbered from 0 to 127. Although theoretically any of these Controllers can be used for any musical purposes, instrument and software manufacturers have agreed that some of them are to be considered reserved for certain specific functions. The list of these functions appears below. Any Controller numbers not listed are not assigned specific functions.

- Controller #1 Modulation Wheel
- Controller #2 Breath Controller
- Controller #4 Foot Controller
- Controller #5 Portamento Time
- Controller #6 Data Entry Slider
- Controller #7 Volume
- Controller #8 Balance
- Controller #10 Pan
- Controller #11 Expression
- Controller #64 Sustain (Damper Pedal)
- Controller #65 Portamento Switch (Pedal)
- Controller #66 Sostenuto (Middle Pedal)
- Controller #67 Soft Pedal
- Controller #69 Hold
- Controller #91 Effects Depth
- Controller #92 Tremolo Depth
- Controller #93 Chorus Depth
- Controller #94 Celeste (Detune) Depth
- Controller #95 Phaser Depth
- Controller #96 Data Increment (+ switch)
- Controller #97 Data Decrement (– switch)
- Controller #122 Local Control (Off=0, On=127)
- Controller #123 All Notes Off
- Controller #124 Omni Mode Off
- Controller #125 Omni Mode On
- Controller #126 Mono Mode On
- Controller #127 Poly Mode On
A

Absolute. See volume: Master Volume Fader
accidentals 40
Add Clocks 105
"all" icon 45, 89
All Notes Off 3
arrow 46, 57, 63, 65
articulation 50
auto 4

B

beat value 112
Big Counter window 75, 140

C

Change Conductor 27
Change Filter 131
Change Menu 101
channel 8, 103
Channel Pressure 69
Channel Pressure window 139
Chase Controllers 164
Chnl. See channel
Clear 94
click 4
Click Setup 163
Clipboard 88
show 100
clocks-per-quarter note 3
Close 80
Conductor 111, 170
Continuous 107
controller
Changing data values 109
maping 107
Controller #7 21
controller chasing 21
Controllers window 70, 139
Copy 91
"Copy Device" checkbox 19
"Copy Program" checkbox 20
count In 4, 25
cue sheet 72
current position 27
current sequence 141
Current Time 162
indicator 3
Cut 89

D

Delete key 53
Delete Measure 98
Device List
in the Step Editor 42
drop frame 173
duration 49, 73, 103
add clocks 105
scale 104
E

Edit
  while playing 99
Edit menu 88
eraser 56, 63, 67
Event List Editor 72
  Inserting events 74
Event List Editor window 138
EXT Sync 5

F

file
  active 78
  MIDI File 82
    Master Tracks Pro file 78
File menu 77
“Filter” button 75
Fit Time 128, 171, 176. See cue
flywheeling 163
follow playback 146

G

Get Info 150
Ghost Notes 63
Goto... 73
grid
  show/hide 145
guitar controller 10

H

Hide Markers 31
home key 2
Humanize 122

I

Initial Program Number 16
Input Channel 51
Insert Data 98
Insert Measure 97
insert points 6
INT Sync 5
Intensity 125

K

Key Pressure 69
Key Pressure window 139
Keyboard Setup 156
Keyboard Step entry 42

L

Layout Menu 145
left-arrow key 2
Locked Markers 129
Looped Overdub 6
Looped Record 6
Looping 11, 167

M

marker 41
  delete 151
  lock / unlock 152
  locked 115, 176
  move 32, 151
  name 32, 151
  ruler 64, 146
  well 32
markers
  show/hide 145
Markers window 33, 151
Master Volume Fader 22
meas/beat/clock
  show/hide 146
measure
  boundary 11
  counter 3, 27
  delete 98
  display 31
  insert 97
  number 29
ruler 30, 40, 64
selecting 34
Memory window 149
meter 112
metronome 27, 112, 164
MIDI
"choking" 118
delay 67
multiple channels 159
MIDI ("Ext") sync 172
MIDI Data window 62, 138
MIDI File 77, 82
 export 82, 83
 Type 0 83
type 1 83
MIDI pitch 40
MIDI Setup 158
MIDI sync 160
MIDI Time Code 161
 MTC Sync 173
MIDI Volume 9
mix. See Volume
Mix Data 95
 mod wheel 70
modem Port 14
modem port 158
Modulation window 70, 139
MTC Sync 5
Multi-Track Record 10
MultiChannel Track 12, 13
multiple sequences 141

N
note
 copy 55, 58
 lock pitch 55
 moving 55
preview 49
re-mapping 58
Scale durations 130
start time 55, 57
stretching 56
tied 95
note icon 42
note-off velocity 73
note-on velocity 73
Notepad window 153
O
offset tempo 28
Overdub 6
P
Paste 92
 multiple paste 93
patch. See program
pause 3
pencil 52, 54, 63, 66
period key 3
Pitch Bend 68
Pitch Bend Range 110
Pitch Bend window 139
play 2, 24, 44
play-enabled 9
playback point 37
playlist 142
 save/load 144
polyphonic aftertouch. See Key Pressure
Pop-up Sliders 15
position indicator
 show/hide 146
Preferences 84
printer port 14, 158
program 16
 name 18
program change 9, 41
 initial 16, 41
 show/hide 146
Punch In 6
Q
Quantize 123
   Sliding notes 127

R
randomize. See Humanize
re-barring 168
record 2, 10, 25
Record Filter 26, 166
Rest 53
Revert 81
rewind 2
rhythmic value 49
right-arrow key 3

S
Save 80
Save As 81
Scale Time 129
Select All 87
serial ports 158
Show Markers 31
Sliding Data 127
SMPTE 72, 161, 162, 173
dropout 162
show/hide 146
Snap-to-Grid 52
Solo 11
Song list
   start 143
Song menu 142
Song Playlist 142
Song Position Pointer 160
Start Time 162
start time 4
Step Editor
   "ghost" view 63
   Hide/Show Grid 40
   note display 40
   pitch division 40
   velocity control 50
Step Editor window 39, 138
Step Time Entry
   recording velocity 52
      with a mouse 52
Step Time entry from MIDI Keyboard 52
Stop 3
Strip Data 115
sub-beat 134
sustain pedal 70
Swing 126
Sync 25
synchronization 158, 171
   external 161
   Internal 161
   MIDI (Ext) sync 172
   MIDI Time Code ("MTC") sync 173
   offset 162
   SMPTE 173
      Transmitting Sync 160
Sysex 154
   receiving 154
      sending 155

T
tab 31
tempo 113
   inserting changes 170
      offset 28
   tempo change 3
Tempo Map 27, 111, 168
   end 29
Tempo Map window 71, 140
Tempo window 27
Thin Continuous Data 118
Thin Notes 120
Thru 7
tied notes 95
time indicator 55, 64
   in the Step Editor 46
time signature 27, 112
track
duplicate 24
Moving 23
multiple-channel 12
name 12, 75
number 29
selecting 35
Track Editor
editing 33
Track Editor Window 8
Track Editor window 138
Transport window 150
Transpose 120
Transpose Lock 24
Transpose Map 121
tuplet 50, 104
U
Undo 2, 88
V
Velocity 50, 105
change 105
show/hide 51, 146
Velocity window 71, 140
Volume 20
faders 21
initial 20
Master Volume Fader 22
W
Window
Display mode 62
Z
zoom in/out 43, 64, 67, 147